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Measurement 

Measurement 

This chapter provides information related to the measurements done 
through E5071C. 

 Setting Measurement Conditions 

 Calibration 

 Making Measurements 

 Data Analysis 

 Data Output 

 Optimizing Measurements 

 Measurement Examples 

 Fixture Simulator 
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Setting Measurement Conditions 

 Setting Measurement Conditions 

 Initializing Parameters 

 Setting Channels and Traces 

 Setting the System Z0 

 Setting Stimulus Conditions 

 Selecting Measurement Parameters 

 Selecting a Data Format 

 Setting the Scales 

 Setting Window Displays 
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Initializing Parameters 

The E5071C has three different initial settings as shown below. 

Initial setting Restore method 

Preset state Press Preset > OK the front panel or Execute the 
:SYST:PRES command 

*RST state Execute the *RST command 

Factory default 
setting 

E5071C factory (default) settings 

The user can set items to be preset freely. For more information, see 
Setting the user preset function. 

Other topics about Setting Measurement Conditions 
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Setting Channels and Traces 

 Overview 

 Setting Upper Limit of Number of Channels/Traces 

 Setting Channel Display (Layout of Channels) 

 Setting Trace Display 

 Active Channel 

 Setting Parameter for each Setup Item (Analyzer, Channel, Trace) 

Other topics about Setting Measurement Conditions 

Overview 

The E5071C allows you to use up to 160 channels (when the number of 
traces is up to 9) to perform measurement under 160 different stimulus 
conditions. 

For each channel, up to 4, 6, 9, 12 or 16 traces (measurement 
parameters) can be displayed. Because multiple traces can be displayed for 
each channel, no feature is provided to link the stimulus conditions 
between channels, and each channel is always independent of the others. 
In other words, for the E5071C, you need to set the measurement 
conditions and execute calibration for each channel you use for 
measurement. 

With the E5071C, you can change the number of available channels and 
the upper limit of the number of traces. If you change the upper limit 
setting, you need to restart the firmware of the E5071C. Therefore, first, 
set the upper limit appropriately depending on the numbers of channels 
and traces necessary for your measurement. 

When you set items whose setting target is channels/traces (refer to 
Parameter setting for each setup item), the target is the selected (active) 
channel/trace. You can specify only the displayed channels/traces as active 
channels/traces. Therefore, set the display of channels/traces before 
setting the measurement conditions. 

Setting Upper Limit of Number of Channels/Traces 

You can select the upper limits of the number of channels and the number 
of traces from the following combinations. 

Channels Traces Maximum 
  

Number 
of Points 

Supported 
Revision 
(Firmware 
Revision) 

Note 
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1 4 1601 All You may want to select the "1-channel, 
4-trace" or "2-channel, 4-trace" 
configuration to save the time required 
to save/recall the instrument state file, 
since this takes longer with other 
configurations. More channels and 
traces requires longer measurement 
time. 

4 16 1601 

9 9 1601 

12 6 1601 

16 4 1601 

16 16 1601 

24 12 1601 

36 9 1601 

2 8 3201 From 
A.09.50 

2 8 1601 Up to 
A.09.4x 

2 8 10001 From 
A.09.20 to 
A.09.4x 

2 16 10001 From 
A.09.50 

1 4 20001 All 

72 9 401  From 
A.08.10 

For these setup, press  
System > Service Menu > Channel/Trace 
Setup 

In this configuration, when many of 
channel/trace/points are used, memory 
swap or memory shortage may occur 
during the measurement. It causes 
pauses or hang-up of measurement. 

96 9 201 

160 9 201 From 
A.09.10 

6 16 10001 From 
A.11.0x 
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4 9 20001 

 Its important to realize that the combination used to save a 
state file must be the same used to recall it; that is, you cannot 
save a state file with one combination of channels/traces and 
recall it with another combination. For more details, see Saving 
and Recalling Instrument State. 

The selection procedure is as follows: 

1. Press System > Misc Setup > Channel/Trace Setup. (System > Service 
Menu > Channel/Trace Setup for some settings) 

2. Press the desired softkey to select the upper limits of the number of 
channels and the number of traces. 

3. The dialog box that prompts "New Channel/Trace configuration will 
take effect after firmware restart." appears. 

4. Click OK. 

5. Press any softkeys or hardkeys besides Preset key. 

6. The dialog box that prompts "Do you want to restart now?" appears. 

7. Click Yes. 

8. On choosing a multi-channel mode, it may take more time to 
restart the firmware. The screen may seem to freeze but will 
resume their normal operation once the settings are applied. 

Setting Channel Display (Layout of Channels) 

The measurement result for each channel is displayed in its dedicated 
window (channel window). You cannot have a single window display the 
measurement results from more than one channel. This means that the 
setting of the window layout determines the number of channels displayed 
on screen. 

 The execution of measurement for each channel 
does not depend on how the channel is displayed (channels that 
are not displayed can be measured). For information on 
executing measurement for each channel (trigger mode and 
trigger source), refer to Making Measurements. 

The procedure for setting the window layout is as follows: 

1.  Press Display key > Allocate Channels. 

2.   Press the desired softkey to select the window layout shown below. 

Windows Layout 
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 From Firmware revision A.09.10, channel display 

configuration of 10×16 is added. 
From Firmware revision A.08.10, channel display configuration 
of 8×9, 6×12 and 8×12 is added. 

Setting Trace Display 
Setting the number of traces 

Depending on the measurement parameters of the traces displayed for 
each channel, the sweep necessary for each channel is executed. For more 
information, refer to Sweep Order in Each Channel. 

You specify the trace display by setting the number of traces (upper limit 
of displayed trace numbers). For example, if you set the number of traces 
to 3, traces 1 through 3 are displayed. 

The procedure for setting the number of traces is as follows: 
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1.    Press Channel Next or Channel Prev to select the channel for which 
you want to set the number of traces. 

2.    Press Display > Number of Traces. 

3.    Press the desired softkey to set the number of traces. 
Setting trace layout (graph layout) 

Traces are laid out and displayed in the order of the trace number from 
graph 1 according to the graph layout in the channel window. 

You can select the graph layout from the windows layout. 

If the number of traces is less than the number of graphs, nothing is 
displayed in the remaining area. If the number of traces you set exceeds 
the number of graphs, excess traces are superimposed from the first 

graph. For example, if you select  as the graph layout and set 
the number of traces to 5, graph 1 (Gr1 in Graph layout) and graph 2 (Gr2 
in Graph layout) display traces 1 and 4 and traces 2 and 5, respectively, by 
superimposing, and graph 3 (Gr3 in Graph layout) displays only trace 3 as 
shown in the figure below. 

 
The procedure for setting the graph layout is as follows: 
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1. Press Channel Next or Channel Prev to select the channel for which 
you want to set the graph layout. 

2. Press Display > Allocate Traces. 

3. Press the desired softkey to select the graph layout shown below. 

Graph Layout 
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Active Channel 

The active channel is the one whose settings can currently be changed. 
The window frame of the active channel is displayed brighter than the 
window frames of the other channels. To change the settings specific to a 
certain channel, you must first activate the channel. 

To change the active channel, use the following hardkeys: 

Hardkey Function 

Channel 
Next 

Change the active channel to the next channel with the 
larger channel number. 

Channel 
Prev  

Change the active channel to the previous channel with the 
smaller channel number. 

Active trace 

The active trace is the one whose settings can currently be changed. The 
trace name on the screen (for example, Tr3) of the current active trace is 
highlighted and indicated with   to the left. To change the settings specific 
to a certain trace, you must first activate the trace. 

To select the active trace, use the following hardkeys: 

Hardkey Function 

Trace 
Next 

Change the active trace to the next trace with the larger 
trace number. 

Trace 
Prev  

Change the active trace to the previous trace with the 
smaller trace number. 

Setting Parameter for each Setup Item (Analyzer, Channel, Trace) 

The following table lists the setting parameters and indicates the setup 
item (analyzer, channel, or trace) that each parameter controls along with 
the applicable setup key(s). 

Parameter Controlled Setup Items Setup Key(s) 

Analyze
r 

Chann
el 

Trac
e 

Stimulus Settings   

Sweep range   x   Start, Stop, Center, Span 

Power, CW frequency   x   Sweep Setup > Power 



E5071C 

78 

Sweep time/Sweep 
delay time 

  x   Sweep Setup > Sweep Time, 
Sweep Delay 

Number of points   x   Sweep Setup > Points 

Segment sweep   x   Sweep Setup > Sweep Type, 
Edit Segment Table, 
 Segment Display 

Sweep mode   x   Sweep Setup > Sweep Mode 

Trigger Settings   

Trigger source x      Trigger > 
Trigger Source/Restart/Trig
ger 

Trigger mode   x   Trigger > Hold/Hold All 
Channels/Single/ 
Continuous/Continuous 
Disp Channels 

Response Settings   

Measurement 
parameter 

    x Meas 

Data format     x   Format 

Scale, Electrical delay, 
Phase offset 

    x Scale 

  

Memory trace and 
data math 

    x Display > Display/Data-
> Mem/ Data Math 

Window title   x    Display > Edit Title Labe/ 
Title Label (ON/OFF) 

Graticule label in 
rectangular form 

  x    Display > Graticule 
Label (ON/OFF) 

Color inversion x     Display > Invert Color 

Frequency display 
ON/OFF 

x       Display > Frequency 
(ON/OFF) 

Display update 
ON/OFF 

x       Display > Update (ON/OFF) 

Averaging   x   Avg > Averaging Restart/ 
Avg Factor/Averaging 
(ON/OFF) 
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Smoothing     x Avg > Smo Aperture/ 
 Smoothing (ON/OFF) 

IF bandwidth   x   Avg > IF Bandwidth 

Calibration   x   Cal 

Marker     x Marker, Marker Search, 
Maker Fctn 

Analysis   

Fixture simulator   x    Analysis > Fixture Simulator 

Time domain     x Analysis > Gating/ 
Transform 

Parameter conversion     x Analysis > Conversion 

Limit test     x Analysis > Limit Test 

Saving and recalling 
data 

x     Save/Recall 

Macro x     Macro Setup, Macro Run, 
Macro Break 

System   

Printing/Saving display 
Screen/Beeper/GRIB 
settings/Network 
Settings/Date & 
Time/Key 
Lock/Backlight/Firmwa
re Revision/Service 
menu 

x     System 

Preset x     Preset 
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Setting the System Z0 

The procedure for setting the system characteristic impedance (Z0) is as 
follows: 

1. Press Cal key. 

2. Click Set Z0, then input the system Z0. 

Other topics about Setting Measurement Conditions 
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Setting Stimulus Conditions 

You can set the stimulus condition for each channel independently. 

 Setting the Sweep Type 

 Setting the Sweep Range 

 Enable Stimulus Signal Output 

 Setting power level 

 Setting fixed frequency at power sweep 

 Setting CW Time Sweep 

 Setting Power Level with Auto Power Range 

 Setting the Number of Points 

 Setting the Sweep Time 

Other topics about Setting Measurement Conditions 

Setting the Sweep Type 

You can select the sweep type from the following four types. 

SoftKey Description 

Linear 
Freq 

Sweeps frequencies in linear scale. 

Log Freq Sweeps frequencies in logarithmic scale. 

Segment Performs a sweep with linear sweep conditions (segments) 
combined. For more information, refer to Performing a 
Segment-by-Segment Sweep (segment sweep). 

Power 
Sweep 

Sweeps power levels in linear scale. 

The procedure for selecting the sweep type is as follows: 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to set the sweep type. 

2. Press Sweep Setup > Sweep Type. 

3. Press the desired softkey to select the sweep type. 

4. To use the E5071C in CW Time sweep, refer to Setting CW Time 
Sweep 

Setting the Sweep Range 
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There are two ways to set the sweep range: by specifying the lowest and 
the highest values and by specifying the center value and a span. Once the 
sweep range is set, it is possible to change the range by substituting the 
lowest value, the highest value, or the center value with a value (stimulus 
value) represented by a marker on the trace. 

 
  

Setting the Sweep Range with the Lowest and Highest Values 

1. Press Channel Next/Channel Prev keys to select the channel whose 
sweep range will be set. 

2. Click Start, then input the lowest value. 

3. Click Stop, then input the highest value. 
Setting the Sweep Range with the Center Value and a Span 

1. Press Channel Next/Channel Prev keys to select the channel whose 
sweep range will be set. 

2. Click Center, then input the center value. 

3. Click Span, then input the span value. 
Setting the Sweep Range Using the Marker 

1. In the channel window whose range must be set, place the active 
marker on the active trace to a position that corresponds to the new 
range (to the lowest, highest, or center value). 

2. Press Marker Fctn key. 

3. Click the softkey that corresponds to each value. 
  

SoftKey Function 

Marker -> Sets the lowest value to the stimulus value of the 
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Start active marker on the currently active trace. 

Marker -> 
Stop 

Sets the highest value to the stimulus value of the 
active marker on the currently active trace. 

Marker -> 
Center 

Sets the center value to the stimulus value of the 
active marker on the currently active trace. 

 If the reference marker is on and the stimulus value 
of the active marker is expressed by a value relative to the 
reference marker, the absolute stimulus value will be used to 
set the new sweep rang. 
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Enable Stimulus Signal Output 

You can turn on/off the stimulus signal output, but this will prevent you 
from performing measurement. Therefore, you will not normally use this 
feature. This is mainly used to turn the output back to on after it has been 
turned off by the power trip feature. 

Follow these steps to turn the stimulus signal output on/off: 

1. Press Sweep Setup key. 

2. Click Power > RF Out (Each press toggles between on/off). 

When set to off, "RF OFF" is displayed in Instrument Status Bar. 
Power trip 

The power trip is a feature that the instrument uses to automatically turn 
off the output of the stimulus signal to protect the instrument when a 
signal whose level exceeds the upper limit is inputted to the test port. 

If the power output is automatically turned off by the power trip feature, 
remove the cause of the over-input and turn on the power output 
according to the above steps to restart the measurement. 

Setting power level 

1. Press Channel Next/Channel Prev keys to select the desired channel. 

2. Press Sweep Setup key. 

3. Click Power > Port Couple, then select the on/off setting of the level 
coupling for all ports. 
  

ON The same power level is outputted to all ports. 

OFF A specific power level is outputted to each port 
independently. 

 The power level of port 1 is coupled with the power 
level for all ports. 

4. If you change the on/off setting of the level coupling, all ports 
are automatically changed to the same level value as that of 
port 1. 

4. Follows the following procedure according to Port Couple. 

 When setting level for all ports (Port Couple ON) 

a. Click Power, then enter the power level. 

 When setting level for each port (Port Couple OFF) 
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a. Press Port Power, then click the softkey corresponding to each 
port (Port 1 Power to Port 4 Power). 

b. Enter the power level. 
Correcting attenuation of power level (using power slope feature) 

You can use the power slope feature to correct the attenuation of a power 
level so that it is simply proportional to the frequency (attenuation due to 
cables and so on), which improves the accuracy of the level actually 
applied to the DUT. 

Turning power slope feature on/off 

1. Press Channel Next/Channel Prev keys to select the desired channel. 

2. Press Sweep Setup key. 

3. Click Power > Slope [OFF] (Slope [ON]). Each press toggles between 
on/off. 

Setting correction coefficient (correction amount per 1 GHz) 

1. Press Channel Next/Channel Prev keys to select the desired channel. 

2. Press Sweep Setup key. 

3. Click Power > Slope [xxx dB/GHz] ("xxx" represents the current set 
value.). 

4. Enter the correction coefficient using the ENTRY block keys on the 
front panel. 

Setting fixed frequency at power sweep 

The procedure for setting the fixed frequency (CW frequency) at the power 
sweep is as follows: 

1. Press Channel Next/Channel Prev keys to select the desired channel. 

2. Press Sweep Setup key. 

3. Click Power > CW Freq, then enter the fixed frequency. 

Setting CW Time Sweep 

The E5071C supports sweep type of CW Time where the E5071C is set to a 
single frequency, and the data is displayed versus time. To use the E5071C 
in CW time, follow the procedure explained below: 

1. Press Channel Next/Channel Prev keys to select the channel whose 
sweep range will be set. 

2. Press Sweep Setup > Sweep Time, then input the duration of the 
sweep which is displayed on X-axis. 

3. Click Span, then input the span value as 0 Hz (zero span). 
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4. Press Center, then input the center value. 

5. Press Marker to display the marker 1. The marker position shows the 
time for its measurement point. 

Setting Power Level with Auto Power Range (options 2D5, 4D5, 2K5 and 
4K5 only) 

 Auto Power range function works only with the 
E5071C options 2D5, 4D5, 2K5 and 4K5 having a mechanical 
source attenuator. Auto power range functionality is neither 
required nor available in other E5071C options which are having 
electrical source attenuator. 

When the Auto Power Range set function is effective, the proper source 
attenuator and power range are selected automatically according to the 
output power setting of each channel. 

Under the following conditions, turn OFF the Auto Power Range set function 
and set the power range and power level manually: 

 When different power ranges are selected in multiple channel 
measurement settings. In this case, an error message is displayed to 
avoid source attenuator damage. For example, if Channel 1 power is 
at -35 dBm with the power range of -35 dBm to 0 dBm, and Channel 
2 power is set at -5 dBm with the power range of -25 dBm to +10 
dBm, this will causes an error because each selected power range is 
different. In such a case , turn OFF the Auto Range on Channel 2 and 
set the range as -35 to 0 manually, to set the same power range as 
of Channel 1. 

 Continuous switching may damage source 
attenuator. 

Setting the level 

1. Press Channel Prev/Channel Next to select the channel for which you 
want to set the power level. 

2. Press Sweep Setup key, then click Power > Port Couple and select the 
ON/OFF setting of the level coupling for all ports. 

Value Description 

ON The same power level is outputted to all ports. 

OFF A specific power level is outputted to each port 
independently. 

1. The power level of port 1 is coupled with the power level for all 
ports when Port Couple is set to ON. 
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2. If you change the on/off setting of the level coupling, all ports 
are automatically changed to the same level value as that of 
port 1. 

3. When setting level for all ports (Port Couple ON), click Power input 
the power level using the ENTRY block keys on the front panel. 

When setting level for each port (Port Couple OFF), click Port Power 
and select the softkey corresponding to each port (Port 1 Power to Port 4 
Power). 

The table below describes the relation between source power level and 
step attenuation: 

Source Power Range Step Attenuation 

-25 ~ +10 dBm 0 dB 

-35 ~  0 dBm 10 dB 

-45 ~ -10 dBm 20 dB 

-55 ~ -20 dBm 30 dB 

-65 ~ -30 dBm 40 dB 

-75 ~ -40 dBm 50 dB 

-85 ~ -50 dBm 60 dB 

For Auto Power Range setting, the minimum value of step attenuation is 
selected according to the available source power level. The table below 
describes the step attenuation selection based on the setting source 
power level: 

Source Power Range Step Attenuation 

-25 ≤ power ≤ +10 dBm 0 dB 

-35 ≤ power <  -25 dBm 10 dB 

-45 ≤ power < -35 dBm 20 dB 

-55 ≤ power < -45 dBm 30 dB 

-65 ≤ power < -55 dBm 40 dB 

-75 ≤ power < -65 dBm 50 dB 
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-85 ≤ power < -75 dBm 60 dB 

When Power Sweep is selected as sweep type, Step attenuation is selected 
with the start power condition and the maximum value of the Stop power 
(>= Start Power) is selected with the step ATT value. 

For example: 

 Case of Start Power= -26 dBm 

o Step ATT = 10 dB, Stop Power = -26 dBm ~ 0 dBm 

 Case of Start Power = -25 dBm 

o Step ATT = 0 dB, Stop Power = -25 dBm ~ + 10 dBm 

 If the source power range (start/stop) is located on the two ranges, 
the Step ATT is set with the latest condition as: 

o After setting Start = -26 dBm, set stop = + 10 dBm, then start 
is reset with - 25 dBm value. 

 Available power differs according to the measurement 
frequency. For example, at 0 dBm Attenuator range, the 
specified maximum available power level is as follows and 
reduces in proportion to inserted Attenuator range: 

Frequency Power Level 

300 kHz to 1 MHz +8 dBm 

1MHz to 6 GHz +10 dBm 

6GHz to 8 GHz +9 dBm 

8GHz to 10.5 GHz +7 dBm 

10.5GHz to 15 GHz +3 dBm 

15 GHz to 20 GHz 0 dBm 
Correcting attenuation of power level (using power slope feature) 

You can use the power slope feature to correct the attenuation of a power 
level so that it is simply proportional to the frequency (attenuation due to 
cables and so on), which improves the accuracy of the level actually 
applied to the DUT. 

Turning power slope feature on/off 

1. Press Channel Prev/Channel Next to select the channel for which the 
power slope feature will be turned OFF. 
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2. Press Sweep Setup key, then click Power > Slope and select the 
ON/OFF setting of the power level. 

Setting correction coefficient (correction amount for 1 GHz) 

1. Press Channel Prev/Channel Next to select the channel for which you 
want to set the correction coefficient. 

2. Press Sweep Setup key, then click Power > Slope [xxx dB/GHz] where 
“xxx” represents the current set value and input the correction 
coefficient using the ENTRY block keys on the front panel. 

Setting the Number of Points 

The number of points is the number of data items collected in one sweep. 
It can be set to any number from 2 to 1601 for each channel 
independently. 

 To obtain a higher trace resolution against the stimulus value, 
choose a larger value for number of points. 

 To obtain higher throughput, keep the number of points to a smaller 
value within an allowable trace resolution. 

 To obtain higher measurement accuracy after calibration, perform 
calibration using the same number of points as in actual 
measurements. 

 When the upper limit of the number of channels and traces is 
set to 1Ch / 4 Tr 20001 Points, the maximum number of 
measurement points will be 20001. 

Setting the number of points 

1. Press Channel Next/Channel Prev keys to select the desired channel. 

2. Press Sweep Setup key. 

3. Click Points, then input the desired number of points. 

Setting the Sweep Time 

Sweep time is the time it takes to complete a sweep for each stimulus 
(source) port. Two modes are available for setting the sweep time: manual 
sweep time mode and automatic sweep time mode. 

Manual 
Sweep Time 
Mode 

In this mode, the sweep time is set manually. Once the 
sweep time is set, changes in measurement conditions 
will not affect the sweep time as long as it is within the 
analyzer's capability. If the sweep time becomes lower 
than the analyzer's lower sweep time limit, the sweep 
time will be reset to the shortest time within the 
conditions. If the sweep time exceeds the analyzer's 
upper sweep time limit, the sweep time will be reset to 
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the longest time within the conditions. 

Automatic 
Sweep Time 
Mode 

The sweep time is always kept to the shortest time 
possible with the current measurement conditions. 

The following figure shows the definitions of the sweep time and the sweep 
delay time. 

  

 
Sweep delay is time before starting a sweep for each stimulus (source) 
port 

Setting Up the Sweep Time (Manual Sweep Time Mode) 

1. Press Channel Next/Channel Prev keys to select the desired channel. 

2. Press Sweep Setup key, then Click Sweep Time. 

3. Using the ENTRY block keys on the front panel, input the desired 
sweep time (in seconds). 

If the previous operation mode was automatic sweep time mode, entering 
a new sweep time forces the analyzer to switch to manual sweep time 
mode. 

Switching to Automatic Sweep Time Mode 

1. Press Channel Next/Channel Prev keys to select the desired channel. 

2. Press Sweep Setup key, then click Sweep Time, press  0 > x1. 

By entering zero (seconds), automatic sweep time becomes effective. 
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Selecting Measurement Parameters 

The E5071C allows users to evaluate the DUT (device under test) 
characteristics by using the following measurement parameters. 

 S-parameters 

 Absolute 

 AUX Input 

Other topics about Setting Measurement Conditions 

Operation Procedure 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) 
to select the trace for which measurement parameters will be set up. 

2. Press Meas. 

3. Click a softkey that corresponds to the desired measurement 
parameter. 

S-parameters 

S-parameters (scattering parameters) are used to evaluate how signals are 
reflected by and transferred through the DUT. An S-parameter is defined 
by the ratio of two complex numbers and contains information on the 
magnitude and phase of the signal. S-parameters are typically expressed 
as follows: 

Sout in 

out: port number of the DUT from which the signal is output 

in: port number of the DUT to which the signal is input 
  

For example, S-parameter S21 is the ratio of the output signal of port 2 on 
the DUT with the input signal of port 1 on the DUT, both expressed in 
complex numbers. 

When the balance-unbalance conversion function is turned on, the Mixed 
mode S-parameters can be selected. Refer to Evaluating Balanced Devices 
(balance-unbalance conversion function for more information. 

Absolute 

Absolute shows the absolute power for reference and received signals on 
the port. 

Softkey Description 

A (n) Absolute measurement in Port 1, test receiver 
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B (n) Absolute measurement in Port 2, test receiver 

C (n) Absolute measurement in Port 3, test receiver 

D (n) Absolute measurement in Port 4, test receiver 

R1 (n) Absolute measurement in Port 1, reference receiver 

R2 (n) Absolute measurement in Port 2, reference receiver 

R3 (n) Absolute measurement in Port 3, reference receiver 

R4 (n) Absolute measurement in Port 4, reference receiver 

where n in the parentheses is the stimulus port number. For example, 
R1(1) means the reference level while the signal is output from the port 1, 
and A(2) means the received signal level into port 1 while the signal is 
output from the port 2. 

 
AUX Input 

The AUX Input Ports can be used to input DC signal for DC signal 
measurement. This is useful in cases where the DUT (Device Under Test) 
works on a DC supply and it is required to measure the DC supply along 
with other measurements of the DUT using the E5071C. 

Example of AUX Input Measurement 
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To use AUX Input Measurement: 

1. Select Aux Input 1 or Aux Input 2 (depending upon the Aux port used 
for connection) by pressing the Meas key. 

2. Select Range (1V or 10 V) [1 in the figure below]. 

 
3. Select Sweep Port (1-4) [2 in the figure above]. 

4. Click Format > Real. 

5. Perform measurements as per normal. 

6. Sweep Port [2 in the figure above] specifies the signal output 
port. For example, if sweep port is set to 1, the AUX input signal 
is measured while port 1 on the front panel outputs the RF 
signal. 
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 Selecting a Data Format 

The E5071C allows you to display measured S-parameters by using the 
following data formats. The data format can be preset to factory settings 
using the Preset option. 

 Rectangular display formats 

 Polar format 

 Smith chart format 

Other topics about Setting Measurement Conditions 

Rectangular display formats 

Rectangular display formats draw traces by assigning stimulus values 
(linear scale) to the X-axis and response values to the Y-axis. Eight 
different formats are available depending on the selection of data for the Y-
axis. 

 
  

Type Y-axis Data Type Y-axis 
Unit 

Application Examples 

Log 
magnitude 
format 

Magnitude dB  Return loss 
measurement 

 Insertion loss 
measurement (or gain 
measurement) 
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Phase format Phase (displayed in 
range from -180 ° 
  to +180 °  ) 

Degrees ( 
° ) 

Measurement of deviation 
from linear phase 

Expanded 
phase format 

Phase (can be 
displayed above 
+180 °   and below 
-180 °  ) 

Degrees ( 
° ) 

Measurement of deviation 
from linear phase 

Positive 
phase format 

Phase (displayed in 
range from 0 ° to 
+360 °  ) 

Degrees ( 
° ) 

Measurement of deviation 
from linear phase 

Group delay 
format 

Signal transfer 
delays within the 
DUT 

Seconds 
(s) 

Group delay measurement 

Linear 
magnitude 
format 

Magnitude (Abstract 
number) 

Reflection coefficient 
measurement 

SWR format 

 
(ρ: reflection 
coefficient) 

(Abstract 
number) 

Measurement of standing 
wave ratio 

Real format Real part of 
measured complex 
parameter 

(Abstract 
number) 

  

Imaginary 
format 

Imaginary part of 
measured complex 
parameter 

(Abstract 
number) 

  

Polar format 

In the polar format, traces are drawn by expressing the magnitude as a 
displacement from the origin (linear) and phase in an angle 
counterclockwise from the positive X-axis. This data format does not have 
a stimulus axis, so frequencies must be read by using the marker. The 
polar format allows users to select one of the following three data groups 
for displaying the marker response values. 

 Linear magnitude and phase ( ° ) 

 Log magnitude and phase ( ° ) 



Measurement 

97 

 Real and imaginary parts 

 
Smith chart format 

The Smith chart format is used to display impedances based on reflection 
measurement data of the DUT. In this format, traces are plotted at the 
same spots as in the polar format. The Smith chart format allows users to 
select one of the following five data groups for displaying the marker 
response values. 

 Linear magnitude and phase ( ° ) 

 Log magnitude and phase ( ° ) 

 Real and imaginary parts 

 Resistance (ohm), Reactance (ohm), and inductance (H) or 
capacitance (F) 

 Conductance (S), susceptance (S), and capacitance (F) or inductance 
(H) 
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Use the following procedure to select a data format. 

1. Press Channel Next (or Channel Prev) and Trace Next (or Trace Prev) 
to select the trace for which the data format will be set. 

2.  Press Format. 

3. Press the softkey that corresponds to the desired data format. 

Softkey Function 

Log Mag Selects the log magnitude format 

Phase Selects the phase format 

Group Delay Selects the group delay format 

Smith - Lin / 
Phase 

Selects the Smith chart format (with linear magnitude and 
phase as the marker response values) 
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Smith - Log / 
Phase 

Selects the Smith chart format (with log magnitude and phase 
as the marker response values) 

Smith - Real / 
Imag 

Selects the Smith chart format (with the real and imaginary 
parts as the marker response values) 

Smith - R + jX Selects the Smith chart format (with resistance and reactance 
as the marker response values) 

Smith - G + jB Selects the Smith chart format (with conductance and 
susceptance as the marker response values) 

Polar - Lin / 
Phase 

Selects the polar format (with linear magnitude and phase as 
the marker response values) 

Polar - Log / 
Phase 

Selects the polar format (with log magnitude and phase as the 
marker response values) 

Polar - Real / 
Imag 

Selects the polar format (with the real and imaginary parts as 
the marker response values) 

Lin Mag Selects the linear magnitude format 

SWR Selects the SWR (standing wave ratio) format 

Real Selects the real format 

Imaginary Selects the imaginary format 

Expand Phase Selects the expanded phase format 

Positive Phase Selects the positive phase format 
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Setting the Scales 

 Auto Scale 

 Manual scale adjustment on a rectangular display format 

Other topics about Setting Measurement Conditions 

Auto scale 

The auto scale function is used to tailor each scale (scale/division and the 
reference line value) automatically in such a way that traces will appear at 
the proper size on the screen for easy observation. 

 The scale data can be preset to factory settings 
using the Preset option. 

Single Trace Auto Scale 

Follow the procedure below to perform the auto scale function on a specific 
trace. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace for which the auto scale function will be 
performed. 

2. Press Scale > Auto Scale. 

Auto Scale on All Traces Within a Channel 

1.  Press Channel Next/Channel Prev keys to select the channel for which 
the auto scale function will be performed. 

2.  Press Scale > Auto Scale. 

Manual scale adjustment on a rectangular display format 

For a rectangular display format, four parameters are used to manually 
adjust the scales. 

Adjustable 
feature 

Description 

Divisions Defines the number of divisions on the Y-axis. An even number 
from 4 to 30 must be used. Once set, it is commonly applied to all 
traces displayed in any rectangular format within that channel. 

Scale/Division 
(Scale/Div) 

Defines the number of increments per division on the Y-axis. The 
value applies only to the active trace. 

Reference 
position 

Defines the position of the reference line. The position must be 
specified using the number assigned to each division on the Y-axis 
starting at 0 (the least significant) running up to the number of 
divisions being used (the most significant). The position applies 
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only to the active trace. 

Reference line 
value 
(Reference 
Value) 

Defines the value corresponding to the reference line. It must be 
set using the unit on the Y-axis. The reference line value applies 
only to the active trace. 

  

  

 

  
Manually setting scales on a rectangular display format 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace for which scale features will be adjusted. 

2.  Press Scale key. 

3. Select the softkey that corresponds to the particular feature that 
needs to be adjusted. 
  

Softkey Function 

Divisions Defines the number of divisions on the Y-axis. 

Scale/Div Defines the number of increments per division on the Y-
axis. 

Reference 
Position 

Defines the position of the reference line. 

Reference Value Defines the value corresponding to the reference line. 
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  It is also possible to turn off the display of graticule 
labels. For details, refer to 
Turning_off_the_display_of_graticule_labels. 

Manual scale adjustment on the Smith chart/polar format 

Manual scale adjustment on the Smith chart format or the polar format is 
done by using the displacement (Scale/Div of the outermost circle). 
 

 
   

Manually setting scales on the Smith chart/polar format 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace for which the scale will be adjusted. 

2. Press Scale key. 

3. Click Scale/Div, then input the displacement of the outermost circle. 
Setting the value of a reference line using the marker 

When using a rectangular display format, it is possible to change the 
reference line value to be equal to the response value of the active marker 
on the active trace. 

Setting the reference line value using the marker 

1. Place the active marker on the active trace on the position that 
corresponds to the new reference line value. 

2. Press Scale or Marker Fctn key. 
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3. Click Marker -> Reference to change the reference line value to the 
marker response value. 

4. If the reference marker is on and the stimulus value of the 
active marker is expressed using a value relative to the 
reference marker, the absolute stimulus value will be used to 
set the new reference line value. 
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Setting Window Displays 

 Maximizing the specified window trace display 

 Turning off the display of graticule labels 

 Hiding Frequency Information 

 Labeling a Window 

 Setting Display Colors 

 Setting Display Magnification 

 Resizing the Screen 

Other topics about Setting Measurement Conditions 

Maximizing the specified window/trace display 

When using multiple channels, it is possible to maximize a specific channel 
window on the screen. When multiple traces are displayed in a channel 
window, it is also possible to maximize a specific trace displayed within 
that channel window. 

 The Window/Trace Display data can be preset to 
factory settings using the Preset option 

Maximizing a window 

1. Press Channel Next  (or Channel Prev) to select the channel whose 
window will be maximized. 

2. Press Channel Max to maximize the channel window. 

3. Press Channel Max one more time to reduce the window to its 
previous size. 

Maximizing a trace display 

1. Press Channel Next  (or Channel Prev) to select the channel to which 
the trace belongs. 

2. Press Trace Next (or Trace Prev) to select the trace whose display will 
be maximized. 

3. Press Trace Max to maximize the trace display. 

4. Press Trace Max one more time to reduce the display to its previous 
size. 

Turning off the display of graticule labels 

When using a rectangular display format, the graph area can be expanded 
to the left by turning off the display of graticule labels. 

Turning off graticule label display 
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1.  Press Channel Next (or Channel Prev) to select the channel for which 
graticule label display will be turned on or off. 

2.  Press Display. 

3. Click Graticule Label to turn graticule label display on or off. 

Hiding Frequency Information 

You can hide the frequency information from the screen in order to ensure 
its confidentiality or for other reasons. 

Hiding Frequency Information on the Screen 

Follow the steps below to hide frequency information on the measurement 
screen. 

1.  Press Display key. 

2.  Click Frequency to turn off the frequency display. 

3. Turning off the frequency display using Display > Frequency key 
does not erase the frequency display within the Stimulus 
softkey, which is turned on by pressing Start, Stop, Center, and 
Span. The display of the softkey bar itself can be switched on or 
off by pressing Softkey On/Off. 

Hiding Softkey's Frequency Information 

You can delete the frequency information from the measurement screen, 
which changes the frequency information displayed in the Stimulus softkey 
and the data entry area for Hz unit to asterisks (***). 

1. Press System key. 

2. Click Service Menu, then click Security Level and select any of the 
following options for the frequency display. 
  

Softkey Function 

None Displays the frequency information. 

Low Hides the frequency information with a series of asterisks. This can 
be turned to OFF by the Security Level menu. 

High Hides the frequency information with a series of asterisks. This 
cannot be turned to OFF by the Security Level menu. 

Resetting to OFF is only possible by executing Preset or Recall. 

o Save/Recall > Save Trace Data & Save/Recall > Save SnP 
is inactive when Security Level is set to Low/High. 
  

Labeling a window 
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It is possible to assign a unique name to a channel and display it on the 
screen. This feature is useful in saving and/or printing measurement result 
for future reference. 

Labeling a window 

1. Press Channel Next/Channel Prev keys to select the channel to be 
labeled. 

2. Press Display key. 

3. Click Edit Title Label,then the title label input dialog box appears. 
 

 
3. Using the keys in the dialog box, type a label and click Enter. 

4. Click Title Label to turn on the title display. The title will appear 
within a frame at the top of the channel window. 
 

 
Setting Display Colors 
Selecting display mode 

You can select the display mode of the LCD display from two modes: 
normal display (background: black) or inverted display (background: 
white). In normal display, the colors of items are preset so that you can 
recognize them easily on the display of the instrument. On the other hand, 
in inverted display, they are preset to colors obtained by nearly inverting 
the default settings of the normal display so that you can use data easily 
when storing it into a graphic file. 

The selection procedure is as follows: 

1. Press Display. 

2. Click Invert Color to select the display color. OFF indicates the normal 
display; ON the inverted display. 

Setting display color for each item 
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You can set the display color to the normal display or the inverted display 
separately for each of the following items. 

 Data/memory trace 

 Labels and lines of graphs 

 File display of the limit test and limit lines 

 Background 

You set the color of each item by specifying the amounts of red (R), green 
(G), and blue (B) contained in the color. You can specify each level of R, G, 
and B in 6 steps (0 to 5). Therefore, 216 colors in total are available by 
combining them. The table below shows the R, G, and B values for the 
main colors as a reference. 

  R G B   R G B   R G B 

White 5 5 5 Gray 2 2 2 Black 0 0 0 

Light 
red 

5 3 3 Red 5 0 0 Dark 
Red 

2 0 0 

Light 
yellow 

5 5 3 Yellow 5 5 0 Dark 
Yellow 

2 2 0 

Light 
green 

3 5 3 Green 0 5 0 Dark 
Green 

0 2 0 

Light 
cyan 

3 5 5 Cyan 0 5 5 Dark 
cyan 

0 2 2 

Light 
blue 

3 3 5 Blue 0 0 5 Dark 
Blue 

0 0 2 

Light 
magent
a 

5 3 5 Magent
a 

5 0 5 Dark 
Magent
a 

2 0 2 

The setting procedure is as follows: 

1. Press System > Misc Setup > Display Setup > Color Setup 

2. Click Normal (for normal display) or Invert (for inverted display). 

3. Click the softkey corresponding to the item for which you want to set 
the display color. 
  

Softkey Function 

Data Trace 1 to 16 Specifies the data trace of traces 1 to 16 
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Mem Trace 1 to 16 Specifies the memory trace of traces 1 to 16 

Graticule Main Specifies the graticule label and the outer lines of graphs 

Graticule Sub Specifies the grid of graphs 

Limit Fail Specifies the fail display in the limit test result 

Limit Line Specifies the limit line 

Background Specifies the background 

4. Click Red (or, Green, or Blue). 

5.  Select the amount of the selected color from 0 to 5. 
Resetting the display colors to the factory state 

You can reset the display colors in normal display and inverted display to 
the preset factory state. 

The selection procedure is as follows: 

1. Press System > Misc Setup > Display Setup > Color Setup. 

2. Click Normal (for normal display) or Invert (for inverted display). 

3. Click Reset Color  > OK. 

Setting Display Magnification 

You can reset the display magnification to Small, Normal or Large. 

The selection procedure is as follows: 

1. Press System > Misc Setup > Display Setup > Magnification. 

2. Click Normal, Small or Large. 

Resizing the Screen 

You can resize the E5071C screen by minimizing, maximizing or restoring 
it to its original size. 

The resizing procedure is as follows: 

1. Click Resize at the top right corner of the screen. 

 
2. A drop-down menu prompts and the available options are: 
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Softkey Function 

Restore Restores the screen to its default size. 

Minimize Minimizes the screen. 

Maximize Displays the screen in full page size. 

3. Click Restore,Minimize or Maximize. 

4. When the screen is resized according to an option, its related softkey 
is disabled. For example, when the screen is displayed in full page 
size, Maximize is disabled. 

Another option to minimize the E5071C screen is by using the Menu Bar 
and the procedure is as follows: 

1. Press Display. 

2. Click Minimize E5071C. 

You can also hide and restore the title bar of the E5071C screen and the 
procedure is as follows: 

1. Press Display. 

2. Click E5071C Title bar. 

3. Click ON to restore the title bar. 

4. Click OFF to hide the title bar. 
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Calibration 

Calibration 
Overview 

 Measurement Errors and their Characteristics 

 Calibration Types and Characteristics 

 Checking Calibration Status 

 Clear Calibration 

Basic Calibration 

 Selecting Calibration Kit 

 OPEN/SHORT Response Calibration (reflection test) 

 THRU Response Calibration (transmission test) 

 Enhanced Response Calibration 

 1-Port Calibration (reflection test) 

 Full 2-Port Calibration 

 Full 3-Port Calibration 

 Full 4-Port Calibration 

Calibration with ECal (Electronic Calibration) 

 ECal (Electronic Calibration) 

 ECal Driver Installation 

 1-Port Calibration Using a 2-Port ECal Module 

 Calibration Using 4-port ECal 
If you have 2 port Ecal: 

 Full 2-Port Calibration Using the 2-Port ECal Module 

 Full 3-Port and Full 4-Port Calibration using 2-Port ECal 
Advanced Calibration with ECal 

 Improving Calibration Accuracy along with ECal 

 Confidence Check on Calibration Coefficients Using ECal 

 Turning off ECal Auto-detect Function 

 User-characterized ECal 

Advanced Calibration 

 Setting the Trigger Source for Calibration 

 Sliding Offset and Load Calibration 
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 Modifying Calibration Kit Definition 

 Specifying Different Standard for Each Frequency 

 Receiver Calibration 

 Power Calibration 

 Partial Overwrite 

 Simplified Calibration 

 Adapter Removal-Insertion 

 Unknown Thru Calibration 

 Performing 8 term Calibration using External PC 

Mixer Calibration 

 Scalar-Mixer Calibration 

 Vector-Mixer Calibration 

TRL Calibration 

 2-port TRL calibration 

 3-port TRL calibration 

 4-port TRL calibration 

  



E5071C 

112 

Measurement Errors and their Characteristics 

 Overview 

 Drift Errors 

 Random Errors 

 Systematic Errors 

Other topics about Calibration 

Overview 

It is important to understand the factors contributing to measurement 
errors in order to determine the appropriate measures that should be 
taken to improve accuracy. Measurement errors are classified into three 
categories: 

Drift Errors 

Drift errors are caused by deviations in the performance of the measuring 
instrument (measurement system) that occur after calibration. Major 
causes are the thermal expansion of connecting cables and thermal drift of 
the frequency converter within the measuring instrument. These errors 
may be reduced by carrying out frequent calibrations as the ambient 
temperature changes or by maintaining a stable ambient temperature 
during the course of a measurement. 

Random Errors 

Random errors occur irregularly in the course of using the instrument. 
Since random errors are unpredictable, they cannot be eliminated by 
calibration. These errors are further classified into the following sub-
categories depending on their causes. 

  Instrument noise errors 

  Switch repeatability errors 

  Connector repeatability errors 
Instrument noise errors 

Instrument noise errors are caused by electric fluctuations within 
components used in the measuring instrument. These errors may be 
reduced by increasing the power of the signal supplied to the DUT, 
narrowing the IF bandwidth, or enabling sweep averaging. 

Switch repeatability errors 

Switch repeatability errors occur due to the fact that the electrical 
characteristics of the mechanical RF switch used in the measuring 
instrument change every time it is switched on. These errors may be 
reduced by carrying out measurements under conditions in which no 
switching operation takes place. 
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(You don't need to worry about these errors since the E5071C does not 
have mechanical RF switches). 

Connector repeatability errors 

Connector repeatability errors are caused by fluctuations in the electrical 
characteristics of connectors due to wear. These errors may be reduced by 
handling connectors with care. 

Systematic Errors 

Systematic errors are caused by imperfections in the measuring instrument 
and the test setup (cables, connectors, fixtures, etc.). Assuming that these 
errors are repeatable (i.e., predictable) and their characteristics do not 
change over time, it is possible to eliminate them mathematically at the 
time of measurement by determining the characteristics of these errors 
through calibration. There are six types of systematic errors, as follows. 

Errors caused by signal leaks in the measuring system: 

 Directivity 

 Isolation (cross-talk) 

Errors caused by reflections in the measuring system: 

 Source match 

 Load match 

Errors caused by the frequency response of the receiver within the 
measuring instrument: 

 Reflection tracking 

 Transmission tracking 

The E5071C has two receivers for each test port: the reference receiver 
and the test receiver (transmission measurement or reflection 
measurement). You can perform measurements with both of these 
receivers at the same time. 

E5071C port architecture and systematic errors 
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Directivity error (Ed) 

Directivity errors are caused by the fact that, in a reflection measurement, 
signals other than the reflection signal from the DUT are received by 
receiver T1 through the directivity coupler. When a certain port is a 
stimulus port, this error can be defined as a constant value for each 
stimulus port because the state of the termination at the other ports does 
not change. The number of directivity errors of the E5071C is the number 
of stimulus ports you use. 

Ed1 Directivity error of port 1 

Ed2 Directivity error of port 2 

Ed3 Directivity error of port 3 

Ed4 Directivity error of port 4 
Isolation error (Ex) 
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An isolation error (crosstalk error) is caused by signals other than the 
transmission signal of the DUT leaking to the test receiver of the 
transmission measurement port in transmission measurements. When a 
certain port is a stimulus port, an isolation error is defined for each of the 
other ports. Therefore, the number of isolation errors for the E5071C is the 
total number of combinations of stimulus ports and response ports. 

Ex21, Ex31, and Ex41 Isolation error when port 1 is a stimulus port 

Ex12, Ex32, and Ex42 Isolation error when port 2 is a stimulus port 

Ex13, Ex23, and Ex43 Isolation error when port 3 is a stimulus port 

Ex14, Ex24, and Ex34 Isolation error when port 4 is a stimulus port 
Source match error (Es) 

A source match error is caused when the reflection signal of the DUT 
reflects at the signal source and enters the DUT again. When a certain port 
is a stimulus port, this error can be defined as a constant value for each 
stimulus port because the state of the signal source switch does not 
change. The number of source match errors in the E5071C is equivalent to 
the number of stimulus ports you use. 

Es1 Source match error of port 1 

Es2 Source match error of port 2 

Es3 Source match error of port 3 

Es4 Source match error of port 4 
Load match error (El) 

A load match error is caused when part, but not all, of the signal 
transmitted in the DUT reflects at a response port is measured by the 
receiver of the response port. When a certain port is a stimulus port, a load 
match error is defined for each of the other ports. Therefore, the number 
of load match errors for the E5071C is the total number of combinations of 
stimulus ports and response ports. 

El21, El31, and El41 Load match error when port 1 is a stimulus port 

El12, El32, and El42 Load match error when port 2 is a stimulus port 

El13, El23, and El43 Load match error when port 3 is a stimulus port 

El14, El24, and El34 Load match error when port 4 is a stimulus port 
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Reflection tracking error (Er) 

A reflection tracking error is caused by the difference in frequency 
response between the test receiver and the reference receiver of a 
stimulus port in reflection measurements. This error can be defined as a 
constant value for each stimulus port because the combination of the test 
receiver and the reference receiver of a stimulus port is always the same. 
The number of reflection tracking errors for the E5071C is simply the 
number of stimulus ports you use. 

Er1 Reflection tracking error of port 1 

Er2 Reflection tracking error of port 2 

Er3 Reflection tracking error of port 3 

Er4 Reflection tracking error of port 4 

  
 Transmission tracking error (Et) 

A transmission tracking error is caused by the difference in frequency 
response between the test receiver of a response port and the reference 
receiver of a stimulus port in transmission measurements. When a certain 
port is a stimulus port, a transmission tracking error is defined for each of 
the other ports. Therefore, the number of transmission tracking errors for 
the E5071C is the total number of combinations of stimulus ports and 
response ports. 

Et21, Et31, and 
Et41 

Transmission tracking error when port 1 is a 
stimulus port 

Et12, Et32, and 
Et42 

Transmission tracking error when port 2 is a 
stimulus port 

Et13, Et23, and 
Et43 

Transmission tracking error when port 3 is a 
stimulus port 

Et14, Et24, and 
Et34 

Transmission tracking error when port 4 is a 
stimulus port 
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Calibration Types and Characteristics 

The table shows the different types of calibrations and the features of each 
method. 

Calibra
tion 
Method 

Standar
d (s) 
Used 

Corrected Error 
Factor 

Measurement 
Parameters 

Character
istics 

No 
calibra
tion 

None None All parameters 

 Low 
accuracy 

 Calibratio
n not 
required 

Respon
se 
Calibra
tion 

OPEN or 
SHORT 

LOAD 

Following 2 error 
terms: 

 Reflection Tracking 
(Er) 

 Directivity (Ed) 

S11(Reflection 
characteristics at 1 port) 

 Medium-
level 
accuracy 

 Quick 
calibratio
n 

 Isolation 
calibratio
n 
improves 
the 
accuracy 
in a 
reflection 
measure
ment of a 
DUT with 
high 
return 
loss 

THRU 

LOAD 

Following 2 error 
terms: 

 Transmission 
Tracking (Et) 

 Isolation (Ex) 

S21 
(1 direction transmission 
characteristics at 2 ports) 

 Medium-
level 
accuracy 

 Quick 
calibratio
n 

 Isolation 
calibratio
n 
improves 
the 
accuracy 
in a 



E5071C 

118 

transmiss
ion 
measure
ment of a 
device 
with high 
insertion 
loss 

1-Port 
Calibra
tion 

ECal 
module 
(2-
port/4-
port) 

Following 3 error 
terms: 

 Directivity (Ed) 

 Source Match (Es) 

 Reflection Tracking 
(Er) 

S11 
(Reflection characteristics at 
1 port) 

 1-port 
measure
ment 
with the 
highest 
degree 
of 
accuracy 

 Quick 
calibratio
n with 
low 
chance 
of 
operator 
error 

OPEN 

SHORT 

LOAD 

 Highly 
accurate 
1-port 
measure
ment 

Enhanc
ed 
Respon
se 
Calibra
tion 

Ecal 
module 
(2-port) 

Following 5 error 
terms: 

 Directivity (Ed1) 

 Isolation (Ex21) 

 Source Match (Es1) 

 Transmission 
Tracking (Et21) 

 Reflection Tracking 
(Er1) 

S11, S21 (1 direction 
transmission/Reflection 
characteristics at 2 ports) 

 Highly 
accurate 
2-port 
measure
ment 
(higher 
than 
response 
calibratio
n) 

 Quick 
calibratio
n with 
low 
chance 
of 
operator 
error 
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OPEN 

SHORT 

LOAD 

THRU 

 Highhly 
accurate 
2-port 
measure
ment 
(higher 
than 
response 
calibratio
n) 

Full 2-
Port 
Calibra
tion 

ECal 
module 
(2-
port/4-
port) 

Following 12 error 
terms: 

 Directivity (Ed1,Ed2) 

 Isolation (Ex21,Ex12) 

 Source Match 
(Es1,Es2) 

 Load Match 
(El12,El21) 

 Transmission 
Tracking (Et21,Et12) 

 Reflection Tracking 
(Er1,Er2) 

S11,S21,S12,S22 
(All S-parameters at 2 
ports) 

 Highly 
accurate 
2-port 
measure
ment 

 Quick 
calibratio
n with 
low 
chance 
of 
operator 
error 

OPEN 

SHORT 

LOAD 

THRU 

 Highly 
accurate 
2-port 
measure
ment 

Full 3-
Port 
Calibra
tion 

ECal 
module 
(2-port/ 
4-port) 

Following 27 error 
terms: 

 Directivity 
(Ed1,Ed2,Ed3) 

 Isolation 
(Ex21,Ex31,Ex12,Ex3
2,Ex13,Ex23) 

 Source Match 
(Es1,Es2,Es3) 

 Load Match 
(El21,El31,El12,El32,
El13,El23) 

 Transmission 
Tracking 
(Et21,Et31,Et12,Et32,
Et13,Et23) 

 Reflection Tracking 
(Er1,Er2,Er3) 

S11,S21,S31,S12,S22,S32,
S13,S23,S33 
(All S-parameters at 3 
ports) 

 Highly 
accurate 
3-port 
measure
ment 

 Quick 
calibratio
n with 
low 
chance 
of 
operator 
error 

OPEN 

SHORT 

LOAD 

THRU 

 Highly 
accurate 
3-port 
measure
ment 
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Simplif
ied full 
3-port 
calibra
tion 

OPEN 

SHORT 

LOAD 

THRU 

Same as full 3-port 
calibration 

S11, S21, S31, S12, S22, 
[S32], S13, [S23], S33 
(Part of thru measurement 
can be skipped) 

 High-
accuracy 
3-port 
measure
ment 

 Simpler 
procedure 
by 
skipping 
thru 
measure
ment 

Full 4-
Port 
Calibra
tion 

ECal 
module 
(2-port/ 
4-port) 

Following 48 error 
terms: 

 Directivity 
(Ed1,Ed2,Ed3,Ed4) 

 Isolation 
(Ex21,Ex31,Ex41,Ex1
2,Ex32,Ex42 
,Ex13,Ex23,Ex43,Ex1
4,Ex24,Ex34) 

 Source Match 
(Es1,Es2,Es3,Es4) 

 Load Match 
(El1,El2,El3,El4) 

 Transmission Tracking 
(Et21,Et31,Et41,Et12,
Et32, 
Et42,Et13,Et23,Et43,E
t14 
,Et24,Et34) 

 Reflection Tracking 
(Er1,Er2,Er3,Er4) 

S11,S21,S31,S41,S12,S22,
S32,S42, 
S13,S23,S33,S43,S14,S24,
S34,S44 
(All S-parameters at 4 
ports) 

 Highly 
accurate 
4-port 
measure
ment 

 Quick 
calibratio
n with 
low 
chance of 
operator 
error 

OPEN 

SHORT 

LOAD 

THRU 

 Highly 
accurate 
4-port 
measure
ment 

Simplif
ied full 
4-port 
calibra
tion 

Open 

Short 

Load 

Thru 

Same as full 4-port 
calibration 

S11, S21, S31, [S41], S12, 
S22, [S32], 
[S42], S13, [S23], S33, 
S43, [S14], [S24], S34, S44 
(Part of thru measurement 
can be skipped) 

 High-
accuracy 
4-port 
measure
ment 

 Simpler 
procedure 
by 
skipping 
thru 
measure
ment 

2-Port Reflectio Following 12 error S11,S21,S12,S22  Highly 
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TRL 
Calibra
tion 

n (OPEN 
or 
SHORT) 

THRU 

LINE 

MATCH 

terms: 

 Directivity (Ed1,Ed2) 

 Source Match 
(Es1,Es2) 

 Load Match (El1,El2) 

 Transmission Tracking 
(Et21,Et12) 

 Reflection Tracking 
(Er1,Er2) 

(All S-parameters at 2 
ports) 

accurate 
2-port 
measure
ment 

 Effective 
for non-
coaxial 
device 
measure
ment 

3-Port 
TRL 
Calibra
tion 

Reflectio
n 
(OPEN 
or 
SHORT) 

THRU 

LINE 

MATCH 

Following 27 error 
terms: 

 Directivity 
(Ed1,Ed2,Ed3) 

 Source Match 
(Es1,Es2,Es3) 

 Load Match 
(El21,El31,El12,El32,E
l13,El23) 

 Transmission Tracking 
(Et21,Et31,Et12,Et32, 
Et13,Et23) 

 Reflection Tracking 
(Er1,Er2,Er3) 

S11,S21,S31,S12,S22,S32,
S13,S23,S33 
(All S-parameters at 3 
ports) 

 Highly 
accurate 
3-port 
measure
ment 

 Effective 
for non-
coaxial 
device 
measure
ment 

Simplif
ied 3-
port 
TRL 
calibra
tion 

Reflectio
n (open 
or short) 

Thru 

Line 

Match 

Same as 3-port TRL 
calibration 

S11, S21, S31, S12, S22, 
[S32], S13, [S23], S33 
(Part of thru (or line) and 
line (or match) 
measurement can be 
skipped) 

 High-
accuracy 
3-port 
measure
ment 
Effective 
for non-
coaxial 
device 
measure
ment 

 Simpler 
procedure 
by 
skipping 
thru/line/
match 
measure
ment 

4-Port 
TRL 
Calibra

Reflectio
n (OPEN 
or 

Following 48 error 
terms: 

 Directivity 

S11,S21,S31,S41,S12,S22,
S32,S42,S13, 

S23,S33,S43,S14,S24,S34,

Highly 
accurate 
4-port 
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tion SHORT) 

THRU 

LINE 

MATCH 

(Ed1,Ed2,Ed3,Ed4) 

 Source Match 
(Es1,Es2,Es3,Es4) 

 Load Match 
(El1,El2,El3,El4) 

 Transmission Tracking 
(Et21,Et31,Et41,Et12,
Et32,Et42, 
Et13,Et23,Et43,Et14,E
t24,Et34) 

 Reflection Tracking 
(Er1,Er2,Er3,Er4) 

S44 
(All S-parameters at 4 
ports) 

measure
ment 
Effective 
for non-
coaxial 
device 
measure
ment 

Simplif
ied 4-
port 
TRL 
calibra
tion 

Reflectio
n (open 
or short) 

Thru 

Line 

Match 

Same as 4-port TRL 
calibration 

S11, S21, S31, [S41], S12, 
S22, [S32], [S42], S13, 
[S23], S33, S43, [S14], 
[S24], S34, S44 
(Part of thru (or line) and 
line (or match) 
measurement can be 
skipped) 

 High-
accuracy 
4-port 
measure
ment 
Effective 
for non-
coaxial 
device 
measure
ment 

 Simpler 
procedure 
by 
skipping 
thru/line/
match 
measure
ment 

Other topics about Calibration 
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Checking Calibration Status 

 Execution Status of Error Correction for Each Channel 

 Execution Status of Error Correction for Each Trace 

 Acquisition Status of Calibration Coefficient for Each Channel 

Other topics about Calibration 

Execution Status of Error Correction for Each Channel 

You can check the execution status of error correction for each channel 
with the error correction status. 

The error correction status is indicated in the channel status bar in the 
lower part of the window by the symbols in the below table. 

Symbol Execution status of error correction 

Cor 
(displayed in 
blue) 

Error correction: On (enabled for all traces) 

Cor 
(displayed in 
gray) 

Error correction: On (enabled for some traces) 

Off 
(displayed in 
gray) 

Error correction: Off 

--- (displayed 
in gray) 

Error correction: On (no calibration data) 

C? 
(displayed in 
blue) 

Error correction: On (Interpolation is being executed or the IF 
bandwidth, power level, power range, sweep time, sweep delay time, 
sweep mode, or sweep type is different from that when the calibration 
was executed.) 

C! 
(displayed in 
blue) 

Error correction: On (Extrapolation is being executed.) In the option 
TDR, even after making deskew and calibration, this is displayed. 

An asterisk (*) in the upper-right of the softkey indicates that the existing 
calibration coefficient will be cleared if you select the test port and execute 
acquisition of the calibration coefficient (clicking Done). 

Execution Status of Error Correction for Each Trace 

You can check the status of the error correction actually executed for each 
trace with the trace status area. 
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For a trace for which error correction is executed, the applied calibration 
type is indicated in the trace status area by the symbols in the table below. 

Symbol Calibration type 

RO Open response calibration 

RS Short response calibration 

RT Thru response calibration 

ER Enhanced response calibration 

F1 1-port calibration 

F2 Full 2-port calibration/2-port TRL calibration 

F3 Full 3-port calibration/3-port TRL calibration 

F4 Full 4-port calibration/4-port TRL calibration 

If none of the symbols described above is displayed, error correction is not 
executed for the trace. 

Acquisition Status of Calibration Coefficient for Each Channel 

You can check the acquisition status of the calibration coefficient for each 
channel with the calibration property. 

The calibration property displays the acquisition status of the calibration 
coefficient between test ports for each channel in matrix format. The 
following figure shows an example of when the calibration coefficients have 
been acquired for the full 2-port calibration between test ports 1 and 2, the 
response calibration for test port 3, and the response calibration (THRU) 
between test ports 4 and 3. 

 Example of calibration property display 
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  The simplified full 3/4-port calibration and the 
simplified 3/4-port TRL calibration are not discriminated from 
the normal full-port and TRL calibrations, and F is displayed. 

Procedure to turn on/off calibration property display 

Follow these steps to turn on/off the calibration property display. 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to turn on/off the calibration property display. 

2. Press Cal key. 

3. Click Property. Each press toggles the on/off setting. 
Conditions for clearing already acquired calibration coefficients 

In the following cases, already acquired calibration coefficients are cleared. 

  Executing preset clears all calibration coefficients. 

  If S parameters required to calculate the calibration coefficient for 
the specified calibration type and test ports and those required for 
the existing calibration coefficient overlap, executing the acquisition 
of the calibration coefficient (measuring necessary data and then 
clicking the Done softkey) clears the calibration coefficient for which 
necessary S parameters overlap. Taking the Example of calibration 
property display as an example, if you acquire the calibration 
coefficient of the 1-port calibration for test port 4, neither calibration 
coefficient is cleared. On the other hand, if you acquire the 
calibration coefficient for the full 2-port calibration between test ports 
2 and 3, the calibration coefficient of the full 2-port calibration 
between test ports 1 and 2 and that of the response calibration for 
test port 3 are cleared. 
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Clear Calibration 

This softkey clears the user calibration data. When Calibration is done for a 
particular DUT, the data get stored in the E5071C. To clear this data, Clear 
Calibration can be used which removes the User calibration data from the 
E5071C. 

Other topics about Calibration 
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Basic Calibrations 
Selecting Calibration Kit 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

Before executing calibration, you need to select a calibration kit. 

If you use a calibration kit other than a predefined one, you need to define 
it. If the connector type of the standard of the calibration kit you use has 
polarity (the distinction between male and female), you need to change the 
standard class definition of the calibration kit depending on the standard 
you actually use. For more information, see Modifying Calibration Kit 
Definition. 

 If you select a predefined calibration kit, (m) and (f) 
in the name (label) of the standard displayed in the softkey 
indicate male (m) and female (f) for the analyzer's connector, 
respectively. 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 

Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to select the calibration kit. 

2. Press Cal Key. 

3. Click Cal Kit, then select the calibration kit. 

4.  If the name (label) of the calibration kit has been changed, the 
label is displayed as the softkey. 

5.  An asterisk (*) on the upper right of the softkey corresponding 
to a predefined calibration kit indicates that its definition value 
has been changed from the factory setting by the user. 
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OPEN/SHORT Response Calibration (reflection test) 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

In OPEN or SHORT response calibration, calibration data are measured by 
connecting an OPEN or SHORT standard, respectively, to the desired test 
port. For frequency response, these calibrations effectively eliminate the 
reflection tracking error from the test setup reflection test using that port. 

 1-Port error model (OPEN/SHORT response) 

 
It is also possible to carry out isolation calibration with a LOAD standard 
during OPEN/SHORT response calibration. An isolation calibration will 
eliminate the directivity error from the test setup in a reflection test using 
that port 

1-Port error model (OPEN/SHORT response + isolation) 

 
 System Z0 should be changed to 1 ohm before 

calibration when using waveguide calibration kit and measuring 
waveguide devices. 

Procedure 
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1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate. 

4. Select OPEN or SHORT response calibration. 

Softkey Function 

Response 
(Open) 

Displays softkeys for performing an OPEN response 
calibration (response calibration with an OPEN 
standard) 

Response 
(Short) 

Displays softkeys for performing a SHORT response 
calibration (response calibration with a SHORT 
standard) 

5.   

6. Click Select Port. 

7. Select the test port upon which you will perform OPEN/SHORT 
response calibration. 

8. Connect a calibration standard (OPEN or SHORT) to the selected test 
port (connector to which the DUT is to be connected). 

9. Click Open or Short to start the calibration measurement. 

10. If an isolation calibration must be performed using a LOAD 
standard, follow the procedure below. 

11.  Connect a LOAD standard to the selected test port (connector to 
which the DUT is to be connected). 

12. Click Load (Optional) to start the measurement on the LOAD 
standard. 

13. Click Done to terminate the response calibration (and the LOAD 
isolation calibration) process. Upon pressing this key, calibration 
coefficients will be calculated and saved. The error correction 
function will also be automatically enabled. 

  Connecting standards in OPEN/SHORT Response calibration 
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THRU Response Calibration (transmission test) 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

In THRU response calibration, calibration data are measured by connecting 
a THRU standard to the desired test port. This calibration effectively 
eliminates the frequency response transmission tracking error from the 
test setup in a transmission test using that port. 

2-Port error model (THRU response) 

 
   

It is also possible to carry out an isolation calibration using a LOAD 
standard in the process of THRU response calibration. An isolation 
calibration will eliminate isolation error (crosstalk error) from the test 
setup in a transmission test using that port. 

2-Port Error model (THRU response + isolation) 

 
  

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 

Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > Response (Thru) > Select Ports. 
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4. Select the test ports (and corresponding S parameters) upon which a 
THRU response calibration is to be performed.   

5. Make a  between the selected test ports (between the connectors to 
which the DUT will be connected). 

 
  

6. Click Thru to start the calibration measurement. 

o The sweep is performed twice in the one thru 
measurement. 

7. If an isolation calibration must be performed using a LOAD standard, 
follow the procedure below. 

6.  

a. Connect a LOAD standard to each of the two selected test ports 
(connectors to which the DUT is to be connected). 
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b. Click Isolation (Optional) to start the calibration measurement. 

7. Click Done to terminate the response calibration (and the LOAD 
isolation calibration) process. Upon pressing this key, calibration 
coefficients will be calculated and saved. The error correction 
function will also be automatically enabled. 
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Enhanced Response Calibration 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

In enhanced response calibration, calibration data are measured by 
connecting an OPEN standard, a SHORT standard, or a LOAD standard to 
the output port (or a THRU standard between two ports).This calibration 
effectively eliminates the directivity error, crosstalk, source match error, 
frequency response reflection tracking error, and frequency response 
transmission tracking error from the test setup in a transmission or 
reflection test using those ports . 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 

2-Port Error Model (Enhanced Response) 

  

 
Procedure 

Connecting the Standard at Enhanced Response Calibration 
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1. Press Channel Next/Channel Prev keys to select the channel for which 

you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate. 

4. Click Enhanced Response. 

5. Click Ports to select the test ports on which an enhanced response 
calibration will be performed. 

6. Connect an OPEN calibration standard to the output port. 

7. Click Open to start the calibration measurement. 

o  If you select the calibration kit which has different 
calibration definitions for each gender, (m) and (f) in the 
name (label) of the standard displayed in the softkey 
indicate male (m) and female (f) for the analyzer's 
connector, respectively. 

8. Disconnect the OPEN calibration standard and replace it with a 
SHORT calibration standard. 

9. Click Short to start the calibration measurement. 

10. Disconnect the SHORT calibration standard and replace it with a 
LOAD standard. 

11. Click Load to start the calibration measurement. 

12. Make a THRU connection between the two ports. 

13. Click Thru to start the calibration measurement. 

14. If an isolation calibration must be performed using a LOAD 
standard, follow the procedure below: 

13.  

a. Connect a LOAD standard to the two test ports. 
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b. Click Isolation (Optional) to start the calibration measurement. 

c. Click Return. 

14. Click Done to terminate the enhanced response calibration 
process. Upon pressing the key, calibration coefficients will be 
calculated and saved. The error correction function will also be 
automatically enabled. 
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1-Port Calibration (reflection test) 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

In 1-port calibration, calibration data are measured by connecting an OPEN 
standard, a SHORT standard, and a LOAD standard to the desired test 
port. This calibration effectively eliminates the frequency response 
reflection tracking error, directivity error, and source match error from the 
test setup in a reflection test using that port. 

 
1-Port error model (1-port calibration) 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 

Procedure 

1. Press Channel Next/Channel Prev keys to  select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > 1-Port Cal > Select Port. 

4. Select a test port (and corresponding S parameter) on which 1-port 
calibration will be performed. 

5. Connect an OPEN calibration standard to the selected test port 
(connector to which the DUT is to be connected). 

6. Click Open to start the calibration measurement. 

o If you select the calibration kit which has different 
calibration definitions for each gender, (m) and (f) in the 
name (label) of the standard displayed in the softkey 
indicate male (m) and female (f) for the analyzer's 
connector, respectively. 
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7. Connect a SHORT calibration standard to the selected test port 
(connector to which the DUT is to be connected). 

8. Click Short to start the calibration measurement. 

9. Connect a LOAD calibration standard to the selected test port 
(connector to which the DUT is to be connected). 

10. Click Load to start the calibration measurement. 

11. Click Done to terminate the 1-port calibration process. Upon 
pressing this key, calibration coefficients will be calculated and 
saved. The error correction function will also be automatically 
enabled. 

Connecting the standard for 1-port calibration 
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Full 2-Port Calibration 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

In full 2-port calibration, calibration data are measured by connecting an 
OPEN standard, a SHORT standard, or a LOAD standard to two desired test 
ports (or a THRU standard between two ports).This calibration effectively 
eliminates the directivity error, crosstalk, source match error, frequency 
response reflection tracking error, and frequency response transmission 
tracking error from the test setup in a transmission or reflection test using 
those ports. This calibration makes it possible to perform measurements 
with the highest possible accuracy. A total of twelve error terms, six each 
in the forward direction and the reverse direction, are used in a calibration. 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 

  

 
Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 
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2. Press Cal key. 

3. Click Calibrate > 2-Port Cal. 

4. Click Select Ports, then select the test ports on which you will 
perform full 2-port calibration. (In the procedure below, the selected 
test ports are denoted as x and y.) 

5. Click Reflection. 

6. Connect an OPEN calibration standard to test port x (the connector 
to which the DUT is to be connected). 

7. Click Port x Open to start the calibration measurement (x denotes the 
test port to which the standard is connected). 

o If you select the calibration kit which has different 
calibration definitions for each gender, (m) and (f) in the 
name (label) of the standard displayed in the softkey 
indicate male (m) and female (f) for the analyzer's 
connector, respectively. 

8. Disconnect the OPEN calibration standard and replace it with a 
SHORT calibration standard. 

9. Click Port x Short to start the calibration measurement (x denotes the 
test port to which the standard is connected). 

10. Disconnect the SHORT calibration standard and replace it with a 
LOAD standard. 

11. Click Port x Load to start the calibration measurement (x denotes 
the test port to which the standard is connected). 

12. Repeat the above procedure for port y. 

13. Click Return. 

14. Click Transmission. 

15. Make a THRU connection between ports x and y (between the 
connectors to which the DUT is to be connected). 

16. Click Port x-y Thru to start the calibration measurement (x and y 
denote the test ports between which the THRU connection is being 
made). 

17. Click Return. 

18. If an isolation calibration must be performed using a LOAD 
standard, follow the procedure below. 

19. Click Isolation (Optional). 

20. Connect a LOAD standard to each of the two test ports 
(connectors to which the DUT is to be connected). 
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21. Click Port x-y Isol to start the calibration measurement (x and y 
denote the port numbers to which the LOAD standard is connected). 

22. Click Return. 

23. Click Done to terminate the full 2-port calibration process. Upon 
pressing this key, calibration coefficients will be calculated and 
saved. The error correction function will also be automatically 
enabled. 

  Connecting standards in full 2-port calibration 
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Full 3-Port Calibration 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

In full 3-port calibration, calibration data are measured by connecting an 
OPEN standard, a SHORT standard, or a LOAD standard to three desired 
test ports (or a THRU standard between three ports). This calibration 
effectively eliminates the directivity error, crosstalk, source match error, 
load match error, frequency response reflection tracking error, and 
frequency response transmission tracking error from the test setup in a 
transmission or reflection test using those ports. As in full 2-port 
calibration, this calibration method also makes it possible to perform 
measurements with the highest possible accuracy. There are unique error 
terms for directivity, source match, and reflection tracking for each 
stimulus test port (3 × 3 ports = 9). As for isolation, load match, and 
transmission tracking errors, there are unique terms for each combination 
between a stimulus port and a response port (3 × 6 combinations = 18). 
Therefore, in total, 27 error terms are involved in a full 3-port calibration. 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 
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Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > 3-Port Cal. 

4. Click Select Ports, then select the test ports on which you will 
perform full 3-port calibration. 

Reflection 

1. Click Reflection. 

2. Connect an OPEN calibration standard to test port x (the connector 
to which the DUT is to be connected). 

3. Click Port x Open to start the calibration measurement (x denotes the 
test port to which the standard is connected). 

o If you select the calibration kit which has different 
calibration definitions for each gender, (m) and (f) in the 
name (label) of the standard displayed in the softkey 
indicate male (m) and female (f) for the analyzer's 
connector, respectively. 

4. Disconnect the OPEN calibration standard and replace it with a 
SHORT calibration standard. 

5. Click Port x Short to start the calibration measurement (x denotes the 
test port to which the standard is connected). 

6. Disconnect the SHORT calibration standard and replace it with a 
LOAD standard. 

7. Click Port x Load to start the calibration measurement (x denotes the 
test port to which the standard is connected). 

8. Repeat the above procedure for ports y and z. 

9. Click Return. 

Transmission  

1. Click Transmission. 

2. Make a THRU connection between ports x and y (between the 
connectors to which the DUT is to be connected). 

3. Click Port x-y Thru to start the calibration measurement (x and y 
denote the test ports between which the THRU connection is being 
made). 

4. Repeat above procedure for ports x and z. then for ports y and z. 
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5. Click Return. 

6. If an isolation calibration must be performed using a LOAD standard, 
follow the procedure below. 

7. Click Isolation (Optional). 

8. Connect a LOAD standard to each of the three test ports (connectors 
to which the DUT is to be connected). 

9. Click Port x-y Isol to start the calibration measurement (x and y 
denote the port numbers to which the LOAD standard is connected). 

10. Click Return. 

11. Click Done to terminate the full 3-port calibration process. Upon 
pressing this key, calibration coefficients will be calculated and 
saved. The error correction function will also be automatically 
enabled. 

Connecting standards in full 3-port calibration 
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Full 4-Port Calibration 

 Overview 

 Procedure 

Other topics about Basic Calibration 
Overview 

In full 4-port calibration, calibration data are measured by connecting an 
OPEN standard, a SHORT standard, or a LOAD standard to the four test 
ports (or a THRU standard between the four ports). This calibration 
effectively eliminates the directivity error, crosstalk, source match error, 
load match error, frequency response reflection tracking error, and 
frequency response transmission tracking error from the test setup in a 
transmission or reflection test using those ports. As in full 2-port 
calibration, this calibration method also makes it possible to perform 
measurements with the highest possible accuracy. There are unique error 
terms for directivity, source match, and reflection tracking for each 
stimulus test port (3 × 4 ports = 12). As for isolation, load match, and 
transmission tracking errors, there are unique terms for each combination 
between a stimulus port and a response port (3 × 12 combinations = 36). 
Therefore, in total, 48 error terms are involved in a full 4-port calibration. 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 
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Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > 4-Port Cal. 

Reflection 

1. Click Reflection. 

2. Connect an OPEN calibration standard to test port 1. 

3. Click Port 1 Open to start the calibration measurement. 

o If you select the calibration kit which has different 
calibration definitions for each gender, (m) and (f) in the 
name (label) of the standard displayed in the softkey 
indicate male (m) and female (f) for the analyzer's 
connector, respectively. 

4. Disconnect the OPEN calibration standard and replace it with a 
SHORT calibration standard. 

5. Click Port 1 Short to start the calibration measurement. 

6. Disconnect the SHORT calibration standard and replace it with a 
LOAD standard. 

7. Click Port 1 Load to start the calibration measurement. 

8. Repeat the above procedure for ports 2, 3 and 4. 

9. Click Return. 

Transmission  

1. Click Transmission. 

2. Make a THRU connection between ports 1 and 2. 

3. Click Port 1-2 Thru to start the calibration measurement. 

4. Repeat above procedure ports 1 and 3. 

5. Repeat the procedure on ports 1 and 4. 

6. Repeat the procedure on ports 2 and 3. 

7. Repeat the procedure on ports 2 and 4. 

8. Repeat the procedure on ports 3 and 4. 

9. Click Return. 

10. If an isolation calibration must be performed using a LOAD 
standard, follow the procedure below. 
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11. Click Isolation (Optional). 

12. Connect a LOAD standard to each of the four test ports 
(connectors to which the DUT is to be connected). 

13. Click Port 1-2 Isol to start the calibration measurement. 

14. Perform the each calibrations by clicking Port 1-3 Isol, Port 1-4 
Isol, Port 2-3 Isol and Port 2-4 Isol. 

15. Click Return. 

16. Click Done to terminate the full 4-port calibration process. Upon 
pressing this key, calibration coefficients will be calculated and 
saved. The error correction function will also be automatically 
enabled. 

Connecting standards in full 4-port calibration 
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Calibration with ECal (Electronic Calibration) 
ECal (electronic calibration) 

ECal is a calibration method that uses solid-state circuit technology. ECal 
offers the following advantages: 

 Simplified calibration process. 

 Shorter time required for calibration. 

 Reduced chance of erroneous operation. 

 Little degradation of performance due to wear because the ECal 
module employs PIN diodes and FET switches. 

 If the frequency sweep range exceeds the frequency range of 
the ECal, the calibration data for the minimum frequency or 
maximum frequency are used for the exceeding frequency 
range and extrapolation is being executed. 

 When using Ecal with the E5071C options 2D5, 4D5, 2K5 and 
4K5 , wait time is inserted automatically for stable calibration 
results. Approximate calibration time is described in the support 
ECal page. 

  

Refer the following section for ECal calibration. 

 Connecting ECal to E5071C 

 1-Port Calibration Using a 2-Port ECal Module 

 Calibration Using 4-port ECal 

 Full 2-Port Calibration Using the 2-Port ECal Module 

 Full 3-Port and Full 4-Port Calibration using 2-Port ECal 

 Improving Calibration Accuracy along with ECal 

 Confidence Check on Calibration Coefficients Using ECal 

 Turning off ECal auto-detect function 

 User-characterized ECal 

Other topics about Calibration with ECal 
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Connecting ECal to E5071C 

 ECal Driver Installation 

 Connecting Single ECal 

 Connecting Multiple ECal 

Other topics about Calibration with ECal 
ECal Driver Installation 

When the ECal is connected with USB ports at the first time, ECal driver 
installation is required. 

1. Connect a Ecal to the USB port of the E5071C. 

2. Select No, not this time, then click Next. 
 

 
3. Select Install the software automatically (Recommended), then click 

Next. 
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4. Click Finish. 
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5. Even if you install the driver on a USB port, you will be asked to 
install the driver again if you connect the ECal with a different 
USB port. 

Connecting Single ECal 

There are several options available in calibrating using ECal module: 

 1-Port Calibration Using a 2-Port ECal Module 

 Calibration Using 4-Port ECal 

 Full 2-Port Calibration Using the 2-Port ECal Module 

 Full 3-Port and Full 4-Port Calibration using 2-Port ECal 

Connecting Multiple ECal 

The ECal module connected to E5071C is listed here: Cal > ECal > ECal.  

If a single ECal is connected, only one ECal is listed here. When multiple 
ECal are connected E5071C, all the connected ECals are listed here. The 
first line indicates the model number of the ECal and the second line 
indicates its serial number, as shown below: 
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E5071C revision A.9.60 and above allows multiple ECal to be connected at 
any one time. To perform calibration using your preferred ECal module, 
select the desired ECal from the list and perform 1-Port, 2-Port, 3-Port or 
4-Port calibration just as its performed in single ECal. Once completed, you 
can select another ECal connected to E5071C and repeat the procedure. 

   

Other topics about Calibration with ECal 
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1-Port Calibration Using a 2-Port ECal Module 

Follow the procedure below to perform a 1-port calibration using the 2-port 
ECal module. 

1. Connect the USB port on the ECal module with the USB port on the 
E5071C via a USB cable. This connection may be made while the 
E5071C's power is on. 

2. Allows the ECal module to warm up for 15 minutes until the module 
indicates from WAIT to READY. 

3. Connect a port on the ECal module to the test port to be calibrated. 

4. If you don't use all of the ECal module's ports, connect terminations 
to the unused ports. 

5. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

6. Press Cal key. 

7. Click Ecal > 1-Port Cal. 

8. Perform a 1-port calibration by clicking the softkey of selected port. 

 You can connect the ports of the ECal and the test 
ports of the E5071C arbitrarily. Connected ports can be 
manually specified although they are automatically detected 
before data measurement. For more information, Turning off 
ECal auto-detect function. 

Connecting ECal module (1-port calibration) 
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Other topics about Calibration with ECal 
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Calibration Using 4-port ECal 

 Overview 

 Procedure 

Other topics about Calibration with ECal 
Overview 

The E5071C allows you to perform calibration using the 4-port ECal 
module. It provides much simpler operation than when using the 2-port 
ECal. Especially when using a multi-port test set, calibration time and 
operator errors can be reduced significantly. 

Procedure 

1. Connect the USB cable between the USB port of the 4-port ECal 
module and the USB port of the E5071C. You can make this 
connection while the E5071C's power is on. 

2. Allows the ECal module to warm up for 20 minutes until the module 
indicates from WAIT to READY. 

3. Connect the ports of the 4-port ECal module to the test ports you 
want to calibrate. 

4. If you don't use all of the ECal module's ports, connect terminations 
to the unused ports. 

5. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

6. Press Cal key. 

7. Click Ecal. 

8. Select the calibration type. 

Softkey Function 

1-Port ECal Selects 1-port calibration 

2-Port ECal Selects full 2-port calibration 

3-Port ECal Selects full 3-port calibration 

4-Port ECal Selects full 4-port calibration 
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Thru ECal Selects THRU calibration 

9.   

10. If you must select a port, the softkey for making this selection is 
displayed. Select a port and start calibration. If you do not have to 
select a port, this step is skipped. 

11.  The E5071C detects the test ports connected to the ECal and 
then measurement starts. If the selected test ports to be calibrated 
is not connected to the ECal module, an error occurs. 

Connecting 4-port ECal module (for full 4-port calibration) 

 
  

 You can connect the ports of the ECal and the test 
ports of the E5071C arbitrarily. Connected ports can be 
manually specified although they are automatically detected 
before data measurement. For more information, Turning off 
ECal auto-detect function. 
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Full 2-Port Calibration Using the 2-Port ECal Module 

Follow the procedure below to perform a full 2-port calibration using the 2-
port ECal module. 

1. Connect the USB port on the ECal module with the USB port on the 
E5071C via a USB cable. This connection may be done while the 
E5071C's power is on. 

2. Allows the ECal module to warm up for 15 minutes until the module 
indicates from WAIT to READY. 

3. Connect port A and port B on the ECal module to the test ports to be 
calibrated. 

4. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

5. Press Cal key. 

6. Click ECal. 

7. Click 2 Port ECal. When using a 2-port E5071C, pressing this key 
performs a 2-port ECal. When using a 3-port or 4-port E5071C, click 
one of the softkeys to start a full 2-port calibration. 

  

Connecting ECal module (full 2-port calibration) 
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 You can connect the ports of the ECal and the test 
ports of the E5071C arbitrarily. Connected ports can be 
manually specified although they are automatically detected 
before data measurement. For more information, Turning off 
ECal auto-detect function 

  

Other topics about Calibration with ECal 
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Full 3-Port and Full 4-Port Calibration using 2-Port ECal 

 Overview 

 Procedure 

Other topics about Calibration with ECal 
Overview 

A VBA macro (ECal Assistant) is pre-installed in the E5071C to carry out a 
full 3-port or a full 4-port calibration using the 2-port ECal. 

  ECal Assistant does not perform isolation calibration. 
Procedure 

1. Connect the USB port of the ECal module to the USB port on the 
E5071C with a USB cable. The connection may be made while the 
E5071C's power is on. 

2. Allows the ECal module to warm up for 15 minutes until the module 
indicates from WAIT to READY. 

3. Press Macro Setup key. 

4. Click Load Project. 

5. From the Open dialog box, select the VBA project file 
D:\Agilent\ECalAssistant.vba and click the Open button. 

6. Press Macro Run key. 

7. The following dialog box appears. 

 
8. Click Next. 
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9. The following dialog box appears. 

 
10. In the Select Ports area, click and select the 3-Port (for a full 3-

port calibration) or the 4-Port (for a full 4-port calibration) radio 
button. 

11. When a full 3-port calibration is carried out on an E5071C, select 
the test ports to be calibrated from the drop-down list box below the 
3-Port button (either 1-2-3, 1-2-4, 1-3-4, or 2-3-4). 

12. In the Select Channel area, select the channel to be calibrated 
(one of channels 1 to  9). 

13. Click the Next button. 

14. The following dialog box appears. 

 
15. Following the connection diagram shown in the dialog box, 

connect ports A and B of the ECal module to test ports on the 
E5071C. The connection diagram shown in each dialog box that 
appears in each step depends on the number of test ports on the 
E5071C. 

16. Click the Measure button to start the measurement of calibration 
data. 
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17. Upon completion of measurement, the following dialog box 
appears. 
 

 
18. Click the Next button. 

19. The following dialog box appears. 
 

 
20. Re-connect the ECal module following the instructions given in 

each dialog box and continue the calibration process. 

21. When all calibration data have been collected, a dialog box with 
the Complete! sign appears as shown in the following figure, click 
Done to finish the calibration. If you wish to cancel the calibration, 
click Cancel. 
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Improving Calibration Accuracy along with ECal 

Inaccuracy caused by Thru calibration in the ECal can be reduced by the 
using the following methods. 

 Partial Overwrite 

 Unknown Thru Calibration 

Other topics about Calibration with ECal 
Partial Overwrite 

Using the partial overwrite function allows you to improve the calibration 
accuracy.  For example, follow these steps for full 2-port calibration. 

1.   Execute full 2-port calibration with ECal and save the calibration 
coefficients. 

2.   Execute Partial overwrite procedure with the Thru standard of the 
calibration kit 

Unknown Thru Calibration 

E5071C allows you to perform Thru calibration of ECal as the unknown 
Thru calibration.  In this function, the Thru calibration is performed with 
the Thru standard in ECal, however, the stored Thru calibration data in 
ECal is not used. E5071C performs the Thru calibration as an unknown 
Thru calibration. 

1. Press Cal Key, then click ECal. 

2. Click Unknown Thru to turn on. 

3. Perform your desired ECal calibration. 
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Confidence Check on Calibration Coefficients Using ECal 

 Overview 

 Procedure 

Other topics about Calibration with ECal 
Overview 

Using the ECal module, the E5071C lets you verify the obtained calibration 
coefficients to determine whether correct measurement is possible with 
them. 

The E5071C can set ECal to the state used to verify the measurement 
parameters and then copy the appropriate characteristics of that 
verification state to the memory trace from the ECal's built-in memory. 
This is done according to the measurement parameters of the active trace 
of the active channel. While measuring ECal in this specified state, you can 
compare the measurement results with those of the E5071C and with the 
appropriate measurement results stored in ECal in several different ways. 
These include simultaneously displaying the data and memory traces or 
displaying the math operation results between the data and memory 
traces. This enables you to verify the correctness of measurement for each 
measurement parameter when the obtained calibration coefficients are 
used. 

Procedure 

1. Connect the USB cable between the USB port of the ECal module and 
that of the E5071C. You can make this connection while the 
E5071C's power is ON. 

2. Allows the ECal module to warm up for 15 to 20 minutes until the 
module indicates from WAIT to READY. 

3. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the verification. 

4. Press Meas key. 

5.  Select the S-parameter you want to verify. You cannot verify the 
mixed mode S-parameter. 

6. Connect the test ports of the E5071C corresponding to the selected 
S-parameter (for example, ports 1 and 2 when the S-parameter is 
S21) and the ports of the ECal module. 

7. If you don't use all of the ECal module's ports, connect terminations 
to the unused ports. 

8. Press Cal key.  

9. Click ECal. 



Measurement 

165 

10. When using an adapter to the ECal, click Characterization and 
then press the softkey corresponding to the characterization for the 
adapter you are using. 

11. Click Confidence Check. 

12. Compare the data trace and the memory trace and verify 
whether measurement is correct. 

13. The following is the procedure for comparison when 
simultaneously displaying the data trace and the memory trace. 

a. Press Display key. 

b. Click Display > Data & Mem. 

c. Press Scale key. 

d. Click Auto Scale. 

e. Determine whether the difference between the traces is 
acceptable. The difference should be read in terms of linear 
values instead of dB error. If we consider the magnitude of the 
linear error as compared to the dB delta, the value is very 
small. So to evaluate the difference between the traces, a 
linear error scale should be used for comparison instead of the 
dB error scale. 

14. For all of the parameters you want to verify, repeat the 
procedure. 

Connecting ECal module (for verification of S21) 
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Turning off ECal auto-detect function 

The ECal module automatically detects the connection between E5071C's 
test ports and ECal module's ports. You can turn off this function to set 
ports manually. 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to turn off the auto-detect function. 

2. Press Cal key. 

3. Click ECal > Orientation, and select Manual. 

4. Specify a test port of the E5071C. 

5. Specify an Ecal port for the port of the E5071C you specified. 

 Even if the connection is wrong with the auto-detect 
function turned off, no error is displayed. 

Other topics about Calibration with ECal 
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User-characterized ECal 

 Overview 

 Precautions to take in using VBA macros 

 Storing user characteristics to the ECal module 

 Backup/recovery of ECal module's built in flash memory 

 Executing User characterized ECal 

Other topics about Calibration with ECal 
Overview 

The E5071C allows you to execute ECal calibration with user-defined 
characteristics instead of the ECal characteristics defined as the factory 
default. This feature is called User-characterized ECal, and it is used to 
execute ECal calibration when an adapter is connected to the ECal module. 

Before executing the User-characterized ECal, you have to measure data, 
such as characteristics when the adapter is connected to the ECal module, 
and store them to the built-in flash memory of the ECal module as the user 
characteristics. 

Use the following VBA macro to acquire user characteristics and store them 
to the ECal module's built-in memory. 

Storage folder VBA macro name (project name) 

D:\Agilent EcalCharacterization.vba 

  
Precautions to take in using VBA macros 

 Never connect/disconnect the USB cable while executing the VBA 
macro. 

  In particular, the above precaution must always be 
observed while the VBA macro is storing data to the ECal 
module's built-in flash memory; disconnecting the USB cable at 
this time may damage the ECal module. 

  Back up the flash memory contents. 
The VBA macro provides a feature to back up the contents of the 
ECal module's built-in flash memory. Before storing user 
characteristics to the ECal module, be sure to use this feature to 
back up the flash memory's current contents. 

Storing user characteristics to the ECal module 
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Follow these steps to measure characteristics while an adapter is 
connected to the ECal module and then to store them to the ECal module's 
built-in flash memory as user characteristics. 

  With the 2-port E5071C, you cannot measure the 
user characteristics of a 4-port ECal module and store them into 
the memory by using this VBA macro. 

1. Connecting ECal Module 

Connect the USB cable between the USB port of the ECal module and that 
of the E5071C. You can make this connection while the E5071C's power is 
ON. 

2. Setting Stimulus Condition 

Set the stimulus condition of the channel for which you want to measure 
the user characteristics. For optimal accuracy, set the IF bandwidth to 1 
kHz or less. 

3. Executing Calibration 

For the channel for which you have set the stimulus condition, execute full 
2/4-port calibration with a mechanical calibration kit when characterizing 
2/4-port ECal. Define the calibration surface as the connector surface 
connected to each port of the ECal module in the state used to measure 
characteristics. 

 
 
4. Starting the VBA MACRO 

a. Press Macro Setup key. 

b. Click Load Project. 

c. The Open dialog box appears. Specify the file name 
"D:\Agilent\EcalCharacterization.vba" and click Open. 

d. Press Macro Run key to start the macro.  When more than 1601 
measurement points is set for 1 channel and 4 traces, the E5071C 
VBA macro function may take more time to operate. A warning is 
also displayed if the user tries to increase the number of points to 
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more than 1601 with 1 channel and 4 traces. Click OK. 

 
e. The ECal part (1 in the figure below) displays the information of the 

ECal module connected to the E5071C. 

f. Click Refresh (2 in the figure below) to update the information if you 
have connected another ECal module after the macro has been 
started. 
  

5. Measuring User Characteristics 

a. Select Characterize ECAL (3 in the figure below) to display the User 
Characteristic Measurement screen. 

 
b.  After connecting the adapter to the ECal module as necessary, 

connect each port of the ECal module and the test port of the 
E5071C. 
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c. Click Measure (4 in the figure) to start measurement. 

a.  You can select any port of the ECal module and any test port of 
the E5071C for connection; the E5071C automatically 
recognizes the connected ports before measurement. 

6. Storing the User Characteristics to the Memory 

a. When the measurement is complete, the User Characterization Info 
screen appears. 
  

b. Enter the following information. 
  

Designation Category Description 

1 Number Specify a user number (a location number 
in the memory where you want to store 
the user characteristics) . If the specified 
location number is not used for storage, 
the parts Characterization, Connectors, 
and Adapter Description are left blank; if 
already used, the stored contents are 
displayed. 
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2 Characterization Enter the information (operator, used 
analyzer, and so on) when measuring 
user characteristics as necessary. 

3 Connectors Select the connector types of the adapters 
for the ECal module's test ports. Male and 
female in the list of connected types 
indicate male and female adapter, 
respectively. Select "No adapter" if no 
adapter is used on a port. 

4 Adapter 
Description 

Enter the detailed information on the 
adapters connected to each port as 
necessary. 

The information you have entered is displayed when checking the user 
characteristics information by using the key strokes: Cal > Ecal > 
Characterization Info. 

d. Click Write. 

e. At this time, if user characteristics are already stored for the 
specified user number, a dialog appears to confirm overwriting. Click 
OK. 
  

a. Although the maximum number of user characteristics 
stored to the ECal's memory is usually five, this number 
may be limited by memory size because the size of user-
characteristics data is not fixed and increases in 
proportion to the number of measurement points. An error 
occurs when the Write button is pressed if the total size 
added the new user characteristics exceeds this limitation 
due to memory size. 

f. The following dialog box is displayed to confirm execution. Click OK 
to start storing the user characteristics. 

 
  

a. Do not disconnect the USB cable or terminate the VBA 
macro by force while the VBA macro is storing data to the 
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ECal's built-in flash memory. Doing so may damage the 
ECal module. 

g. The following dialog box appears while the VBA macro is storing data 
to memory. Storing the user characteristics takes a few minutes 
depending on the amount of data. 

 
  

h. Another dialog box is displayed to notify completion of data storage. 
Click OK. 

 
  

8. Closing the VBA macro 

a. Click Close (No. 5 in Figure) to close the macro. 
Backup and recovery of ECal module's built-in flash memory 

Follow these steps to back up the contents of the ECal module's built-in 
flash memory. 

1. Connect the USB cable between the USB port of the ECal module and 
that of the E5071C. You can make this connection while the 
E5071C's power is ON. 

2. Start the VBA macro according to Starting the VBA MACRO 
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3. Select Backup Flash ROM (No. 1 in the following figure) to display the 
Backup screen. 

 

Recovery 

1. Click Recover (No. 2 in the figure above.). 

2. The Open dialog box appears. Enter the file name of the contents 
you want to recover and Click Open. If the serial number information 
stored in the file does not match that of the ECal module connected 
to the E5071C, a confirmation dialog box appears. Click OK to 
continue the recovery only if a mismatch between these serial 
numbers is allowed. 

3. The dialog box is displayed to confirm execution. Click OK to start 
the recovery of the flash memory. The dialog box appears while the 
VBA macro is storing data to the memory. The recovery of the flash 
memory takes a few minutes depending on the amount of data. 

4. The Completion screen appears. Click OK. 

Backup 

1. Click backup. 

2. The Save As dialog box appears. Enter the name of the file you want 
to save and press Save. 

3. Click Close to close the macro. 
Executing User-characterized ECal 

The execution procedure for the User-characterized ECal is the same as for 
normal ECal except that it requires the user characteristics to be selected 
in advance. 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to execute calibration. 

2. Press Cal key. 

3. Click ECal > Characterization. 
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4. Select a user characteristic which is specified by User 
Characterization Info screen. 

5. To check the information on the user characteristics you have 
selected, click  Characterization Info. The following dialog box 
appears. 

 
  

1: The date when the user characteristics were measured 

2: The information you entered in Characterization ( 1 of User 
Characterization Info screen) 

3: The stimulus conditions when the user characteristics were 
measured 

4: The information you entered in Adapter Description ( 4 of User 
Characterization Info screen) 

5: The information you entered in Connectors ( 3 of User 
Characterization Info screen) 
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Advanced Calibrations 
Setting the trigger source for calibration 

 Overview of Trigger Source 

 Setting Trigger Source 

Other topics about Advanced Calibration 
Overview of Trigger Source 

You can set the trigger source for calibration before executing calibration. 

You can select it from "Internal" or "System." Setting it to "System" allows 
you to use the same trigger source setting for calibration and 
measurement. 

You can set the trigger source for calibration (which is usually set to 
"Internal") to "System," which allows you to generate triggers at any 
timing from a PC for external control or from the front panel for calibration 
in the same way as for measurement. 

The setting of the point trigger and averaging trigger is also applied to the 
trigger for calibration. When the trigger source for calibration is set to 
"System" and the trigger source for measurement is set to "External" or 
"Manual" with the point trigger function set to ON, a trigger is required for 
each measurement point during calibration. When the averaging trigger 
function is set to ON, the sweep is performed the number of times 
specified by the averaging factor for a single trigger during calibration. 

 For the following types of calibration, the setting of the trigger 
source does not take effect. Those calibration operations are controlled 
by the internal trigger. 

  Calibration using ECal 

  Power calibration 

  Receiver calibration 

  Mixer converter calibration 
Setting Trigger Source 

Follow these steps to set the trigger source for calibration: 

1. Press Cal Key. 

2. Click Cal Trig Source, then select the trigger source you want to use. 
  

Softkey Function 

Internal Selects "Internal." 
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System Selects "System." 
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Sliding and Offset Load Calibration 

 Supported Calibration 

 Sliding Load Calibration 

 Offset Load Calibration 

Other topics about Advanced Calibration 
Supported Calibration 

The following table shows the supported calibration for the sliding load and 
offset load. 

Calibra
tion 

SO
LT 

Respo
nse 

Enhan
ced 
Respo
nse  

TR
L-
Li
ne 

Adapt
er 
Remo
val 

Scal
ar 
Mix
er 

Vec
tor 
Mix
er 
(VB
A) 

Sliding 
Load 

Yes Yes Yes 
Ye
s 

Yes No No 

Offset 
Load 

Yes No Yes No No No No 

Sliding Load Calibration 

A sliding load is defined by making multiple measurements of the device 
with the sliding load element positioned at various marked positions of a 
long transmission line. The transmission line is assumed to have zero 
reflections and the load element has a finite reflection that can be 
mathematically removed using a least squares circle fitting method.  

A sliding load calibration can be very accurate when performed perfectly. It 
can also be very inaccurate when not using proper technique. For accurate 
results, follow the users manual instructions closely. 

The following calibration kits are supported: 

 85050B 7 mm Calibration Kit 

 85052B 3.5 mm Calibration Kit 

 85054B 50 Ohm Type-N Calibration Kit 

 85056A 2.4 mm Calibration Kit 

Procedure 
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Follow these steps to perform calibration using sliding load. The example 
demonstrates re-calibration for full 1-port calibration. 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > Cal Kit. 

4. Select the calibration kit with sliding load, for example, 85052B. 

5. Press Cal key. 

6. Click Calibrate > 1-Port Cal > Select Ports. 

7. Select the test ports for which you want to perform re-calibration for 
full 1-port calibration.  

8. Make a OPEN connection on the selected test port. 

9. Click Open. 

10. Make a SHORT connection on the selected test port. 

11. Click Short. 

12. Make a LOAD connection on the selected test port with a sliding 
load. 

13. Click Calibrate > 1-Port Cal > Load > Load 2 Sliding for female 
load OR Calibrate > 1-Port Cal > Load > Load 5 for male load. The 
assignment of female and male loads varies from one calibration kit 
to another. In the case of 85052B, load 2 is a female and load 5 is a 
male load. 

14. Slide the load to the desired position and click Sliding Load. 
Repeat this step for at least 5 times (till Sliding Load 5), then click 
Done. This step can be repeated at most 10 times only. 

15. Click Return. 

16. Now, all Short, Open and Load should have check mark on their 
left. 

17. Click Done. 

The sweep range setting should match the frequency range of the sliding 
load. Else, the load process is not executed, hence no check mark appear 
on the Load softkey. Similarly, if the frequency range is extended, the load 
process is also not executed. Refer to redefining a calibration kit to learn 
more about it.  

Offset Load Calibration 

An offset load is a compound standard consisting of a load element and 
two known offset elements (transmission lines) of different length. The 
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shorter offset element can be a zero-length (Flush-thru) offset. The load 
element is defined as a 1-port reflection standard. An offset load standard 
is used when the response of the offset elements are more precisely known 
than the response of the load element. This is the case with waveguide. 
Measurement of an offset load standard consists of two measurements, 
one with each of the two offset elements terminated by the load element. 
The frequency range of the offset load standard should be set so that there 
will be at least a 20 degree separation between the expected response of 
each measurement. 

To specify more than two offset elements, define multiple offset load 
standards.  

The following calibration kits are supported: 

 X11644A X Band 90 Calibration Kit 

 P11644A P Band WG 62 Calibration Kit 

 K11644A K Band WG 42 Calibration Kit  

 The K11644A K Band WG 42 Calibration Kit is not verified. 

Procedure 

Follow these steps to perform calibration using offset load. The example 
demonstrates re-calibration for full 1-port calibration. 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > Cal Kit. 

4. Select the calibration kit with sliding load, for example, X11644A. 

5. Press Cal key. 

6. Click Calibrate > 1-Port Cal > Select Ports. 

7. Select the test ports for which you want to perform re-calibration for 
full 1-port calibration.  

8. Make a OPEN connection on the selected test port. 

9. Click Open. 

10. Make a SHORT connection on the selected test port. 

11. Click Short. 

12. Click Calibrate > 1-Port Cal > Load > Load 2 Offset Load. 

13. Make a LOAD connection on the selected test port with a offset 
load (Thru). 

14. Click Offset Line 1 Thru. 
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15. Make a LOAD connection on the selected test port with a offset 
load (X-band Delay line). 

16. Click X-band Delay Line. 

17. Click Done. 

18. Click Return twice. 

19. Now, all Short, Open and Load should have check mark on their 
left. 

20. Click Done. 

The sweep range setting and Thru Offset frequency range should match 
the frequency range of the offset load. Else, the load process is not 
executed, hence no check mark appear on the Load softkey. Similarly, if 
the frequency range is extended, the load process is also not executed. 
Refer to redefining a calibration kit to learn more about it.  
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Modifying Calibration Kit Definition 

 Definition of Terms 

 Defining Parameters for Standards 

 Redefining a Calibration Kit 

 Setting Options for TRL Calibration 

 Defining Calibration Kit Gender 

 Saving Definition File of Calibration Kit 

 Loading Definition File of Calibration Kit 

 Restoring Definition File of Calibration Kit 

Other topics about Advanced Calibration 

In most measurements, the user can use pre-defined calibration kits as 
they are. However, it may be necessary to change the definition of a 
calibration kit (or create a new one) when changing the pre-defined 
connector between male and female (e.g. from OPEN (f) to OPEN (m)) or 
when a special standard is used or a high degree of accuracy is demanded. 
When it is necessary to change the definition of a calibration kit that 
contains a calibration device but no calibration kit model, the user must 
fully understand error correction and the system error model. 

A user-defined calibration kit may be used in the following circumstances. 

 When the user wants to use connectors other than those pre-defined 
in the calibration kits for the E5071C (e.g., a SMA connector). 

 When the user wants to use different standards in place of one or 
more standards pre-defined in the E5071C. For example, when three 
offset SHORT standards are used instead of OPEN, SHORT, and LOAD 
standards. 

 When the user wants to modify the standard model of a pre-defined 
calibration kit and turn it into a more accurate model. It is possible to 
perform better calibration if the performance of the actual standard 
is better reflected in the standard model. For example, you may need 
to define the 7-mm LOAD standard as 50.4 ohm instead of 50.0 
ohm. 

Definition of Terms 

The terms used in this section are defined as follows: 

Standard 

An accurate physical device, for which the model is clearly defined, used to 
determine system errors. With the E5071C, the user may define up to 21 
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standards per calibration kit. Each standard is numbered from 1 through 
21. For example, standard 1 for the 85033E 3.5-mm calibration kit is a 
SHORT standard. 

Standard type 

The type of standard used to classify a standard model based on its form 
and construction. Six standard types are available: SHORT, OPEN, LOAD, 
delay/THRU, Unknown Through, and arbitrary impedance. 

Standard coefficient 

The numeric characteristics of the standard used in the selected model. For 
example, the offset delay (32 ps) of the SHORT standard in the 3.5-mm 
calibration kit is a standard coefficient. 

Standard class 

A group of standards used in a calibration process. For each class, the user 
must select the standards to use from the 21 available standards. 

Subclass 

You can register up to 8 standard types. This capability lets you specify a 
different standard for each frequency range. You must assign standards to 
subclasses you use. 

Defining Parameters for Standards 

The following figures show the parameters used in defining standards. 

 Reflection Standard Model (SHORT, OPEN, or LOAD) 
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Transmission Standard Model (THRU) 
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Offset Z0 

The offset impedance between the standard to be defined and the actual 
measurement plane. Normally, this is set to the system's characteristic 
impedance. 

Offset Delay 

The delay that occurs depending on the length of the transmission line 
between the standard to be defined and the actual measurement plane. In 
an OPEN, SHORT, or LOAD standard, the delay is defined as one-way 
propagation time (sec.) from the measurement plane to the standard. In a 
THRU standard, it is defined as one-way propagation time (sec.) from one 
measurement plane to the other. The delay can be determined through 
measurement or by dividing the exact physical length of the standard by 
the velocity coefficient. 

Offset Loss 

This is used to determine the energy loss caused by the skin effect along 
the length (one-way) of the coaxial cable. Loss is defined using the unit of 
ohm/s at 1 GHz. If you select waveguide as the media type, this parameter 
is ignored. In many applications, using the value 0 for the loss should not 
result in significant error. The loss of a standard is determined by 
measuring the delay (sec.) and the loss at 1 GHz and then substituting 
them in the formula below. 

 

C0, C1, C2, C3 

It is extremely rare for an OPEN standard to have perfect reflection 
characteristics at high frequencies. This is because the fringe capacitance of 
the standard causes a phase shift that varies along with the frequency. For 
internal calculation of the analyzer, an OPEN capacitance model is used. This 
model is described as a function of frequency, which is a polynomial of the 
third degree. Coefficients in the polynomial may be defined by the user. The 
formula for the capacitance model is shown below: 

 

F: measurement frequency 
C0 unit: (Farads) (constant in the polynomial) 
C1 unit: (Farads/Hz) 
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C2 unit: (Farads/Hz2) 
C3 unit: (Farads/Hz3) 

L0, L1, L2, L3 

It is extremely rare for a SHORT standard to have perfect reflection 
characteristics at high frequencies. This is because the residual inductance 
of the standard causes a phase shift that varies along with the frequency. 
It is not possible to eliminate this effect. For internal calculation of the 
analyzer, a short-circuit inductance model is used. This model is described 
as a function of frequency, which is a polynomial of the third degree. 
Coefficients in the polynomial may be defined by the user. The formula for 
the inductance model is shown below. 

 

   

F: Measurement frequency 
L0 unit: [Henry] (the constant in the polynomial) 
L1 unit: [Henry/Hz] 
L2 unit: [Henry/Hz2] 
L3 unit: [Henry/Hz3] 

In most existing calibration kits, THRU standards are defined as "zero-
length THRU," i.e., the delay and loss are both "0". Such a THRU standard 
does not exist, however. Calibration must be done with two test ports 
interconnected directly. 

  The measurement accuracy depends on the 
conformity of the calibration standard to its definition. If the 
calibration standard has been damaged or worn out, the 
accuracy will decrease. 

Redefining a Calibration Kit 

This section provides the procedure to change the definition of a calibration 
kit. 

 Procedure to select and define a calibration kit 

 Procedure to select the standard type and define standard coefficient 

 Procedure to define standard class 

Procedure to select and define a calibration kit 

1. Press Cal key. 

2. Click Cal Kit, then select the calibration kit to be redefined. If the 
names (labels) of calibration kits were changed prior to operation, 
the new names will appear on the respective softkeys. 
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3. Click Modify Kit. To change the pre-defined connector type (e.g. 
OPEN(f) to OPEN (m)) skip to the specifty classes. 

4. Click Define STDs. 

5. Select the standard to be redefined from among standards numbered 
1 through 21. 

6. Click No Name > Label and input a new label for the standard using 
the keypad displayed on the screen. 

Procedure to select the standard type and define standard coefficient 

1. Press Cal key. 

2. Click Modify Kit. 

3. Click Define STDs and select the standard to be redefined from 
among standards numbered 1 through 21. 

4. Click STD Type, then select the type of standard. 

Softkey Function 

Open Selects the OPEN standard 

Short Selects the SHORT standard 

Load Selects the LOAD standard 

Delay/Thru Selects the delay/THRU standard 

Unknown Thru Selects the Unknown THRU standard 

Arbitrary Selects the arbitrary impedance 

None Selects no standard type 

5.   

6. Set the standard coefficient. 

Softkey Function 

C0 Sets C0 
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C1 Sets C1 

C2 Sets C2 

C3 Sets C3 

L0 Sets L0 

L1 Sets L1 

L2 Sets L2 

L3 Sets L3 

Offset Delay Sets the offset delay 

Offset Z0 Sets the offset Z0. Specify 1 ohm when 
Waveguide is set for the media type. 

Offset Loss Sets the offset loss 

Arb. 
Impedance Sets an arbitrary impedance 

Min. 
Frequency 

Sets a start frequency. Specify cutoff frequency 
when Waveguide is set for the media type. 

Max. 
Frequency 

Sets a stop frequency. Specify cutoff frequency 
when Waveguide is set for the media type. 

Media Selects a media type, Coaxial or Waveguide. 

Length Type When the standard type is Load, this softkey 
can be selected from Fixed, Sliding or Offset. 

7.   
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8. Repeat step 1 to step 5 to redefine all standards for which changes 
are necessary, then click Return. 

Procedure to define standard class 

1. Press Cal key. 

2. Click Modify Kit. 

3. Click Specify CLSs, then select the class. 

Softkey Function 

Sub Class Selects a subclass you want to use. 

Open Selects the OPEN class 

Short Selects the SHORT class 

Load Selects the LOAD class 

Thru Selects the THRU class 

TRL Reflect Selects TRL Reflect. 

TRL Line/Match Selcts TRL Line/Match. 

4.   

5. For TRL Thru, select ports. Select Set All to use the same standards 
for all test ports. 

Softkey    Function 

Port 1-2 Selects port 1 and port 2. 

Port 1-3 Selects port 1 and port 3. 

Port 1-4 Selects port 1 and port 4. 

Port 2-3 Selects port 2 and port 3. 
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Port 2-4 Selects port 2 and port 4. 

Port 3-4 Selects port 3 and port 4. 

6.   

7. Select the test port. Select Set All to use the same standards for all 
test ports. 

8. Select the standards to be registered in the class from among 
standards numbered 1 through 21. To change the connectors 
between male and female (e.g. OPEN (f) to OPEN (m)), select the 
appropriately labeled standards here. For more information on 
changing the gender, refer to Defining Calibration Kit Gender. 

9. Repeat the procedure until classes are defined for all test ports that 
need to be redefined, then click Return. 

10. Repeat the procedure to redefine all classes that need to be 
modified, then click  Return. 

11. Click Label Kit and input a new label for the calibration kit by 
using the keypad displayed on the screen. 

You can save the definition. See Saving Definition File of Calibration Kit. 

Example of defining the TRL calibration kit 

You need to enter the definition of the TRL calibration kit to perform TRL 
calibration. Follow these steps to define the following calibration kit given 
as an example. 

 THRU (Delay 0 ps, Offset Loss 1.3 Gohm/s) 

 REFLECT (SHORT, Delay 0 ps) 

 MATCH (@0 to 2GHz) 

 LINE1 (50-ohm transmission line, Delay 54.0 ps @ 2G to 7GHz) 

 LINE2 (50-ohm transmission line, Delay 13.0 ps @ 7G to 32GHz) 

Procedure to define the name of the calibration kit 

1. Press Cal key. 

2. Click Cal Kit , then select a User kit that has not been registered. 

3. Click Modify Kit > Label Kit [User], then type in a name you want. 

Procedure to define Thru and Reflect 

1. Click Define STDs. 

2. Click 1:No Name > Label, then type in THRU. 
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3. Select STD Type > Delay/Thru. 

4. Set Offset Loss to 1.3Gohm/s, and Offset Delay to 0. 

5. Click Return to return to the Define STD menu. 

6. In the same way, repeat the procedure to enter the definition of 
REFLECT to No. 2. 

7. Select SHORT for STD Type. 

Procedure to define Match 

1. Click 3:No Name > Label. 

2. Type in MATCH <2G. 

3. Click STD Type > Load. 

4. Set Max Frequency to 2GHz. 

5. Click Return to return to the Define Std menu. 

Procedure to define Line 1/2 

1. Click 4:No Name - Label. 

2. Type in LINE <7G. 

3. Click STD Type - Thru. 

4. Set Offset Delay to 54 ps. 

5. Set Min Frequency to 2 GHz. 

6. Set Max Frequency to 7 GHz. 

7. Click Return to return to the Define Std menu. 

8. Click 5:No Name - Label. 

9. Type in LINE >7G. 

10. Click STD Type >  Thru. 

11. Set Offset Delay to 13 ps. 

12. Set Min Frequency to 7 GHz. 

13. Click Return to return to the Define Std menu. 

14. Click Return to return to the Modify Cal Kit menu. 

Procedure to register Thru/Reflect/Match to sub class 1 

1. Click Specify CLSs > Sub Class. 

2. Select Sub Class1. 

3. Click TRL Thru > Set All >  THRU > Return. 

4. Click TRL Reflect > REFLECT. 

5. Click TRL Line/Match > Set All > MATCH <2G > Return. 
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Procedure to register Line 1/2 to subclass 2/3 

1. Click Sub Class2. 

2. Click TRL Line/Match > Set All > LINE <7G > Return. 

3. Click Sub Class3. 

4. Click TRL Line/Match > Set All > LINE >7G > Return. 

5. Press Cal key and check that the name you specified is selected as 
Cal Kit. 

By assigning Match and Line 1/2 to subclass 1/2/3 respectively, you can 
calibrate 3 standards with different frequency bands for TRL line/match 
calibration. 

Setting Options for TRL Calibration 

This section describes how to set the reference impedance and 
measurement data of the standard used for calculating the calibration 
plane for TRL calibration. 

1. Press Cal key. 

2. Click Cal Kit, then select a calibration kit. 

3. Click Modify Cal Kit > TRL Option. 

4. Click Impedance to select the reference impedance. 

Softkey Function 

Line 

Calculates the calibration 
coefficient using the 
characteristic impedance of 
the line standard as the 
reference impedance. The 
impedance of the line 
standard is used as the center 
of the Smith chart, and the 
calibration coefficient is 
calculated using the line 
standard's as the direction. 

System 

Calculates the calibration 
coefficient using the system 
impedance as the reference 
impedance. Select this when 
the line impedance and the 
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test port impedance differ. 

5. Click Reference Plane to select the measurement data of the 
standard used for calculating the reference plane. 

Softkey Function 

Thru Uses the length of the thru/line standard to calculate the 
calibration plane. 

Reflect Uses the reflection coefficient of the reflection standard 
to calculate the calibration plane. 

6.   

Setting a media type for the calibration kit 

You can set a media type for the standard you use. 

1. Press Cal key. 

2. Click Cal Kit, then select a calibration kit. 

3. Click Modify Cal Kit > Modify Cal Kit. 

4. Click Define STDs, and select a standard. 

5. Click Media, and select a media type. 

Softkey Function 

Coaxial Selects coaxial as the media type. 

Waveguide Selects waveguide as the media type. 

6.   

7. If you select waveguide as the media type, set the system 
impedance and the characteristic impedance to 1ohm . 

8. Depending on the media type you use, the calculation method 
of the electrical delay, which is required to correct the phase 
delay, differs. 
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You can save the definition. See Saving Definition File of Calibration Kit. 
Defining Calibration Kit Gender (m/f) 

The gender of a calibration can be set using the subclass function in the 
ENA. For example, subclass 1 can be used as "male" and subclass 2 can be 
used as "female" or vice-versa. The display label, for example "Open (f)" 
or "Open (m)", is just a display label and can be edited using Cal > Modify 
Kit > Define STDs and hence cannot be used to change the gender of the 
calibration kit. To change the gender of the calibration kit, the E5071C 
subclass function must be used. 

For example, the gender of the default calibration kit (85032F) can be 
checked using the following procedure: 

1. Press Cal key. 

2. Click Cal Kit and select 85032F. 

3. Select Cal > Modify Cal Kit > Specify CLSs > Sub Class. 

The subclass gender is set from the E5071C side and not from the 
Calibration kit side. 

If both male/female are set using subclass in advance, the gender which is 
used for the calibration can also be changed programmatically using 
SCPI.SENSe(Ch).CORRection.COLLect.ACQuire.SUBClass 

 The gender setting option using subclass is defined from the 
E5071C connector type and not from the standard calibration kit 
gender type. 

Saving Definition File of Calibration Kit 

You can save the definition file of the calibration kit for each standard into 
a file on a storage device, then recall it later to reproduce the definition. 

1. Press Cal key. 

2. Click Cal Kit, then select a calibration kit. 

3. Click Modify Cal Kit > Export Cal Kit... to open the dialog box. 

4. Specify a folder, enter a file name, and click Save. 

  The file is saved with the (.ckx) extension. Do not 
open and modify it directly. 

 Never modify the contents (folders and files) of 
drives except for drive D. Modifying the contents of drives other 
than drive D may give serous damage to the functions and 
performance of the analyzer. 

Loading Definition File of Calibration Kit 

1. Press Cal key. 

2. Click Cal Kit, then select a calibration kit. 
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3. Click Modify Cal Kit > Import Cal Kit... to open the dialog box. 

4. Specify a folder, enter a file name, and click Open. 
Restoring Definition File of Calibration Kit 

1. Press Cal key. 

2. Click Cal Kit, then select a calibration kit. 

3. Click Modify Cal Kit > Restore Cal Kit.... 

4. Click OK to restore the definition of the calibration kit selected by Cal 
Kit to factory default settings.  
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Specifying Different Standards for Each Frequency 

 Overview 

 Defining Standards for Each Subclass 

 Disabling Standards Defined for a Subclass 

 Possible Cases of Frequency Ranges Using Subclasses 

Other topics about Advanced Calibration 
 Overview 

This section demonstrates the procedure to define a different open 
standard for each frequency band, based on the following information: 

Standard Label name Frequencies to be defined 

Open Open 3G 1 GHz - 3 GHz 

Open Open 6G 3 GHz - 6 GHz 

1. Press Cal key. 

2. Click Cal Kit. 

3. Select a calibration kit you want to define. 

4. Click Modify Kit > Define STDs. 

5.  Select #1, click Label, and enter Open 3G using the character input 
pad that appears on the screen. 

6. Click Open as the standard type (STD Type). 

7. Set a necessary standard coefficient. 

8. Enter 1G as the minimum frequency for Min Frequency. 

9. Enter 3G as the maximum frequency for Max Frequency. 

10. Click Return. 

11. In the same way, select #2, press Label, and enter Open 6G 
using the character input pad that appears on the screen. 

12. Select Open as the standard type (STD Type). 

13. Set a necessary standard coefficient. 

14. Enter 3G as the minimum frequency for Min Frequency. 

15. Enter 6G as the maximum frequency for Max Frequency. 

16. Click Return. 
Defining Standards for Each Subclass 

This section demonstrates the procedure to specify a different OPEN 
standard for each frequency band, using subclasses #1 and #2. In this 
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example, the standards created in Defining different standard for each 
frequency band are used. 

1. Press Cal Key. 

2. Click Cal Kit. 

3. Select a calibration kit you want to use. 

4. Click Modify Kit > Specify CLSs. 

5. Click Sub Class > Sub Class 1. 

6. Select the standard type Open, press Set All, make settings for all 
ports. 

7. Select #1 (Open 3G). 

8. Click Return. 

9. Then, press Sub Class, and select Sub Class 2. 

10. Select the standard type Open, press Set All, make settings for 
all ports. 

11. Select #2 (Open 6G). 

12. Click Return. 
Disabling Standards Defined for a Subclass 

The following procedure shows how to disable a standard defined for a 
subclass. You cannot disable subclass 1 because at least one standard 
must exist. The following procedure shows how to disable an OPEN 
standard of subclass 2. 

1. Press Cal key. 

2. Click Cal Kit. 

3. Select a calibration kit you want to use. 

4. Click Modify Kit > Specify CLSs. 

5. Click Sub Class > Sub Class 2. 

6. Select the standard type Open, click Set All, make settings for all 
ports. 

7. Select None. 

8. Click Return. 
Possible Cases of Frequency Ranges Using Subclasses 

By using several subclasses, you can set a different standard for each 
frequency, but note the following on frequency ranges. The following table 
shows possible cases and whether calibration is possible. 

Possible cases of frequency ranges Execution of 
calibration 



E5071C 

198 

Example 1, When frequency ranges specified with subclasses 
overlap 

Possible 

Example 2, When frequency ranges specified with subclasses do 
not cover a part of a measurement frequency range 

Impossible 

Example 3, When a frequency range specified with a subclass 
lies outside the measurement frequency range 

Possible 

Example 4, When a part of a frequency range specified with a 
subclass lies outside the measurement frequency range 

Possible 

  

Example 1, When frequency ranges specified with subclasses overlap 

For the measurement frequency range (1 GHz - 8 GHz), if you execute 
calibration with a standard of subclass 1 (1 GHz-5 GHz) and then with a 
standard of subclass 2 (4 GHz-8 GHz), the standard last executed is 
applied for the overlapping portion (4 GHz-5 GHz). 

 

Example 2, When frequency ranges specified with subclasses do not cover a part of a measurement frequency range 

For a measurement frequency range (1 GHz to 8 GHz), if you execute 
calibration with a standard of subclass 1 (1 GHz to 5 GHz) and then with a 
standard of subclass 2 (6 GHz to 8 GHz), Done is NOT available for the 
undefined portion (5 GHz-6 GHz). 
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Example 3, When a frequency range specified with a subclass lies outside the measurement frequency range 

For a measurement frequency range (1 GHz to 5 GHz), if you define a 
standard of subclass 1 (1 GHz to 5 GHz) and a standard of subclass 2 (5 
GHz to 8 GHz), calibration possible for subclass 2 although it is out of the 
measurement frequency range. The calibration coefficients, however, are 
disregarded. (There is no check mark on the softkey.) Note that, because 
the standard of subclass 1 covers the measurement frequency range, Done 
is available. 

 
  

Example 4, When a part of a frequency range specified with a subclass lies outside the measurement frequency range 

For a measurement frequency range (1 GHz to 6 GHz), if you define a 
standard of subclass 1 (1 GHz - 5 GHz) and a standard of subclass 2 (5 
GHz to 8 GHz), a part of subclass 2 (6 GHz to 8 GHz) lies outside the 
measurement frequency range, but the other part (5 GHz to 6 GHz) lies 
within it, so calibration is possible. 
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Receiver Calibration 

 Overview 

 Turning Receiver Error Correction ON/OFF 

 Selecting Target Port for Error Correction 

 Measuring Calibration Data 

Other topics about Advanced Calibration 
Overview 

The E5071C has a function to calibrate the gain of the individual receivers 
in absolute value measurement. 

The receiver calibration function calibrates the gain of the receiver by 
inputting the output power of a stimulus port that has been assigned a 
correct value by the power calibration to the port of the receiver you need 
to calibrate. 

 Receiver calibration is valid only for the parameters 
of absolute value measurement. 

Turning Receiver Error Correction ON/OFF 

The receiver calibration data are acquired for each channel/test port, so 
the gain error correction can be turned ON/OFF independently for any 
channel or port. 

The status of the gain error correction for each channel is indicated by one 
of the symbols in the channel status bar in the lower part of the window, 
as shown in the following table. 

Symbol Status of receiver error correction 

RC (displayed in blue) Error correction is performed for all of the receiver ports. 

RC (displayed in grey) Error correction is performed for some of the receiver 
ports. 

RC? (displayed in blue) Error correction is performed for all of the receiver ports. 
Interpolated calibration data is used. 

RC? (displayed in grey) Error correction is performed for some of the receiver 
ports. Interpolated calibration data is used. 

RC! (displayed in blue) Error correction is performed for all of the receiver ports. 
Extrapolated calibration data is used. 

RC! (displayed in grey) Error correction is performed for some of the receiver 
ports. Extrapolated calibration data is used. 

--- (displayed in gray) Error correction is not performed. 
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(At least one receiver port is turned on for error 
correction, but valid calibration data are not available.) 

None Error correction is not performed. 
(Error correction is turned off for all of the receiver 
ports.) 

Turning receiver error correction ON/OFF 

The error correction of the receiver is automatically turned on when the 
calibration data are measured. You can also turn this ON/OFF explicitly by 
following the steps below. 

1. Press Cal key. 

2. Press Receiver Calibration. 

3. Select a port (see Selecting target port for error correction). 

4. Click Correction. Each time the key is pressed, ON and OFF switches 
over alternately. 

Selecting Target Port for Error Correction 

The error correction of receiver ports is performed for each channel/port, 
and you can set the following items for them: 

 Turning on or off error correction 

 Calibration data 

1. Press Cal key. 

2. Press Receiver Calibration. 

3. Press Channel Next/Channel Prev keys to select a channel. 

4. Click Select Port. 
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5. Click the softkey corresponding to the port you want to calibrate. 

Measuring Calibration Data 

 The power calibration information on both the 
receiver port and source port is used to calculate calibration 
coefficients. The accuracy of receiver calibration will increase if 
power calibration is implemented for both the receiver port and 
the source port before starting receiver calibration. For 
information on power calibration, refer to Power Calibration. 

1. Press Cal key. 

2. Press Receiver Calibration. 

3. Select a port (see Selecting target port for error correction). 

4. Click Source Port. 

5. Select the stimulus port for which you want to perform power 
calibration. 

6. Connect the selected stimulus port by cable to any port you want to 
calibrate. 
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7. Click Receiver Calibration > Power Offset to enter the offset value. 
Receiver calibration is done at the condition of (source 
power)+(Specified offset). 
 
For example, if the source Power is -10 dBm, then: 

 If specified offset is 0 dBm, then Source Power Reading after 
calibration would be -10 dBm. 

 If specified offset is 10 dBm, then Source Power Reading after 
calibration would be 0 dBm. 

 If specified offset is -10 dBm, then Source Power Reading after 
calibration would be -20 dBm. 

 The value of offset is independent for each channel. 

8. The E5071C provides an option to calibrate both the Receiver and 
Transmitter end, or only the Receiver end, or only the Transmitter 
end: 

 Click Receiver Calibration > Calibrate  Both to start 
measurement of calibration data for both receiver and 
transmitter end. This step allows the gain of the receiver to be 
calibrated, turning on the error correction function 
automatically. 

9. From Firmware revision 9.2, Take Cal Sweep softkey is renamed 
as the Calibrate Both softkey. 
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 Click Receiver Calibration > Calibrate R to calibrate the receiver 
end only. 

 When Calibrate R is selected, the Select Port setting is 
used and the Source Port setting is ignored.   

 Click Receiver Calibration > Calibrate T to calibrate the 
transmitter end only. 

 When Calibrate Both or Calibrate T is selected, the 
source port should be different from measurement port. 
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Power Calibration 

 Overview 

 Turning Power Level Error Correction ON/OFF 

 Preparing Power Meter and Sensor 

 Selecting Target Port of Error Correction 

 Setting Loss Compensation 

 Setting Tolerance for Power Calibration 

 Measuring Calibration Data 

Other topics about Advanced Calibration 
Overview 

The E5071C has a calibration feature for power level output that uses the 
power meter (power calibration). 

The power calibration function outputs a stimulus signal with a more 
accurate power level (closer to the set value) by measuring calibration 
data (power level) in advance with the power meter and sensor. Then this 
function performs error correction of the power level by using the 
calibration data. 

Turning Power Level Error Correction ON/OFF 

Power calibration data are acquired for each channel/test port, and you can 
turn ON/OFF the power level error correction independently for any 
channel or test port. 

The status of the power level error correction of each channel is indicated 
by one of the symbols shown in table below in the channel status bar in 
the lower part of the window. 

Symbol Status of power level error correction 

PC (displayed in blue) Error correction is performed for all stimulus ports 

PC (displayed in gray) Error correction is performed for some stimulus ports 

PC? (displayed in blue) Error correction is performed for all stimulus ports; 
interpolated calibration data is used. If you turn on the 
error correction function when the stimulus setting is 
different from that when the power calibration data were 
acquired, power level error correction is performed with 
interpolated calibration data only when calibration data 
can be interpolated (extrapolation is not performed for 
calibration data). 

PC? (displayed in gray) Error correction is performed for some stimulus ports; 
interpolated calibration data is used. If you turn on the 
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error correction function when the stimulus setting is 
different from that when the power calibration data were 
acquired, power level error correction is performed with 
interpolated calibration data only when calibration data 
can be interpolated (extrapolation is not performed for 
calibration data). 

--- (displayed in gray) Error correction is not performed 
(some stimulus ports have error correction set to on, but 
there is no valid calibration data) 

None Error correction is not performed 
(error correction is off for all stimulus ports) 

Procedure to turn ON/OFF power level error correction 

Power level error correction is automatically turned on when you execute 
the measurement of calibration data. You can turn it on or off as necessary 
by using the following procedure. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Select a port. 

4. Click Correction. Each press toggles this selection between ON/OFF. 
Preparing Power Meter and Sensor 

To execute power calibration, you need to prepare the power meter and 
power sensor used to acquire power calibration data. 

 Power calibration may not be executed when the 
specified frequency and level is out of range of the power sensor 
specification. 

 Power meter is controlled via USB/GPIB connector or 
USB (for USB enabled Power Meters) 

The table below shows available power meters and recommended power 
sensors for power calibration. 

Product 
Description 

Model Number 
Supported ENA 
Firmware 
Revision 

Power meters 

Agilent 437B, 438A, E4418A/B, E4419A/B, 
N1911A/N1912A 
(w/ USB/GPIB interface) 

All 

HP EPM-441A/442A, EPM-P E4416A/E4417A 
(w/ USB/GPIB interface) 
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Agilent N1911A/N1912A (USB to USB direct 
connection)   A.09.2x and above 

Agilent N1913A/N1914A EPM Series   A.11.0x and above 

Power sensors 

Agilent 8482A, E4412A, N1921A 
 All 

HP ECP-E18A 

Agilent N1922A, E4413A, E9300A, E9301A, 
E9304A, E9304A-H18/H20, E9300H, E9300H-
H19, E9301H, E9300B, E9301B 

A.09.1x and above 

Agilent U2000A/B/H, U2001A/B/H, U2002A/H, 
U2004A 

A.09.2x and above 

Preparing to control the power meter 

When acquiring power calibration data, the power meter is controlled via 
GPIB or USB (for USB enabled Power Meters) from the E5071C. 

To control the power meter through GPIB from the E5071C, connect the 
USB port of the E5071C and the GPIB/USB connector of the power meter 
through the USB/GPIB interface and set the GPIB address of the connected 
power meter with the E5071C. 

 The USB/GPIB interface and USB enabled power 
sensor must be ready to use. When you connect them for the 
first time, new hardware wizard runs. For the procedure, refer 
to Setting system controller (USB/GPIB interface). The 
hardware wizard procedure for USB enabled power sensor is 
same. At the last step in the procedure, Assign USB device alias 
dialog box will be displayed. Select "When a new USB device is 
plugged in" or "Never show this dialog" instead of "Each time a 
USB devices is plugged in", or ENA sometimes fail to recognize 
the USB power sensor. 
 
For detailed information, refer to "Hardware Installation and 
Configuration", page 15 to 19 of USB Power sensor operation 
manual, U2000-90405 November 14, 2008 3rd edition. 

 Check whether the USB power sensor is properly 
installed by referring to "Hardware Installation and 
Configuration" of USB Power sensor operation manual, U2000-
90405. If you face trouble while connecting the USB power 
sensor for the first time, or just after reconnecting, try to restart 
the ENA firmware and re-connect the USB power sensor again. 
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Selecting the power meter 

Use the following procedure to select the type of GPIB or USB enabled 
power meter: 

1. Press System key. 

2. Click Misc Setup > Power Meter Setup > Select type > GPIB|USB 

3. From Firmware revision 9.2, E5071C supports USB enabled 
power sensors. 

Using GPIB controlled power meter 

Use the following procedure to set the GPIB address of the power meter: 

1. Press System key. 

2. Click Misc Setup > GPIB Setup > Power Meter Address. 

3. Enter the GPIB address of the power meter you are using. 

4. You can also set the GPIB address of power meter by pressing 
System > Misc Setup > Power Meter Setup > GPIB Address 

Setting power sensor calibration factor table 

 Before using the power sensor calibration factor 
table of the E5071C, set the calibration factor to 100% and then 
calibrate the power sensor. 

When you use the 437B or 438A as the power meter, you need to set the 
power sensor calibration factor table with the E5071C. 

If you use a power meter other than the 437B or 438A, refer to the 
following table. 

Power sensor Setting of calibration factor table 

8482A Set the calibration factor table with the E5071C only when you do 
not set the calibration factor table with the power meter. If you set 
the calibration factor table with both the power meter and the 
E5071C, calibration is executed by both of them and you cannot 
obtain correct measurement results. 

E4412A ECP-
E18A 

You do not need to set the calibration factor table with the 
E5071C. Even if you set the calibration factor table with the 
E5071C, this setting would be ignored. 

 If you use the E4418A, E4419A, EPM-441A, or EPM-
442A with Firmware revision Ax.02.00 or earlier and you set the 
calibration factor table with the E5071C, calibration is executed 
by both the power meter and the E5071C due to this Firmware 
revision, and thus you cannot obtain correct measurement 
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results. Therefore, never set the calibration factor table under 
this condition with the E5071C. 

Use the following procedure to set the power sensor's calibration factor 
table: 

1. Press Cal key. 

2. Click Power Calibration. 

3. Click Sensor A Settings (for power sensor connected to channel A) or 
Sensor B Settings (for power sensor connected to channel B). 

4. Click Ref Cal Factor. 

5. Enter the reference calibration factor (the calibration factor at 50 
MHz). 

6. According to the calibration factor data attached to the power sensor, 
set the frequency (Frequency) and the coefficient (Factor) of the 
calibration factor table by using the hardkeys and softkeys. 

7. Pressing Preset > OK does not affect the current setting of the 
reference calibration factor and the calibration factor table. 

8. For a frequency other than one set in the table, a value 
obtained by linear interpolation of the calibration factors at the 
2 points adjacent to the frequency is used. If a frequency is 
lower than the lowest frequency in the table, the calibration 
factor at the lowest frequency is used; if larger than the highest 
frequency in the table, the calibration factor at the highest 
frequency is used. 

9. When setting the table by using the front panel keys or the 
keyboard, you need to first set the focus on (select) the 
operation target (table or softkey). You can change the focus by 
pressing Focus key in the ENTRY block. When the focus is 
placed on the table, the window frame of the table is displayed 
as bright as the window frame of the active channel. When the 
focus is placed on the softkey menu, the softkey menu title area 
is displayed in blue. 

Saving power sensor calibration factor table 

You can save the power sensor calibration factor table as a CSV (Comma 
Separated Value) format file. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Click Sensor A Settings or Sensor B Settings. 
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4. Click Export to CSV File to open the Save As dialog box. At this time, 
CSV File (extension *.csv) is selected as the file type. 

5. Enter a file name in the File Name box and press the Save button to 
save the power sensor calibration factor table. 

Recalling power sensor calibration factor table 

By recalling a power sensor calibration factor table saved in the CSV 
format according to saving power sensor calibration factor table, you can 
set the power sensor calibration factor table. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Click Sensor A Settings or Sensor B Settings. 

4. Click Import from CSV File to open the Open dialog box. At this time, 
CSV File (extension*.csv) is selected as the file type. 

5. Select the CSV format file you want to import and press the Open 
button to recall the power sensor calibration factor table. 

6. This operation is not guaranteed under the following two 
conditions: 
1) you imported a CSV format file created/edited on a 
spreadsheet program, or 
2) you imported a CSV format file that had been exported 
according to Saving power sensor calibration factor table but 
then modified. 

Using USB power sensor 

Use the following procedure to select the USB power meter: 

1. Press System key. 

2. Click Misc Setup > Power Meter Setup > USB. 

3. Select desired USB power sensor. 

4. When USB enabled power sensor is plugged to ENA, it will take 
about 30 seconds to be ready. If you perform calibration or 
zeroing before the ENA is ready, an error will occur. 

Performing Zeroing/Calibration 

Zeroing a power sensor is performed in order to reduce zero measurement 
offset and noise impact to improve the accuracy of RF power 
measurement. The U2000 Series USB power sensors have two types of 
zeroing INTernal zeroing and EXTernal zeroing. For more information, refer 
to http://cp.literature.agilent.com/litweb/pdf/U2000-90405.pdf. 

Use the following procedure to perform zeroing/calibration: 
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1. Press Cal key. 

2. Click Power Calibration > Sensor A/B Settings > Zero Type > INT|EXT 
to select from internal or external zeroing. 

3. Click Power Calibration > Sensor A/B Settings > Zero/Calibrate Sensor 

4. For U2000 Series USB power sensors, Sensor B setting is 
disabled. 

Selecting Target Port of Error Correction 

The power level error correction is executed for each channel/test port. 
You can set the following items for each channel/test port: 

 ON/OFF of error correction 

 Setting of loss compensation 

 Selection of the power sensor 

 Number of power level measurements at one measurement point 

 Calibration data 

Follow the steps below to select the test port for which you want to 
set/execute power level error correction. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Press Channel Next/Channel Prev keys to select the channel. 

4. Click Select Port. 

5. Click the softkey corresponding to the test port you want to select. 
Setting Loss Compensation 

If you need to apply a signal with a more accurate power level to the DUT, 
you can use the loss compensation feature to obtain calibration data for 
correcting the difference in power loss due to the difference in connection 
method (cable, adapter, etc.) between the time when the power calibration 
data are measured and when the actual DUT is measured. 

The loss compensation feature corrects the power measurement result 
based on the preset power loss data. More specifically, if you turn on the 
loss compensation, the measurement result of the power level obtained in 
the power calibration data measurement is a value obtained by adding the 
loss value set in the loss compensation table to the measured power value. 

Turning ON/OFF loss compensation 

Follow the steps below to turn ON/OFF the loss compensation. 

1. Press Cal key. 

2. Click Power Calibration. 
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3. Select a port (refer to Selecting target port of error correction). 

4. Click Loss Compen > Compensation. Each press toggles the selection 
between ON/OFF. 

Creating loss compensation table 

Follow the steps below to set the loss compensation table. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Select a port (refer to Selecting target port of error correction). 

4. Click Loss Compen 

5. Set the frequency (Frequency) and the loss (Loss) of the loss 
compensation table by using the hardkeys and softkeys. 

1. Pressing Preset > OK does not affect the current setting of the 
reference calibration factor and the calibration factor table. 

2. For a frequency other than one set in the table, a value 
obtained by linear interpolation of the calibration factors at the 
2 points adjacent to the frequency is used. If a frequency is 
lower than the lowest frequency in the table, the calibration 
factor at the lowest frequency is used; if larger than the highest 
frequency in the table, the calibration factor at the highest 
frequency is used. 

3. When setting the table by using the front panel keys or the 
keyboard, you need to first set the focus on (select) the 
operation target (table or softkey). You can change the focus by 
pressing Focus key in the ENTRY block. When the focus is 
placed on the table, the window frame of the table is displayed 
as bright as the window frame of the active channel. When the 
focus is placed on the softkey menu, the softkey menu title area 
is displayed in blue. 

Saving loss compensation table 

You can save the loss compensation table as a CSV (Comma Separated 
Value) format file. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Select a port (refer to Selecting target port of error correction). 

4. Click Loss Compen. 
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5. Click Export to CSV File to open the Save As dialog box. At this time, 
CSV File (extension*.csv) is selected as the file type. 

6. Enter a file name in the File Name box and press the Save button to 
save the loss compensation table. 

Recalling loss compensation table 

By recalling a loss compensation table saved in the CSV format according 
to the Saving loss compensation table, you can set this loss compensation 
table. 

1. It is possible to recall a file from a different channel/port from 
where it was saved. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Select a port (refer to Selecting target port of error correction). 

4. Click Loss Compen. 

5. Click Import from CSV File to open the Open dialog box. At this time, 
CSV File (extension*.csv) is selected as the file type. 

6. Select the CSV format file you want to import and press the Open 
button to recall the loss compensation table. 

7. This operation is not guaranteed under the following two 
conditions: 1) you imported a CSV format file created/edited on 
a spreadsheet program, or 2) you imported a CSV format file 
that had been exported according to Saving loss compensation 
table but then modified. 

Setting Tolerance for Power Calibration 

The tolerance value sets the target power tolerance for the power 
calibration. Follow the steps below to set the tolerance for power 
calibration: 

1.  Press Cal key. 

2. Click Power Calibration > Tolerance. 

3. Enter the tolerance value for power calibration. 

Setting Max Iteration 

When you want to make a power calibration with higher accuracy, use the 
Iteration function. This function repeats the cycle of updating the power 
calibration coefficient and measuring the power level until the Max 
Iteration number at each stimulus point is reached. 
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On the other hand, Num of Readings just repeats the power measurement 
and averages the measurement results without updating the power 
calibration coefficient. This capability should be used only when the 
measurement of the power sensor is unstable due to some circumstances. 

 When the max iteration is set to 0, no iteration is performed. The 
output power level is measured and the power calibration coefficient 
is set by comparing the targeted power level and the actually 
measured power level at each stimulus point. If the measured power 
level is out of the tolerance, the power calibration process is aborted 
with an error message. 

 When the max iteration is 1 and above, the power measurement is 
re-performed after the initial power measurement and updating the 
power calibration coefficient. And if the measured power level is 
within the tolerance, the analyzer goes to the next stimulus point to 
be calibrated. If the measured power level is out of the tolerance, the 
analyzer repeats the cycle of updating the calibration coefficient and 
measuring the power level until the max iteration number. If the 
power measurement value is out of the tolerance even after the max 
iteration, the power calibration process is aborted with an error 
message. 

 Max Iteration is independent of measurement type. It corrects the 
E5071C source regardless of which receivers are being used in a 
measurement. Therefore, it can be used with both ratio or non-ratio 
measurements. 

 Applies only to those measurements on the selected channel that use 
the test port specified as the source for the calibration. For example, 
if you specify Channel 1 and Port 1 as the source to be calibrated, 
only those measurements on channel 1 that use port 1 as the source 
will be corrected.  

 Can be used in conjunction with other measurement calibrations, 
such as a full 2-port calibration. For highest accuracy, perform the 
measurement calibration after the source calibration. 

 Can be used with Power Sweep type. Source Power Cal corrects the 
power at all power levels across the power sweep. 

 Can also be used with Port Power Uncoupled. 

To set the maximum iteration, follow the steps below: 

1. Press Cal > Power Calibration > Maximum Iteration, then set the 
maximum iteration value. 

Measuring Calibration Data 
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 Before measuring calibration data, you need to 
execute the zero adjustment and calibration of the power 
sensor. For information on how to execute these operations, see 
the manual of the power meter you are using. 

When using the power sensor calibration factor table of the E5071C, set 
the calibration factor to 100% and execute the calibration of the power 
sensor. 

1. Press Cal key. 

2. Click Power Calibration. 

3. Select a port (refer to Selecting target port of error correction). 

4. Click Use Sensor. Each press toggles between channel A and channel 
B. If you use a power meter with one channel, channel A is always 
selected. 

5. Click Tolerance and enter the tolerance value (for example, 0.1 dB). 

6. Click Max Iteration and enter the max iteration number (for example, 
5). 

7. Connect the power sensor for the selected channel to the selected 
port.   

8. Click Take Cal Sweep to start the measurement of calibration data. 

9. You can abort the measurement by pressing Abort during 
measurement. 

10. When the measurement is complete, the power level error 
correction is automatically turned on. 

11. If the power meter GPIB address is not set correctly or if 
the power sensor is not connected to the specified channel, an 
error occurs and calibration data are not measured. 

 If appropriate calibration data cannot be obtained, 
an error may occur for each sweep after the measurement of 
calibration data is complete. In this event, turn off the power 
level error correction, check the connection and setting, and 
then measure the calibration data again. 
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Partial Overwrite Calibration 

 Overview 

 Procedure 

Other topics about Advanced Calibration 
Overview 

The partial overwrite function is used to perform partial measurement after 
the execution of calibration, and it overwrites the calibration coefficients. 

There are three types of calibration coefficients: Er, Es, Ed for reflection, Et 
for transmission, and Ex for isolation. If some of them do not provide 
satisfactory calibration, you can use this function to re-calculate the 
calibration coefficients by measuring an applicable standard only instead of 
measuring all standards again. 

 When the calibration coefficients become 
inappropriate over time or the status on the E5071C side from 
the calibration surface changes due to replacement of a cable or 
connector, you need to also perform thru measurement when 
partial overwrite is required for reflection or isolation 
measurement. 

  The adapter removal and partial overwrite function 
is only available when calibration status is [Corr] and not for 
[C?] or [C!]. 
 
Partial overwrite is not available if no calibration has been done. 
You cannot append calibration coefficients to previous 
calibrations. For example, you cannot realize full 4-port 
calibration by performing additional calibration for 1 port after 
the execution of full 3-port calibration. The partial overwrite 
function is used to make measurements for previous calibration 
coefficients and overwrite them. 

Procedure 

Follow these steps to execute the partial overwrite function. The example 
demonstrates re-calibration for full 2-port thru calibration. 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > 2-Port Cal > Select Ports. 

4. Select the test ports for which you want to perform re-calibration for 
full 2-port calibration. (In the following procedure, the test ports you 
select are expressed as test ports x and y.) 
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5. Click Transmission. 

6. Make a thru connection between selected test ports x and y 
(between the connectors to which the DUT is connected). 

7. Click Port x-y Thru (x and y are the thru-connected port numbers) to 
start the re-measurement of the calibration standard. 

8. Click Return. 

9. Click Overwrite to finish the re-calibration for the full 2-port 
calibration. At this point, the calibration coefficients are re-calculated 
and saved. 

. 
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Simplified Calibration 

 Overview 

 Simplified Full 3/4-port Calibration 

 Simplified 3/4-port TRL Calibration 

Other topics about Advanced Calibration 
Overview 

The simplified calibration calculates the calibration coefficients by skipping 
part of thru measurement (and line measurement for TRL measurement) 
that is necessary for the full 3/4-port calibration and the 3/4-port TRL 
calibration. 

Simplified Full 3/4-port Calibration 

In the simplified full 3/4-port calibration, since the calibration coefficients 
are calculated while omitting part of the thru measurement data, the effect 
of errors when acquiring calibration data becomes larger than in the 
normal full 3/4-port calibration. Therefore, you must pay special attention 
to the following points when measuring data for the simplified full 3/4-port 
calibration. 

 The standard used for measurement must match its definition value. 

 Use a standard that provides good repeatability (stability). 

 Do not omit the length of the thru when defining the standard. 

 When using a user-created standard, verify the definition 
value. 

 For the N connector, note the discrimination between male and 
female. 

 Realize high reliability and repeatability for measurement. 

 Reduce the difference in external environment (such as 
temperature difference) between conditions of measuring 
calibration data and conditions of measuring actual data. 

 Set the power level of the stimulus signal to a value that does 
not generate compression. 

 Narrow the IF bandwidth. 

 Increase the averaging factor. 

 Use a cable whose change in amplitude/phase characteristics 
when bent is small. 

 Use high-precision connectors. 
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The types of thru measurement you can omit are determined by the ports 
you select. Some types of thru measurement cannot be omitted. The table 
below shows the types of thru measurement that can be omitted. 

Omissible Thru Type at Full 3-port Calibration 

Ports used Types of thru measurement that can be omitted 

Ports 1, 2, 3 2-3 

Ports 1, 2, 4 2-4 

Ports 1, 3, 4 1-4 

Ports 2, 3, 4 2-4 

For the simplified full 3-port calibration, (Optional) is displayed on the 
softkey of the type of thru measurement that can be omitted. For example, 
when the omissible thru measurement is 2-3, 2-3 (Optional) is displayed. 
The display after the execution of the omissible thru measurement is the 
same as that for a required thru measurement. 

Omissible Thru Type at Full 4-port Calibration 

Required thru 
measurements 

Types of thru measurement that can 
be omitted 

1-2, 1-3, 3-4 1-4, 2-3, 2-4 

For the simplified full 4-port calibration, (Recommended) is displayed on 
the softkey of the type of thru measurement that can be omitted. For 
example, when the omissible thru measurement is 2-3, 2-3 (Recommended) 
is displayed. The display after the execution of the omissible thru 
measurement is the same as that for a required thru measurement, and 
the display for the remaining omissible thru measurement is 2-3 (Optional). 

For the simplified full 4-port calibration, up to three thru measurements 
can be omitted, but it is recommended to perform two or more types of 
calibration because omitting all of them results in poor accuracy. 

Simplified 3/4-port TRL Calibration 

In the simplified 3/4-port TRL calibration, because the calibration 
coefficients are calculated while omitting part of the thru/line measurement 
data and line/match measurement data, the effect of errors when acquiring 
calibration data becomes larger than in the normal 3/4-port TRL 
calibration. Therefore, you must give more attention to data measurement 
for the simplified full 3/4-port calibration than for the ordinary 3/4-port 
TRL calibration. 
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The types of thru/line measurement and line/match measurement you can 
omit are determined by the ports you select. Some types of measurement 
cannot be omitted. You cannot omit thru/line measurement only or 
line/match measurement only, even for an omissible measurement path. 

Omissible Thru type at 3-port TRL calibration 

Ports used Omissible measurement 

Ports 1, 2, 3 2-3 

Ports 1, 2, 4 2-4 

Ports 1, 3, 4 1-4 

Ports 2, 3, 4 2-4 

For the simplified 3-port TRL calibration, (Optional) is displayed on the 
softkey of the omissible thru/line measurement. For example, when the 
omissible thru/line measurement is 2-3, 2-3 (Optional) is displayed. The 
display after the execution of the omissible thru/line measurement is 2-3 
Thru/Line. 

For the softkey of an omissible line/match measurement, (Optional) is 
displayed as in the case of the omissible thru/line measurement. For 
example, when the omissible line/match measurement is 2-3, 2-3 (Optional) 
is displayed. The display after the execution of the omissible line/match 
measurement is 2-3 Line/Match. 

The softkeys (Fwd and Rvs) for forward measurement and reverse 
measurement for the omissible line/match measurement do not change. 

Omissible measurements at 4-port TRL calibration 

Required measurements Omissible measurements 

1-2, 1-3, 3-4 1-4, 2-3, 2-4 

For the simplified 4-port TRL calibration, (Recommended) is displayed on 
the softkey of the omissible thru/line measurement. For example, when 
the omissible thru/line measurement is 2-3, 2-3 (Recommended) is 
displayed. The display after the execution of the omissible thru/line 
measurement is 2-3 Thru/Line, and the display for the remaining omissible 
thru/line measurement is 2-3 (Optional). 

For the softkey of an omissible line/match measurement, (Recommended) 
is displayed as in the case of the omissible thru/line measurement. For 
example, when the omissible line/match measurement is 2-3, 2-3 
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(Recommended) is displayed. The display after the execution of the 
omissible line/match measurement is 2-3 Line/Match, and the display for 
the remaining omissible line/match measurement is 2-3 (Optional). 

The softkeys (Fwd and Rvs) for forward measurement and reverse 
measurement for the omissible line/match measurement do not change. 

For the simplified 4-port TRL calibration, up to three thru/line 
measurements and line/match measurements can be omitted, but omitting 
all of them results in poor accuracy. 
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Adapter Removal-Insertion 

 About Adapter Removal 

 About Adapter Insertion 

 About Adapter Waveguide & Rotate 

 Performing Adapter Waveguide Calibration 

 Procedure for Adapter Removal/Insertion 

 Adapter Removal 

 Adapter Insertion 

 Difference between Traditional Network Analyzer & E5071C Adapter 
Calibration 

Other topics about Advanced Calibration 
About Adapter Removal 

Adapter Removal is a technique used to remove any adapter 
characteristics from the calibration plane. The E5071C uses the following 
adapter removal process to remove adapter characteristics: 

1. Perform calibration with the adapter in use. 

2. Remove the adapter from the port and measure Open, Short, and 
Load values to determine the adapter's characteristics. 

3. Remove the obtained adapter characteristics from the error 
coefficients in a de-embedding fashion. 

Open, Short, and Load values measured with the adapter removed 
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 The adapter removal and partial overwrite function is 
only available when the calibration status is [Corr] and not for 
[C?] or [C!]. 

About Adapter Insertion 

This above described method also makes it possible to add adapter 
characteristics to a port with n-port full calibration. This allows you to 
make a measurement with the adapter. E5071C uses the following adapter 
insertion process to insert adapter characteristics: 

1. Perform calibration without adapter in use. 

2. Insert the adapter to the port and measure Open, Short, and Load 
values to determine the adapter's characteristics. 

3. Insert the obtained adapter characteristics to the error coefficients in 
an embedding fashion. 

Open, Short, and Load values measured with adapter attached 

 
  

In order to determine the adapter characteristics (with four unknown 
parameters) by making three measurements (Open, Short, and Load), the 
adapter must satisfy the following requirements: 

1. Adapter must be Reciprocal (with S21 and S12 equal) in nature. It 
should have a consistent behavior, independent of the direction from 
which it is used. 

2. The electrical length of Adapter should be known at an accuracy of 
±1 /4 of wavelength. 

About Adapter Waveguide & Rotate 
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From firmware A.09.10, functionality related to adapter waveguide and 
adapter rotation is added. Adapter waveguide length and Cut off frequency 
can be set using the following commands: 

SCPI.SENSe(Ch).CORRection.COLLect.ADAPter(Pt).WAVeguide.LENGth 

SCPI.SENSe(Ch).CORRection.COLLect.ADAPter(Pt).WAVeguide.CUToff 

Coaxial length can be set using Cal > Calibrate > Adapter Removal > 
Coaxial Length 

Rotate command executes Adapter Removal/Insertion along with moving 
the phase of adapter (which is removed or inserted) to 180 degrees. This 
command is useful in cases where auto judgement of phase fails. This 
command can be executed several times while the calibration remains 
valid.   

SCPI.SENSe(Ch).CORRection.COLLect.ADAPter(Pt).ROTate 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 

 Some calibration kits such as the waveguide 
calibration kit have operational frequency range defined by 
Minimum and Maximum frequency. When the E5071C stimulus 
setting is out of the operational frequency range, you cannot 
click Done key or finish the calibration by remote control. In 
this case, use a calibration kit that has proper frequency range, 
or change the E5071C stimulus setting to proper range that the 
calibration kit can cover. Refer to the calibration kit manual or 
definition in the E5071C with Cal > Modify Cal Kit > Define STDs 
for the Maximum & Minimum frequency of the calibration kit. 

Performing Adapter Waveguide Calibration 

This section provides an example of performing adapter waveguide 
calibration to perform a Full 2-port calibration plane between Port 1 
(3.5mm) & Port 2 (P-band wave guide). 
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1. Using Adapter Insertion: 

a. Perform a SOLT F2P Calibration at Port 1 (3.5mm) using 
Z0=50 ohm 

b. Perform Adapter insertion at Port 2 (Z0=1) using P11644A 
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2. Using Adaptor Removal: 

a. Perform a SOLT/TRL F2P Calibration at P band WG (Z0 = 1) 

b. Perform Adapter removal at port 1 (Z0=50) using 85052D 

 
3. Using Port Extension: 

a. Perform a SOLT F2P calibration at Port 1 (3.5mm) with Z0 = 
50 

b. Perform Port extension calibration at Port 2 (manual with Coax 
length, WG length, Cut off). System Z0 can be either 1 oh or 
50 ohm; both are fine to use. 
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Procedure for Adapter Removal/Insertion 

Example scenario where adapter removal/insertion is required: When the 
DUT is an SMA (female) -to-Type N (male) whereas the test ports are two 
SMA (male) cables. In such cases, an adapter of Type N (female)-to-SMA 
(female) is required to perform adapter removal/insertion. 

The S parameter of a reciprocal adapter can be determined when the 
following data is available: 

1. Open, Short, and Load measurements. 

2. Actual values derived from the CalKit definitions. 

3. An approximate length of the adapter. 

4. Nature of the intended operation: removal or insertion. 

 If the frequency setting is not Zero Span, an 
approximate length of the adapter should be provided otherwise 
an error might be generated in the measurement. 

 For Adapter Removal, the adapter length is (+) 
Positive. For Adapter Insertion, the Adapter length is (-) 
Negative. 

 To change gender of the calibration kit, refer to 
Defining Calibration Kit Gender. 

The diagram below shows summary of the adapter removal and insertion 
procedure: 
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To use Adapter Removal: 

1. Perform a full n-Port calibration using your calibration kit so that the 
port used to conduct adapter removal is calibrated. 

 When you need to remove an adapter from the 
calibration plane (adapter removal) to connect your DUT, 
perform the calibration with an adapter so that you can 
make a calibration with your calibration kit.  

2. Open the Adapter Removal menu: 
 
Cal > Calibrate > Adapter Removal 
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3. Select the Port from which you want to remove Adapter 
characteristics from. Select Port  (e.g. 1) (1 in the above figure). A * 
sign appears in front of the port indicates that this is a valid port to 
conduct adapter removal (as well as insertion) as the full n-port 
calibration has been performed on the port. 

4. Select the proper standard Calkit you need to use from the options 
available at CalKit (e.g. 85033E) (2 in the above figure) to 
characterize the adapter. The calibration kit is used at the plane from 
which adapter is removed. 

5. If you are using a Waveguide or a mixed adapter: 

a. Set the Coaxial length as Auto for Automatic Removal or with a 
(+) Positive value. 

b. Select the Cutoff Frequency of the waveguide you want to enter 
(6 in the above figure). The Cutoff Frequency is defined by the 
waveguide calibration kit in use. 

 Without entering the value of Cutoff Frequency, the 
Waveguide Length cannot be entered. 

c. Set the Waveguide Length as Auto for Automatic Removal or if 
you want to input a manual Waveguide Length, type a value 
with a (+) Positive value, which indicates removal. 

 When using waveguide calibration kit and measuring 
waveguide devices, ensure that you change the system Z0 
to 1 ohm prior to calibration. 

If you are using Coaxial extension: 

a. Set the Coaxial length as Auto for Automatic Removal or with a (+) 
Positive value. 

b. Omit the Cutoff Frequency and Waveguide Length selection.  

6. Connect Open, Short, and Load of the selected Calkit (e.g. 85033E) 
with the selected port respectively and select Open, Short, and Load 
respectively. E5071C measures the cal kit standard, calculates the 
adapter characteristics, and then conducts adapter removal. 

 A checkmark appears on the (Open, Short, and Load) 
menu after each type of calibration is completed, respectively. 

7. Click Done to complete the process (7 in the above figure). 

 Some calibration kits such as the waveguide calibration kit 
have operational frequency range defined by Minimum and 
Maximum frequency. When the E5071C stimulus setting is out of 
the operational frequency range, you cannot click Done or finish 
the calibration by remote control. In this case, use a calibration 
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kit that has proper frequency range, or change the E5071C 
stimulus setting to proper range that the calibration kit can cover. 
Refer to the calibration kit manual or definition in the E5071C with 
Cal > Modify Cal Kit > Define STDs for the Maximum & Minimum 
frequency of the calibration kit. 

 In cases where auto judgement of phase fails, select 
Rotate Adapter to move the phase of adapter (which is 
removed) to 180 degrees. 

To use Adapter Insertion: 

1. Perform a full n-Port calibration using your calibration kit so that the 
port used to conduct adapter insertion is calibrated. 

 When you need to add an adapter into the calibration 
plane (adapter insertion) to connect your DUT, perform the 
calibration without an adapter. 

2. Open the Adapter Removal menu: 
 
Cal > Calibrate > Adapter Removal 

3. Select the Port in which you want to insert the Adapter 
characteristics from Select Port  (e.g. 1) (1 in the above figure. 
A * sign appears in front of the port is a valid port to conduct 
adapter insertion (as well as removal) as the full n-port 
calibration has been performed on the port. 

4. Select the proper standard Calkit you need to use from the options 
available at CalKit (e.g. 85033E) (2 in the above figure) to 
characterize the adapter. The calibration kit is used at the plane in 
which adapter is inserted. 

5. If you are using a Waveguide or a mixed adapter: 

a. Set the Coaxial length as Auto for Automatic Insertion or with a (-
) Negative value. 

b. Select the Cutoff Frequency of the waveguide you want to enter 
(6 in the above figure). The Cutoff Frequency is defined by the 
waveguide calibration kit in use. 

 Without entering the value of Cutoff Frequency, the 
Waveguide Length cannot be entered. 

c. Set the Waveguide Length as Auto for Automatic Insertion or if 
you want to input a manual Waveguide Length, type a value 
with a (-) Negative value, which indicates insertion. 



Measurement 

233 

 When using waveguide calibration kit and measuring 
waveguide devices, ensure that you change the system Z0 to 1 ohm 
prior to calibration. 

If you are using Coaxial extension: 

a. Set the Coaxial length as Auto for Automatic Insertion or with a (-) 
Negative value. 

b. Omit the Cutoff Frequency and Waveguide Length selection.  

6. Connect Open, Short, and Load of the selected Calkit (e.g. 
85033E)with the selected port respectively and select Open, Short, 
and Load respectively. ENA measures the cal kit standard, calculates 
the adapter characteristics, and then conducts adapter insertion. 

 A checkmark appears in (Open, Short, and Load) menu 
after each type of calibration is completed, respectively. 

7. Click Done to complete the process (7 in the above figure). 

 Some calibration kits such as the waveguide calibration kit 
have operational frequency range defined by Minimum and 
Maximum frequency. When the E5071C stimulus setting is out of 
the operational frequency range, you cannot click Done or finish 
the calibration by remote control. In this case, use a calibration 
kit that has proper frequency range, or change the E5071C 
stimulus setting to proper range that the calibration kit can cover. 
Refer to the calibration kit manual or definition in the E5071C with 
Cal > Modify Cal Kit > Define STDs for the Maximum & Minimum 
frequency of the calibration kit. 

 In cases where auto judgement of phase fails, select 
Rotate Adapter to move the phase of adapter (which is inserted) 
to 180 degrees. 

Difference between Traditional Network Analyzer & E5071C Adapter Calibration 

Usually, two-port network analyzers removes adapter characteristics by 
performing two sets of Full 2 Port Calibration as shown below: 

Calibration performed with the adapter connected to Port2 
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Calibration performed with the adapter connected to Port1 

 
Removing adapter characteristics using two (above) sets of 
calibration 
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However, this method is not suitable for a multi-port network analyzer 
because it will require as many sets of Full 2 Port Calibration as twice the 
number of port combinations. Therefore, the E5071C uses an advanced 
method to remove Adapter characteristics described in About Adapter 
Insertion. 
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Unknown Thru Calibration 

 Overview 

 Procedure 

Other topics about Advanced Calibration 
Overview 

Unknown Thru Cal is the preferred THRU method of calibrating the ENA to 
measure a non-insertable device. The major benefits of using a unknown 
Thru calibration are: 

 It is easy to perform. 

 Provides better accuracy than Defined Thru and is usually better than 
Adapter Removal. 

 Does not rely on the existing standard definitions that may no longer 
be accurate. 

 Causes minimal cable movement if the THRU standard has the same 
footprint as the DUT. In fact, the DUT can often be treated as the 
THRU standard. 

The Thru must satisfy the following requirements: 

1. Thru must be Reciprocal (with S21 and S12 equal) in nature. It 
should have a consistent behavior, independent of the direction from 
which it is used. 

2. The electrical length of the Thru should be known at an accuracy of 
±1 /4 of the wavelength. 

3. Unknown Thru is NOT supported during the TRL calibration. 
Procedure 

To measure the nominal electrical delay of the Unknown Thru standard: 

1. With port 1 configured, perform a simple S11 response calibration at 
port 1 by using a short circuit 
 
Press Cal > Calibrate > Response (Short) > Short 

2. Connect the Unknown Thru standard to port 1 and terminate the 
standard with a short circuit. 

3. Measure the electrical delay of the Unknown Thru standard 
 
Press Cal > Port Extensions > Auto Port Extension > Measure SHORT 
> Port 1 
 
The electrical delay is automatically measured and can be confirmed. 
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Press Cal > Port Extensions > Extension Port 1 {Value} 

4. If there is an offset in the short circuit used to terminate the 
Unknown Thru standard, remember to subtract its electrical 
length from the measurement result. 

To perform the unknown Thru Calibration, follow the procedure below: 

1. Press Cal key, then click Calkit. 

2. Select the desired calibration kit (e.g. 85033D or User Kit) 

3. Press Cal > Modify Calkit > Define STDs > No Name > Label 

4. Type a name for unknown Thru Cal standard e.g. {Unknown Thru1} 

 By changing the label to a different name (e.g. Unknown 
Thru1), the 'No Name' standard will adopt to the specified 
new name. 

5. Press Cal > Modify Calkit > Define STDs > {Defined Name} > STD Type 
> Unknown Thru 

6. Click Offset Delay, then enter the approximate offset delay value of 
the unknown Thru standard. 

7. Press Cal > Modify Calkit > Specify CLSs > Thru > Set All > {Defined 
Name} 

6. Different Unknown Thru can be used for different ports. 

7. Press Cal > Calibrate > n-Port Cal (n>1) > Transmission > {Defined 
Name} to execute mechanical Unknown Thru calibration. 

8. Complete Reflection, and Isolation (optional) calibration for n full 
port Cal. 
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Performing 8 term Calibration using External PC 

 Overview 

 Procedure 

 Example 

Other topics about Advanced Calibration 
Overview 

To perform 8-term error model calibration using an external PC (measuring 
raw measurement data using the E5071C, calculating error term using 
external PC and then performing correction with calculated error terms and 
measured raw data), the procedure described in this section must be 
followed. When you use this method, the measurement specification is not 
satisfied. 

 In most cases, users do NOT need to follow the below procedure 
as these considerations have already been performed on 8-term error 
model calibration in E5071C. 

 When users perform 12-term error model calibration using 
external computer such as SOLT calibration, users do NOT need to take 
following procedure. 

Procedure 

Turning off the "System Calibration" 

In its default setting, the E5071C applies "system calibration" to the 
measured S-parameter data. Because the "system calibration" is applied 
only to the S-parameter measurement data and NOT to the absolute value 
measurement data, it interferes with 8-term error model calibration when 
calculating error coefficients on external computer. You need to turn OFF 
this state, all the time for calibration and measurement. 

The system calibration can be turned off by executing 
SCPI.SYSTem.CORRection.STATe 

 Once the E5071C receives this command, it will keep this 
setting until preset. This state is saved in the state file. 

Turning off the "Virtual Bridge" (3 GHz, 4.5 GHz, 6.5 GHz and 8.5 GHz option only) 

There is a software conversion function called "virtual bridge" on E5071C. 
The default setting of this state is ON, and this state interferes with 8-term 
error model calibration when calculating error coefficients on external 
computer. You need to turn OFF this state, all the time for the calibration 
and the measurement. 
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 This function only exist on frequency 3 GHz, 4.5 GHz, 6.5 GHz 
and 8.5 GHz options.  It's not necessary to consider "virtual bridge" on 
E5070A/71A/70B/71B, and E5071C frequency 14 GHz and 20 GHz 
options. 

The virtual bridge can be turned off by the command: 
SERVice:ADJust:VIRTual:BRIDge[:STATe] {ON|OFF|1|0}. 

 Since this command is under service menu, the "SVC" indicator 
is turned on when the ENA sets virtual bridge OFF. 

 Once the ENA receives this command, it will keep this setting 
until preset. 

 The state of "virtual bridge" is NOT saved in the state file, and 
the default state of the "virtual bridge" is ON. So you need to send the 
command to turn OFF the state, every time you recall the state file. 

Set the "RF ranging mode" to MANual  (3 GHz, 4.5 GHz, 6.5 GHz and 8.5 GHz option only) 

There is a hardware function called "RF ranging mode" on E5071C. The 
default setting of this state is AUTO, and this state interferes with 8-term 
error model calibration when calculating error coefficients on external 
computer. You need to turn off the "RF ranging Auto mode". 

The "RF ranging mode" can be changed by the command: 
SERVice:ADJust:SENSe[Ch]:SWEep:RF:RANGe:PORT[Pt]:AUTO {ON|OFF}. 
This command applies to each channel and measurement port. 

 This function only exist on frequency 3 GHz, 4.5 GHz, 6.5 GHz 
and 8.5 GHz options.  It's not necessary to consider "virtual bridge" on 
E5070A/71A/70B/71B, and E5071C frequency 14 GHz and 20 GHz 
options. 

 Since this command is under service menu, the "SVC" indicator 
is turned on when the ENA sets RF range auto mode OFF. Once the ENA 
receives this command, it will keep this setting until preset. 

 The state of "RF ranging mode" is NOT saved in the state file, 
and the default state of the "RF ranging mode" is AUTO. So you need to 
send the command to set state to AUTO OFF, every time you recall the 
state file. 

You need to keep the state of "RF range Auto Mode" as OFF, all the time 
for calibration and measurement using this method 

 Once the ENA receives above command, it will keep this setting 
until preset. 

 Since the "RF ranging" is hold during the measurement, the 
system dynamic range of the E5071C will degrade by 6dB, as a result of 
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the 8-term calibration performed externally. However, there is NO 
dynamic range degrade by 8-term error model calibration with internal 
calibration of the ENA. 

Example 

Assume you perform 4-port TRL calibration on channel1, you need to send 
following command before calibration. Also, you need to keep this state all 
the time for calibration and measurement. 

SYSTem:CORRection:STATe OFF  'system correction off 

SERVice:ADJust:VIRTual:BRIDge:STATe OFF  'virtual bridge off 

SERVice:ADJust:SENSe1:SWEep:RF:RANGe:PORT1:AUTO OFF  'RF ranging 
mode to manual on port1 

SERVice:ADJust:SENSe1:SWEep:RF:RANGe:PORT2:AUTO OFF  'RF ranging 
mode to manual on port2 

SERVice:ADJust:SENSe1:SWEep:RF:RANGe:PORT3:AUTO OFF  'RF ranging 
mode to manual on port3 

SERVice:ADJust:SENSe1:SWEep:RF:RANGe:PORT4:AUTO OFF  'RF ranging 
mode to manual on port4 

 Once you preset the system, you need to resend all of the 
above commands. 

 Once you save and recall the state using this method, you need 
to resend all of the above commands except for system correction off. 
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Mixer Calibration 
Scalar-Mixer Calibration 

 Overview 

 Confirming Calibration Status 

 Procedure Using Mechanical Calibration Kit 

 Procedure Using ECal Kit 

Other topics about Mixer Calibration 
Overview 

The E5071C has a scalar-mixer calibration function for measuring 
frequency conversion devices. 

Scalar-mixer calibration allows you to measure the magnitude value and 
reflection parameter of the mixer's conversion loss with very high accuracy 
by performing calibration using calibration standards (OPEN/SHORT/LOAD) 
in combination as well as a power meter. 

For measurement of the conversion loss in a frequency conversion device, 
normal full 2-port calibration is not available because of the frequency 
difference between the stimulus port and the response port. Therefore, 
scalar-mixer calibration allows you to correct the error term that resides in 
a full 2-port error model by using the error model and an expression based 
on a new concept. 

You can correct the following error elements by using the scalar-mixer 
calibration. 

 The reflection between the output port of the network analyzer and 
the input port of the measured mixer (vector error correction). 

 The reflection between the output port of the measured mixer and 
the input port of the network analyzer (vector error correction). 

 Transmission frequency characteristics at different frequencies 
(scalar error correction). 

The frequency-offset error model can be described by the flow graph in the 
figure below. From the flow graph it can be seen that the model is divided 
in two halves: the stimulus port and the response port. By conceptualizing 
the error model in these two halves, each error term can be isolated to 
either of the model's halves depending on the frequency at which it was 
generated. The majority of the signals will only affect measurements by 
causing errors at the same frequency. 

Two error signals that are functions of both halves of the frequency-offset 
model are isolation (EXF) and transmission tracking (ETF). EXF is set to 
zero because it is cannot be detected by the frequency change. ETF must 
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be divided into two types of errors: one associated with the stimulus side 
at the input frequencies and the other associated with the response side at 
the output frequencies. As previously discussed, calculating the 
transmission tracking (ETF) based on both stimulus and response sides is 
the key to using error correction during frequency-offset measurements. 

 
  

In scalar-mixer calibration, use the power meter to measure the 
transmission tracking error (ESTF) of the signal source in both the output 
and input frequencies in order to calculate the transmission tracking in the 
frequency-offset (ETF). The transmission tracking of the receiver in the 
output frequency (ERTF) can be determined by dividing the transmission 
tracking (ETF) calculated based on the output frequency in full 2-port 
calibration by the receiver's transmission tracking (ESTF). Multiplying the 
signal source transmission tracking (ESTF) by the receiver transmission 
tracking (ERTF) provides the transmission tracking in the frequency-offset 
(ETF). Since ESTF and ERTF are products of two power measurements, the 
resulting correction coefficient is a scalar parameter. 

Confirming Calibration Status 

Error correction status of each channel 
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You can confirm the progress of error correction for each channel by 
viewing the error calibration status. For the traces in which the scalar-
mixer is valid, the status [S2] is added. 

 
 In scalar-mixer calibration, the normal calibration 

coefficient is invalid while the frequency-offset sweep is in 
progress; in this case the scalar-mixer calibration coefficient is 
used instead. Turning the frequency-offset sweep off switches 
over to the normal calibration coefficient; however, the 
information on the scalar-mixer calibration coefficient is 
retained. 

Procedure Using Mechanical Calibration Kit 

1. Before starting scalar-mixer calibration, verify that the frequency-
offset is activated by clicking  Sweep Setup key > Frequency Offset. If 
the frequency-offset is not valid, you cannot start scalar-mixer 
calibration. 

2. Press Channel Next/Channel Prev keys to select the channel you want 
to calibrate. 

3. Press Cal key. 

4. Click Mixer/Converter Calibration > Scalar Cal (Manual) > Select Ports. 

5. Select the test port for starting scalar-mixer calibration. 
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 For the scalar-mixer calibration, only one direction 
with 2-ports calibration is available. "One direction" means the 
forward or reverse direction. Two directions may be used among 
the same ports, but this would not be full 2-port scalar-mixer 
calibration but simply the simultaneous operation of single-
direction scalar-mixer calibrations..   . 

Reflection 

Both x and y in the following steps are provided for the case where you 
have selected in the test port selection. 

6. Click Reflection. 

7. Connect the OPEN calibration standard to the test port x (connector 
for the DUT). 

8. Click Port x @Freq x Open to start measurement of the calibration 
standard. 

9. Click Port x @Freq y Open to start measurement of the calibration 
standard. 

10. Disconnect the OPEN calibration standard, then connect SHORT 
calibration standard in its place. 
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11. Click Port x@Freq x Short to start measurement of the calibration 
standard. 

12. Click Port x@Freq y Short to start measurement of the calibration 
standard. 

13. Disconnect the SHORT calibration standard, then connect LOAD 
calibration standard in its place. 

14. Click Port x@Freq x Load to start measurement of the calibration 
standard. 

15. Click Port x@Freq y Load to start measurement of the calibration 
standard. 

16. Repeat the procedure for port y. 

17. Click Return. 

Transmission 

18. Click Transmission. 

19. Connect a THRU between the test ports x and y (between the 
connectors for the DUT). 

20. Click Port y-x@Freq y Thru to start measurement of the 
calibration standard. 

21. Click Port x-y@Freq x Thru to start measurement of the 
calibration standard. 

22. Click Return. 

Power Meter 

23. Click Power Meter. See Preparing to control the power meter for 
setup the power meter. 

24. Click Use Sensor. Each time the key is pressed, Channels A and B 
switch over alternately. If you are using a one-channel power meter, 
select Channel A. 

25. Connect the power sensor for the selected channel to the 
selected port. 

26. Click Port x@Freq x. 

27. Click Port x@Freq y. 

28. Click Port y@Freq x. 

29. Click Port y@Freq y. 

30. Click Return. 

Error Correction Done 
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31. Click Done to exit the scalar-mixer calibration. This step allows 
the calibration coefficient to be calculated, turning on the error 
correction function automatically. 

Procedure Using ECal Kit 

1. Before starting scalar-mixer calibration, verify that the frequency-
offset is activated by clicking  Sweep Setup key > Frequency Offset. If 
the frequency-offset is not valid, you cannot start scalar-mixer 
calibration. 

2. Press Channel Next/Channel Prev keys to select the channel you want 
to calibrate. 

3. Press Cal key. 

4. Click Mixer/Converter Calibration > Scalar Cal (ECal) > Select Ports. 

5. Select the test port for starting scalar-mixer calibration. 

6. Click Power Meter. See Preparing to control the power meter for setup 
the power meter. 

7. Click Use Sensor. Each time the key is pressed, Channels A and B 
switch over alternately. If you are using a one-channel power meter, 
select Channel A. 

8. Connect the power sensor for the selected channel to the selected 
port. 

9. Click Port x@Freq x. 

10. Click Port x@Freq y. 

11. Click Port y@Freq x. 

12. Click Port y@Freq y. 

13. Click Return. 

14. Connect the test port you selected to the ECal module. 
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15. Click ECal & Done. The calibration coefficient will be calculated, 
turning on the error correction function automatically. 

 If the ECal module is not connected to the E5071C or 
power calibration have not been done yet, the ECal & Done 
menu item will not be not available. In addition, if the ECal 
module is not connected to the test port of the calibration 
target, an error may occur. 
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Vector-Mixer Calibration 

 Overview 

 Characterizing Calibration Mixer (with IF filter) 

 Executing Characterization of Calibration Mixer 

 Characterizing Calibration Mixer (with IF filter) for Balance Mixer 
Measurement 

 Executing Characterization 

Other topics about Mixer Calibration 
Overview of Vector-Mixer Calibration 

The E5071C has a vector-mixer calibration function for use in measuring 
frequency conversion devices. 

The vector-mixer calibration allows you to measure the magnitude, phase 
and group delay of the mixer's conversion loss by using in combination 
calibration standards (OPEN/SHORT/LOAD) and calibration mixer with an 
IF filter, as well as the network de-embedding function incorporated in the 
E5071C. 

 For Fixed RF measurement (RF: Fixed, LO and IF: Swept), it is 
NOT possible to perform vector-mixer calibration because touchstone 
file, which defined with fixed frequency, can not be imported to ENA. 

 For Fixed IF measurement (RF and LO: Swept, IF: Fixed), it is 
possible to perform vector-mixer calibration and to measure conversion 
loss and return loss, but NOT possible to measure group delay because 
IF frequency is fixed. 

 For Swept IF measurement (RF and IF: Swept, LO: Fixed), it is 
possible to perform vector-mixer calibration and to measure conversion 
loss, return loss and group delay. 

You can also perform balanced mixer measurements by using two 
calibration mixers that each has an IF filter. 

Vector-mixer calibration is implemented by eliminating the characteristics 
of the calibration mixer and IF filter by using the network de-embedding 
function after full 2-port calibration has been completed. Using the 
up/down conversion method allows you to specify the same sweep 
measurement frequency for the input and output ports, thus enabling full 
2-port calibration at the end of the target port. Consequently, only the 
characteristics of the measured mixer (DUT) can be obtained by using the 
network de-embedding function, after eliminating the characteristics of the 
calibration mixer with an IF filter from all measurement results. 
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 Since the up/down conversion method is used in 
vector-mixer calibration, the frequency-offset function is not 
used. But, option 008 is required to use the VMC macro, SG 
control, and etc. 

Overview of Vector-Mixer Calibration 

 
The vector-mixer calibration requires the characteristics data for the 
calibration mixer with IF filter. 

Measured mixer 

A measured mixer (DUT) signifies an unknown target mixer of 
measurement. However, a measured mixer meeting the requirements for a 
calibration mixer can be used as a calibration mixer. 

Calibration mixer (with IF filter) 

The calibration mixer is required for supporting the measurement system 
of the up/down conversion. You must also evaluate in advance the 
frequency response characteristics of the calibration mixer. The vector-
mixer calibration method obtains the characteristics of the measured mixer 
alone by using the network de-embedding function to eliminate the 
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characteristics of the calibration mixer from the measurement result. You 
can use the IF filter to select any required frequency conversion 
component such as RF+LO, RF-LO, and LO-RF. The calibration mixer and 
IF filter can be seen as a part of the test system setup, just like the 
network analyzer and the test cable; they are connected at the same 
location during the entire calibration or measurement. 

 The frequency range must be equal to or greater 
than that of the measured mixer. If you want to test multiple 
mixers with a single setup, select a wide range of calibration 
mixers that can cover all frequencies of the target test devices. 

Characterizing Calibration Mixer (with IF filter) 

In vector-mixer calibration, you must characterize the calibration mixer 
with the IF filter. As shown in the following figure, connect the target mixer 
(with IF filter) to the port of the network analyzer on which vector 
calibration has been performed and then connect an OPEN, SHORT or 
LOAD standard to the end of the IF filter to start reflection measurement. 
The signals measured at the test port include the reflection signal from the 
mixer's RF port, the IF signal (IF+) converted by the mixer and then 
reflected by the IF filter, and the IF signal (IF-) passing through the IF filer 
and then reflected by the calibration standard. 

The characteristics of the calibration mixer can be described in a 1-port 
error model, and each error item can be determined from ΓO, ΓS, and ΓL, 
which are obtained in the reflection measurement of individual standards. 

 Characteristics evaluation of calibration mixer (with IF filter) 
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 The calibration mixer must be reciprocal. The term 
"reciprocal" means the magnitude and phase of the conversion 
loss are equal both in the forward and reverse directions. The 
forward conversion loss occurs during the measurement of the 
output signal at the IF port while inputting measurement signals 
into the RF port. In contrast, the reverse conversion loss occurs 
during measurement of the output signal at the RF port while 
inputting measurement signals into the IF port. 

 For precise calibration, the conversion loss in each 
direction must be less than 10 dB using a calibration mixer and 
IF filter in combination. Exceeding 15 dB of the conversion loss 
in any direction may deteriorate the calibration accuracy 
significantly. 

Characterizing procedure for calibration mixer (with IF filter) 

The E5071C has a pre-installed VBA macro (Vector Mixer Characterization) 
for characterizing the calibration mixer with an IF filter. 

Storage Folder VBA Macro (Project Name) 

D:\Agilent MixerCharacterization.vba 
Executing Characterization of Calibration Mixer 

1. Setting Stimulus Conditions  

Set the stimulus conditions for the channel you want to calibrate. For the 
necessary steps, refer to Setting Stimulus Conditions. 
You must also set the external signal source in advance. For the necessary 
steps, refer to Setting External Signal Source. 

2. Running VBA Macro 

 Full 2-port calibration is recommended for 
characterizing the calibration mixer with the IF filter, although 
1-port calibration is also available. This is because using full 2-
port calibration simplifies the evaluation procedures, which are 
described in Overview of vector-mixer calibration . For detailed 
information on full 2-port calibration, see Full 2-Port Calibration. 

Load the VBA project and then run it. 

1. Press Macro Setup. 

2. Click Load & Project. 

3. Specify D:\Agilent\ MixerCharacterization.vba for the file name in the 
Open dialog box and then press the Open button. 
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4. Press Macro Run to run the macro. 

5. The following dialog appears. Click OK. 

 
When more than 1601 measurement points is set for 1 channel and 
4 traces, the E5071C VBA macro function may take more time to 
operate. 

Vector Mixer Characterization Macro 

 
3. Selecting Measurement Port 

Select the 1-port calibration port (1 in menu). 

 Select any port if full 2-port calibration is set. 

4. Setting IF Frequency 

Select IF frequency from RF+LO, RF-LO and LO-RF (2 in menu), depending 
on the IF frequency of the calibration mixer. 
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 The number displayed in the Vector Mixer 
Characterization macro is the frequency set in the E5071C and 
read from it. You must also set the minimum IF frequency at 
more than 0 kHz. 
IF BW must be set to much smaller value than IF frequency. 

5. Selecting a Calibration Kit 

Select a calibration kit (3 in menu). 

 The mechanical calibration kit displayed in the Vector 
Mixer Characterization macro is the frequency registered in the 
E5071C and read from it. If an ECal module is connected to the 
E5071C, ECal will be selected automatically. 

6. Measuring Calibration Mixer with IF Filter (when using calibration kit) 

Connect the calibration mixer to one of the test ports on which 1-port 
calibration has been done, as shown in the following figure. 

Connection of calibration mixer (with IF filter) 

 
  Select any port if full 2-port calibration is set. 
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 We recommend that you characterize the calibration 
mixer with an IF filter when the power splitter for distributing 
the LO signal is connected to the measured mixer. In vector-
mixer calibration, where the up/down conversion method is 
used, the power of the LO signal is distributed to the calibration 
mixer and the measured mixer through the power splitter. 
During a characteristics evaluation of the calibration mixer, the 
LO power level used by the drive of the calibration mixer must 
be equal to the LO power level with the measured mixer 
connected. This is because the mixer's conversion loss and 
reflection coefficient are significantly affected by the power level 
of the LO signal. 

1. Select CalKit (3 in menu). 

2. Select the type number of the calibration kit from CalKit menu (4 in 
menu). 

3. Click the Open button (5 in menu) to start measurement in OPEN. 

4. Click the Short button (6 in menu) to start measurement in SHORT. 

5. Click the Load button (7 in menu) to start measurement in LOAD. 

7. Measuring Calibration Mixer with IF Filter (when using ECal module) 

Characterizing calibration mixer using ECal 

 
1. Select ECal (1 in menu). 

2. Select the port used for the ECal module (2 in menu). 
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3. Click the Measure button (3 in menu) to start measurement. 

8. Saving Characteristic Data and Closing VBA Macro 

1. Press the Save button (8 in menu) to open the Save screen. 

2. Press the Save button to specify a name for the characteristic data of 
the calibration mixer with IF filter. Then save it to a Touchstone file. 
 If you check the Setup Option (9 in menu), the saved characteristic 
data will be set for the specified port of the active channel as the 
characteristic data file of the network de-embedding, and the fixture 
simulator function will be enabled. If unchecked, only the 
characteristic data will be saved. 

3. Click the Close button (10 in menu) to exit the macro. 
Characterizing Calibration Mixer (with IF filter) for Balance Mixer Measurement 

The VBA macro (Vector Mixer Characterization) provided with the E5071C 
allows you to characterize the calibration mixer (with IF filter) to be used 
for the balanced mixer measurement. The characterizing procedures of the 
calibration mixer with IF filter used for balance mixer measurement are 
basically the same as those used for normal mixer measurement; however, 
two characteristic data of the calibration mixer with IF filter are required 
for balanced mixer measurement, as shown in the following figure. 

Connect the target calibration mixer (with IF filter) to the port of the 
network analyzer on which calibration has been performed and then 
connect the OPEN, SHORT and LOAD standards to the end of the IF filter to 
start reflection measurement and characterization. For a balanced mixers, 
the phase difference of the LO signals between the calibration mixers with 
IF filter will remain as an error, since each calibration mixer with IF filter is 
characterized independently. Therefore, you must calibrate the phase 
difference between the two characterized calibration mixers with IF filters. 

Characteristics evaluation of calibration mixer (with IF filter) for 
balance mixer 
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 We recommend that you use the same products of 

calibration mixers, IF filters and cables between the balanced 
ports to which each calibration mixer (with IF filter) is 
connected. 
You should keep the following electrical lengths the same 
between the two ports to which the calibration mixer is 
connected as much as possible - the electrical length from the 
external signal source output port (a) to the extended 
calibration plane (b), and the electrical length from the 
calibration plane (c) to the extended calibration plane (b). Large 
electrical length differences between the two ports to which the 
calibration mixer is connected could raise 180 degrees phase 
value error between the two IF ports even though the Balanced 
Mixer Calibration Macro is executed. You can verify it by 
swapping the IF cable connections with each other. 

Executing Characterization 
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1. Characterizing Calibration Mixer (with IF filter) 

Measure the characteristic data of each calibration mixer with the IF filter 
used for balanced mixer measurement, using any two ports. 

Set the stimulus conditions for the channel you want to calibrate. For the 
necessary steps, refer to Setting Stimulus Conditions. 
You must also set the external signal source in advance. For the necessary 
steps, refer to Setting External Signal Source. 

 If you characterize a calibration mixer with an IF 
filter, we recommend that you perform full 4-port calibration in 
advance, since it simplifies the evaluation procedures. For 
detailed information on full 4-port calibration, see Full 4-Port 
Calibration. 

1. Press Macro Setup key. 

2. Click Load & Project. 

3. Specify "D:\ Agilent\ MixerCharacterization.vba" for the file name in the 
Open dialog box and then press the Open button. 

4. Press Macro Run to run the macro. 

5. Select Port 1 (1 in menu) to characterize the calibration mixer 1 with 
IF filter. In this case, the data are saved to a temporary file 
(MIXER_1.s2p). 

6.  Select Port 2 (1 in menu) to characterize calibration mixer 2 with IF 
filter. Here, the data are also saved to a temporary file 
(MIXER_2.s2p). 

 For detailed information on characterizing the 
calibration mixer, see Characterizing procedure for 
calibration mixer (with IF filter). 

7. Click (Optional) Balanced Mixer (2 in menu). 

Vector Mixer Characterization Macro 
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8. As the Vector Mixer Characterization Macro is running, the data files 

of the pre-measured calibration mixer with IF filter (MIXER_1.s2p, 
MIXER_2.s2p) are read automatically into the macro (1 in menu). 

 If failure occurs when reading the data file for the 
calibration mixer with IF filter, the characterization may have 
done by using only one port instead of using two ports. 

Balanced Mixer Characterization Macro 

 
1. Select the measurement port (2 in menu) and then connect a THRU 

between the IF ports of the calibration mixers to correct the phase 
difference of the LO signals for the calibration mixers with IF filters. 
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2. Pressing the Execute (3 in menu) button executes a phase error 
correction and overwrites the results on the original data file. 

 You cannot run the Execute function when selecting 
the measurement port if the data file of the calibration mixer 
with IF filter (*.s2p) has not been set for the network removal 
function of the fixture simulator. 

 The phase error correction data reflects the phase 
difference of the LO signals for the phase information of the 
calibration mixer's data file, which is registered in any two 
ports. 

3.  Press the Close button (4 in menu) to exit macro. 
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TRL Calibration 
2-port TRL Calibration 

 Overview 

 Procedure 

Other topics about TRL Calibration 
Overview 

The 2-port TRL calibration function lets you measure calibration data by 
connecting thru, reflection (open or short), line, or match calibration 
standards to (between) 2 desired test ports. This calibration provides the 
most accurate measurement for non-coaxial parts, using 12 error terms 
model in total for calibration in the same way as full 2-port calibration. 

Before executing TRL calibration, you need to modify the calibration kit 
definition you use (or create a new one). For more information, see 
Changing the Calibration Kit Definition. 

Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to perform the calibration. 

2. Press Cal key. 

3. Click Calibrate > 2-Port TRL Cal. 

4. Click Select Ports, then select the test ports for which you want to 
execute TRL 2-port calibration. (In the following procedure, test 
ports you select here are expressed as test ports x and y.) 

5. Connect the port. 

Thru/Line 

1. Make a THRU or Line connection between ports x and y (between the 
connectors to which the DUT is to be connected). 

2. Click  Thru/Line. 

3. Click Port x-y Thru to execute a Thru/Line measurement. 

4. Click Return. 

Reflection 

1. Click   Reflect 

2. Click Port x Reflect to execute a reflection calibration for test port x. 

3. Click Port y Reflect to execute a reflection calibration for test port y. 

4. Click Return. 
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Line/Match 

1. Click Line/Match. 

2. Click softkey to execute Line/Match calibration. 

Softkey Function 

x-y 
Line/Match 

Executes line/match calibration for test ports x and y. 
Use this to perform forward-direction measurement 
and reverse-direction measurement at the same time. 
This is equivalent to measuring both x-y Fwd (Syx) and 
x-y Rvs (Sxy). 

x-y Fwd 
(Syx) 

Executes line/match calibration for test ports x and y. 
Use this to perform forward-direction measurement 
only. 

x-y Rvs 
(Sxy) 

Executes line/match calibration for test ports x and y. 
Use this to perform reverse-direction measurement 
only. 

3.   

4. Click Return. 

5. Click Done to finish TRL 2-port calibration. At this point, the 
calibration coefficient is calculated and saved. The error correction 
function is automatically turned on. 
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3-port TRL Calibration 

 Overview 

 Procedure 

Other topics about TRL Calibration 
Overview 

The 3-port TRL calibration function lets you measure calibration data by 
connecting thru, reflection (open or short), line, or match calibration 
standards to (between) 3 desired test ports. This calibration provides the 
most accurate measurement for non-coaxial parts, using 27 error terms 
model in total for calibration in the same way as full 3-port calibration. 

Before executing TRL calibration, you need to modify the calibration kit 
definition you use (or create a new one). For more information, see 
Changing the Calibration Kit Definition. 

Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to execute calibration. 

2. Press Cal key. 

3. Click Calibrate > 3-Port TRL Cal > Select Ports. 

4. Select test ports for which you want to execute TRL 3-port 
calibration. (In the following procedure, test ports you select here 
are expressed as test ports x, y, and z.) 

5. Click Thru/Line to start the measurement of the calibration standard. 

6.  Click Reflect to start the measurement of the calibration standard. 

7.  Click Line/Match to start the measurement of the calibration 
standard. 
  

Softkey Function 

x-y 
Line/Match 

Executes line/match calibration for test ports x and y. Use this 
to perform forward-direction measurement and reverse-
direction measurement at the same time. 

x-y Fwd 
(Syx) 

Executes line/match calibration for test ports x and y. Use this 
to perform forward-direction measurement only. 

x-y Rvs 
(Sxy) 

Executes line/match calibration for test ports x and y. Use this 
to perform reverse-direction measurement only. 

x-z 
Line/Match 

Executes line/match calibration for test ports x and z. Use this 
to perform forward-direction measurement and reverse-
direction measurement at the same time. 
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x-z Fwd 
(Szx) 

Executes line/match calibration for test ports x and z. Use this 
to perform forward-direction measurement only. 

x-z Rvs (Sxz) Executes line/match calibration for test ports x and z. Use this 
to perform reverse-direction measurement only. 

y-z 
Line/Match 

Executes line/match calibration for test ports y and z. Use this 
to perform forward-direction measurement and reverse-
direction measurement at the same time. 

y-z Fwd 
(Szy) 

Executes line/match calibration for test ports y and z. Use this 
to perform forward-direction measurement only. 

y-z Rvs (Syz) Executes line/match calibration for test ports y and z. Use this 
to perform reverse-direction measurement only. 

8. Click Done to finish TRL 3-port calibration. At this point, the 
calibration coefficient is calculated and saved. The error correction 
function is automatically turned on. 
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4-port TRL Calibration 

 Overview 

 Procedure 

Other topics about TRL Calibration 
Overview 

The 4-port TRL calibration function lets you measure calibration data by 
connecting thru, reflection (open or short), line, or match calibration 
standards to (between) 4 test ports. This calibration provides the most 
accurate measurement for non-coaxial parts, using 48 error terms model 
in total for calibration in the same way as full 4-port calibration. 

Before executing TRL calibration, you need to modify the calibration kit 
definition you use (or create a new one). For more information, see 
Changing the Calibration Kit Definition. 

Procedure 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to execute calibration. 

2. Press Cal key. 

3. Click Calibrate > 4-Port TRL Cal > Select Ports. 

4. Click Thru/Line to start the measurement of the calibration standard. 

5. Click Reflect to start the measurement of the calibration standard. 
  

Softkey Function 

Port 1 Reflect Executes reflection calibration for test port 1. 

Port 2 Reflect Executes reflection calibration for test port 2. 

Port 3 Reflect Executes reflection calibration for test port 3. 

Port 4 Reflect Executes reflection calibration for test port 4. 

6. Click Line/Match to start the measurement of the calibration 
standard.  

Softkey Function 

1-2 
Line/Match 

Executes line/match calibration for test ports 1 and 2.Use this to 
perform forward-direction measurement and reverse-direction 
measurement at the same time. 

1-2 Fwd 
(S21) 

Executes line/match calibration for test ports 1 and 2.Use this to 
perform forward-direction measurement only. 
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1-2 Rvs 
(S12) 

Executes line/match calibration for test ports 1 and 2.Use this to 
perform reverse-direction measurement only. 

1-3 
Line/Match 

Executes line/match calibration for test ports 1 and 3.Use this to 
perform forward-direction measurement and reverse-direction 
measurement at the same time. 

1-3 Fwd 
(S31) 

Executes line/match calibration for test ports 1 and 3.Use this to 
perform forward-direction measurement only. 

1-3 Rvs 
(S13) 

Executes line/match calibration for test ports 1 and 3.Use this to 
perform reverse-direction measurement only. 

1-4 
Line/Match 

Executes line/match calibration for test ports 1 and 4.Use this to 
perform forward-direction measurement and reverse-direction 
measurement at the same time. 

1-4 Fwd 
(S41) 

Executes line/match calibration for test ports 1 and 4.Use this to 
perform forward-direction measurement only. 

1-4 Rvs 
(S14) 

Executes line/match calibration for test ports 1 and 4.Use this to 
perform reverse-direction measurement only. 

2-3 
Line/Match 

Executes line/match calibration for test ports 2 and 3.Use this to 
perform forward-direction measurement and reverse-direction 
measurement at the same time. 

2-3 Fwd 
(S32) 

Executes line/match calibration for test ports 2 and 3.Use this to 
perform forward-direction measurement only. 

2-3 Rvs 
(S23) 

Executes line/match calibration for test ports 2 and 3.Use this to 
perform reverse-direction measurement only. 

2-4 
Line/Match 

Executes line/match calibration for test ports 2 and 4.Use this to 
perform forward-direction measurement and reverse-direction 
measurement at the same time. 

2-4 Fwd 
(S42) 

Executes line/match calibration for test ports 2 and 4.Use this to 
perform forward-direction measurement only. 

2-4 Rvs 
(S24) 

Executes line/match calibration for test ports 2 and 4.Use this to 
perform reverse-direction measurement only. 

3-4 
Line/Match 

Executes line/match calibration for test ports 3 and 4. Use this to 
perform forward-direction measurement and reverse-direction 
measurement at the same time. 

3-4 Fwd 
(S43) 

Executes line/match calibration for test ports 3 and 4. Use this to 
perform forward-direction measurement only. 

3-4 Rvs 
(S34) 

Executes line/match calibration for test ports 3 and 4. Use this to 
perform reverse-direction measurement only. 
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7. Press Done to finish TRL 4-port calibration. At this point, the 
calibration coefficient is calculated and saved. The error correction 
function is automatically turned on. 
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Making Measurements 

Making Measurements 

 Setting Up Trigger and Making Measurements 

 Setting Point Trigger 

 Setting Low-Latency External Trigger Mode 

 Setting Averaging Trigger Function 

 Setting External Trigger Output 



E5071C 

268 

 

Setting Trigger and Making Measurements 

 Overview 

 Sweep Order in Each Channel 

 Trigger Source 

 Trigger Scope 

 Trigger Mode 

 Setup Procedure for Trigger 

Other topics about Making Measurement 

Overview 

The E5071C has one trigger source. When this trigger source detects a 
trigger signal that has occurred, a sweep is performed for channels in the 
"Initiate" state in the order of channel 1 to channel 36. You set the 
"Initiate" or "Idle" status of each channel by changing the trigger mode. 

 The execution of measurement for each channel 
does not depend on whether the channel is displayed. Channels 
that have been activated can be measured even if they are not 
displayed. 

 For each channel, a sweep is performed only for the 
stimulus ports needed to update the parameters of the 
displayed trace. 

Sweep Order in Each Channel 

In a channel, each test port is set to a stimulus port in the order of port 
number and updates each trace. 

Sweep Order Stimulus Port Updated Trace 

1 Port 1 S11, S21, S31, S41 

2 Port 2 S12, S22, S32, S42 

3 Port 3 S13, S23, S33, S43 

4 Port 4 S14, S24, S34, S44 

 If full 2, 3, or 4-port error correction is in effect, no 
trace between calibrated ports is updated until the last 
calibrated port is swept as the stimulus port. 

 Sweep is not executed for stimulus ports that are not 
required for updating traces. 
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Trigger Source 

The trigger source generates a cue signal that initiates a measurement 
process. Four types of trigger sources are available. 

Trigger 
Sources 

Function 

Internal 
(Internal) 

Uses a consecutive signal generated by the firmware as a trigger 
source. Triggers are sent immediately following the completion of 
each measurement. 

External 
(External) 

Uses the external trigger input terminal (BNC) or Handler I/O (Pin No. 
18)  as a trigger source. 

Manual 
(Manual) 

A trigger is generated by pressing Trigger > Trigger. 

Bus (Bus) A trigger is generated through GPIB/LAN/USB. 

Trigger Scope 

The Trigger Scope specifies the scope of the triggering, whether it is for all 
channels (default) or for the selected channel. 

When this function is enabled with a value of "ACTive", only active channel 
is triggered. When this function is enabled with a value of "ALL", all 
channels of the E5071C are triggered. 

For example, if Trigger Scope is set to "ACTive" when Trigger > Continuous 
 is selected for all channels, a measurement channel is automatically 
changed by switching over the active channel. 

  

Trigger Scope Function 

All Channel Triggers ALL channels which are in "Initiate" status 

Active Channel Triggers Active channel which is in "Initiate" status 

Trigger Mode 

You can set the trigger mode for each channel independently. This allows 
you to control the operation of each channel after a trigger signal is 
detected by setting the channel's status with the trigger mode. 

Trigger mode 
name 

Function 

Sweep stop 
(Hold) 

The status ("Idle" status) in which the sweep is stopped. When a 
trigger signal is detected, the sweep is not performed. 

Single sweep An "Initiate" status. When a trigger signal is detected, a sweep is 
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(Single) performed. After completion of the sweep, the "Idle" status is 
activated. 

Continuous 
sweep 
(Continuous) 

An "Initiate" status. When a trigger signal is detected, a sweep is 
performed. After completion of the sweep, the "Initiate" status is 
maintained. The sweep is repeated each time a trigger signal is 
detected. 

Hold All Channels Sets all channel trigger modes to hold sweep mode 

Continuous Disp 
Channels 

Sets trigger modes of all displayed channels (Display > Allocate 
Channels) to continuous sweep mode 

Setup Procedure For Trigger 
1. Selecting a Trigger Source 

Follow the procedure below to select a trigger source. 

1. Press Trigger. 

2. Click Trigger Source. 

3. Click the softkey that corresponds to the desired trigger source. 

4. When External is selected as a trigger source, click Ext Trig Input to 
select trigger polarity. 

Softkey Function 

Negative Edge Triggered at negative edge of an external trigger input signal. 

Positive Edge Triggered at positive edge of an external trigger input signal. 

5. The setting for trigger polarity is not valid for the external 
trigger from Hander I/O. 

2. Selecting a Trigger Scope 

Follow the procedure below to select a trigger mode. 

1. Press Trigger key. 

2. Click Trigger Scope. 

3. Click the softkey that corresponds to the desired trigger scope: 
  

Trigger Scope Function 

All Channel Triggers ALL channels 

Active Channel Triggers Active channel alone. 

3. Selecting a Trigger Mode 

Follow the procedure below to select a trigger mode. 
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1. Press Channel Next/Channel Prev keys to  select the channel for which 
the trigger mode will be set. 

2. Press Trigger key. 

3. Press the softkey that corresponds to the desired trigger mode. 
Repeat the procedure until each channel is set for its trigger mode. 
  

Softkey Function 

Hold Sets active channel trigger mode to hold sweep mode 

Single Sets active channel trigger mode to single sweep mode 

Continuous Sets active channel trigger mode to continuous sweep mode 

Hold All 
Channels 

Sets all channel trigger modes to hold sweep mode 

Continuous 
Disp Channels 

Sets trigger modes of all displayed channels (Display > 
Allocate Channels) to continuous sweep mode 

4. Generating the Trigger 

Next, it is necessary to generate a trigger by using the trigger source 
selected in Selecting a Trigger Source. 

 Once the internal trigger source is selected, a series 
of triggers is continuously generated as soon as the setting 
becomes effective. 

 Pressing Trigger > Restart during a sweep forces the 
analyzer to abort the sweep. 
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Setting Point Trigger 

 Overview 

 Setting Point Trigger 

Other topics about Making Measurement 

Overview 

The point trigger provides a point measurement at every trigger, and it can 
be used to change the trigger event to point trigger mode. 

Trigger event 
name 

Function 

On Point (On) Point measurement is performed when trigger is applied. 

On Sweep (Off) Measurement is performed for all measurement points when 
trigger is applied. 

 When the trigger source is selected as the internal 
trigger, the point trigger does not work. 

Setting Point Trigger 

1. Press Trigger key. 

2. Click Trigger Event. 

3. Click the softkey that corresponds to the desired trigger event. 

Softkey Function 

On Point Measures at each measurement point 

On Sweep Measures all measurement points 
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Setting Low-Latency External Trigger Mode 

 Overview 

 Setting Low-Latency External Trigger 

 External Trigger Delay Time and Point Trigger Interval 

Other topics about Making Measurement 

Overview 

In the low-latency external trigger mode, variations in delay time between 
the reception of a trigger and the start of a one-point measurement are 
decreased for point trigger measurement by using trigger pulses supplied 
to the external trigger input terminal. In addition, using this mode will 
allow you to decrease the variations in the time required to be ready for 
the next measurement trigger after execution of a one-point 
measurement. This mode allows you to perform continuous point trigger 
measurement in sync with external trigger pulses and accurately set a 
trigger delay time at each point-trigger point. 

 The time required for measurement at each 
measurement point varies depending on the settings of the 
E5071C and the type of measurement. For more information, 
see External trigger delay time and point trigger interval. 

The low-latency external trigger mode becomes available by turning on the 
point trigger function and setting the trigger source to "External." 

Low-latency external 
trigger mode 

Function 

ON Sets the low-latency external trigger mode to ON. The 
external trigger delay time becomes valid. 

OFF Sets the low-latency external trigger mode to OFF. 

 If the trigger source is not the external trigger, the 
low-latency external trigger mode does not work if it is specified 
to ON. 

 The setting of the low-latency external trigger mode 
is valid for all channels. 

Setting Low-Latency External Trigger 
1. Setting the low-latency external trigger 

If the trigger source is set to "External" and the trigger event to "On" (On 
Point), set the low-latency external trigger mode. 

1. Press Trigger key. 
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2. Click Low Latency. 

3. Click ON to activate the-low latency external trigger mode. 
2. Setting the external trigger delay time 

Set the external trigger delay time at each point. The setting resolution is 
10 µs. 

1. Press Trigger key. 

2. Click Trig Delay. 

3. Enter an external trigger delay time. 

External Trigger Delay Time and Point Trigger Interval 

External trigger pulses, supplied until the next measurement becomes 
ready after the start of a one-point measurement, are ignored, and the 
next trigger is generated by a pulse supplied after the completion of the 
one-point measurement. 

The time until the next trigger can be accepted after the start of a one-
point measurement depends on the IFBW and other settings of the 
analyzer. For example, in the case of a frequency's zero-span 
measurement, the time until the next measurement is ready after the start 
of a one-point measurement is obtained by dividing the time required for a 
single sweep in On Sweep mode, instead of On Point mode, by the number 
of measurement points. If you use the point trigger function with external 
trigger pulses that are wider than this time, point trigger measurement is 
performed at each pulse input. 

The figure below shows the timing chart of an external trigger when the 
point trigger function is on. 

Timing chart of external trigger (trigger event = on, trigger source 
= external, low-latency external trigger mode = on) 
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The table below describes signals and time as shown in the above figure. 

Signal, 
time 

Description 

External 
Trig 

External trigger signal to be supplied. 

Sampling Time while the E5071C is actually performing measurement. 

Index /Index signal of the handler I/O port. When the point trigger function is 
ON and the low-latency external trigger mode is ON, it goes to the High 
level only before staring measurement of the first sweep point and 
returns to the Low level after completing measurement of all 
measurement points. 

Point 
Trigger 
Period 

Time until the E5071C is ready to accept a trigger for the next 
measurement point. The value depends on the measurement conditions 
and the settings of the E5071C. 

td1 Time set as the external trigger delay time. 

td2 Time that the E5071C requires internally for setting. This depends on 
the settling time for setting the frequency, IF frequency band, and so 
on. For zero-span measurement, td2 = 13±1 µs  (Typ.). 
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Setting Averaging Trigger Function 

 Overview 

 Averaging Trigger Function 

Other topics about Making Measurement 

Overview 

The averaging trigger function is used to execute the sweep the number of 
times specified by the averaging factor with a single trigger when the 
sweep averaging function is ON. 

Averaging 
Trigger 

Function 

ON Performs the sweep the number of times specified by the 
averaging factor with a single trigger. 

OFF Performs the sweep once with a single trigger. 

The averaging factor is cleared before the start of measurement. 

 When the point trigger function is on, its setting has priority, 
and you need to generate triggers based on "(number of measurement 
points)× (averaging factor)". 

 When the sweep averaging function is off, sweep is performed 
only once even if the averaging trigger function is set to on. 

 The averaging trigger function is valid for all channels. Note that 
you can set the sweep averaging function for each channel. 

Averaging Trigger Function 
1. Setting Averaging Trigger Function 

When the sweep averaging function is ON, follow these steps to set the 
averaging trigger function. 

1. Press Avg key. 

2. Click Avg Trigger. 

3. Click ON to activate the averaging trigger. 
2. Executing Averaging Measurement 

1. Press Trigger key. 

2. Click Single. The averaging factor is cleared before the start of 
measurement, the sweep is executed the number of times specified 
by the averaging factor, and then the instrument waits for the next 
trigger. 
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Setting External Trigger Output 

 Overview 

 Setting External Trigger Output 

Other topics about Making Measurement 

Overview 

The External Trigger Output port (located at the rear panel) can be used to 
provide trigger to an external device. This is useful in cases where an 
external device needs to be triggered through the E5071C. 

Setting External Trigger Output 

1. Press Trigger key, and then set the value of Ext Trig Output (1) as 
ON.  
 

 
2. Click Polarity, and then select Positive Pulse or Negative Pulse (2). 

  

Polarity Property Description 

Positive Pulse Generates a Positive Pulse as a trigger. 

Negative Pulse Generates a Negative Pulse as a trigger. 

3. Click Position, and then select After Point or Before Point (3). 
  

Position 
Property 

Description 

After Point Generates a Pulse (trigger) after the 
measurement points. 

Before Point Generates a Pulse (trigger) before the 
measurement points. 

Difference between After and Before Point Settings 
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External trigger output function displays the difference result by setting the 
Point trigger as follows: 

 
   

After Point:Pulse is generated after every measurement point. 

Before Point:Pulse is generated before first measurement point. Rest of 
pulse are same timing as After Point. Number of pulse is same as number 
of measurement point. 

   

 
After Point:Pulse is generated after every measurement point. 

Before Point:Pulse is generated before every measurement point. 



Measurement 

279 

Data Analysis 

Data Analysis 

 Analyzing Data on the Trace Using the Marker 

 Searching for Positions that Match Specified Criteria 

 Determining the Bandwidth of the Trace (Bandwidth Search) 

 Determining the Bandwidth of the Trace (Notch Search) 

 Determining the Mean, Standard Deviation, and p-p of the Trace 

 Comparing Traces/Performing Data Math 

 Performing Parameter Conversion of Measurement Results 

 Holding Max/Min Points for the Trace 

 Limit Test 

 Ripple Test 

 Bandwidth Test 

 Point Limit 

 Equation Editor 
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Analyzing Data on the Trace Using the Marker 

 About Marker Functions 

 Reading Marker Values on Trace 

 Reading Relative Value from Reference Point on Trace 

 Reading Actual Measurement Point/Value Interpolated between 
Measurement Points 

 Setting up Markers for Each Trace/Setting up Markers for Coupled 
Operation between Traces 

 Listing Marker Values in All Displayed Channels 

 Specifying Display Position of Marker Values 

 Aligning Marker Value Display 

 Displaying All Marker Values for Displayed Traces 

Other topics about Data Analysis 

About Marker Functions 

The marker can be used in the following ways: 

 Reading a measured value as numerical data (as an absolute value 
or a relative value from the reference point) 

 Moving the marker to a specific point on the trace (marker search) 

 Analyzing trace data to determine a specific parameter 

 Using the value of the marker to change the stimulus (sweep range) 
and scale (value of the reference line) 

For the procedure used to change the sweep range and scale by using the 
marker, refer to Setting the Sweep Range Using the Marker and Setting the 
value of a reference line using the marker. 

The E5071C is capable of displaying up to 10 markers including the 
reference marker on each trace. Each marker has a stimulus value (the 
value on the X-axis in rectangular display format) and a response value (the 
value on the Y-axis in rectangular display format). The Smith chart and polar 
formats each have two marker response values (log amplitude and phase). 

  

Reading Marker Values on Trace 

You can read the value of a marker displayed on the trace. 

In rectangular display format, the marker response value is always in the 
same data format as that of the Y-axis. On the contrary, one format for the 
marker response values (two values: main and auxiliary) can be selected 
from among several types. The selection is performed in the data format. 
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Softkey for selecting data format 

Marker response value 

Main Auxiliary 

Smith - Lin / Phase Linear amplitude Phase 

Smith - Log / Phase Log amplitude Phase 

Smith - Real / Imag Real component Imaginary component 

Smith - R + jX Resistance Reactance 

Smith - G + jB Conductance Susceptance 

Polar - Lin / Phase Linear amplitude Phase 

Polar - Log / Phase Log amplitude Phase 

Polar - Real / Imag Real component Imaginary component 

For setting up data formats, refer to Selecting a Data Format. 
Activating the marker on the Trace 

1. Press Channel Next/Channel Prev keys to activate the channel on 
which a marker is used. 

2. Press Trace Next/Trace Prev to activate the trace on which a marker is 
used. 

3. Press Marker key. At this point, marker 1 is turned on and becomes 
active (you can operate the marker). When using marker 1, you can 
omit the next step. 

4. Select a marker and turn it on. The softkey used to turn on a marker 
is also used to activate that marker. 

Moving the marker 

1. Change the marker stimulus value. This operation enables you to 
move the marker to a point on the selected trace. 

2. Read the marker stimulus value and marker response value 
displayed in the upper-left part of the trace screen. 

Turning off the marker 

1. Press Marker key. 
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2. Click Clear Marker Menu and then click one of the options. 

 In the preset configuration, the marker settings on 
traces in a channel are coupled (Marker Couple is turned on). 
For marker coupling, refer to Setting up markers for each 
trace/Setting up markers for coupled operations between traces. 

  

Reading Relative Value from Reference Point on Trace 

You can convert the marker reading into a relative value from the reference 
point. 

 
Converting From a Reference Point to a Relative Value 

1. Activate the reference marker. 

2. Move the reference marker at the point to be used as the reference. 

3. Click Ref Marker Mode to turn on the reference mode. 

4. With the reference mode turned on, the stimulus values and 
response values are indicated in relative values referred to by the 
position of the reference marker. 

5. Activate your desired marker, then move it to your desired position. 

6. Pressing Marker and then clicking Ref Marker enables you to 
place the reference marker at the position of the currently 
active marker . The reference mode will then turn on 
automatically. 

Reading Actual Measurement Point/Value Interpolated between 
Measurement Points 

The point on the trace on which a marker can be placed differs depending on 
how the discrete marker mode is set up. 
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Value Description 

Turning on 
discrete 
mode 
(Discrete 
ON) 

A marker moves only between actual measurement points. When a 
specific marker stimulus value is specified as a numerical value, the 
marker is placed at the measurement point closest to the specified 
value. A marker that is placed between interpolated points with the 
discrete mode off automatically moves to the nearest measurement 
point when the discrete mode is turned on. 

Turning off 
discrete 
mode 
(Discrete 
OFF) 

The marker can move from one actual measurement point to another. 
Because it is interpolated, it can also move in the space between 
measurement points. 

 

  
Turning Discrete Mode On or Off 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev to 
activate the trace on which the discrete mode is set up. 

2. Press Marker Fctn key. 

3. Click Discrete to turn the discrete mode on or off. 
  

Setting up Markers for Each Trace/Setting up Markers for Coupled 
Operation between Traces 
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Makers can be set up and moved either in coupled operation for all traces in 
a channel or independently for each trace. 

 
  

Value Description 

Marker Couple is 
on 
(Coupling ON) 

Markers are set up and moved in coupled operation on all traces in a 
channel. 

Marker Couple is 
off 
(Coupling OFF) 

Markers are set up and moved independently for each trace. 

Turning Marker Coupling On or Off 

1. Press Channel Next/Channel Prev keys to activate the channel on 
which the marker couple will be set. 

2. Press Marker Fctn key. 

3. Click Couple to turn the marker coupling on or off. 

Listing all Marker Values in all Displayed Channels 

You can list all of the marker values in all of the displayed channels on the 
screen. 
Turning On the Marker Table Display 

1. Press Marker Fctn key. 

2. Click Marker Table to turn on the marker table display. 

The marker table appears in the lower part of the screen. 
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Specifying Display Position of Marker Values 

This section describes how to specify the marker value display position for 
each active trace. 
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Value Description 

Marker Info X 
Pos 

Specifies the horizontal display position by the width of the display area 
as a percentage. 

  

Marker Info Y 
Pos 

Specifies the vertical display position by the height of the display area 
as a percentage. 

  

Operational procedure 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set marker coupling. 

2. Press Marker Fctn key. 

3. Click Annotation Options. 

4. Click Marker Info X Pos to set the horizontal display position. 

5. Click Marker Info Y Pos to set the vertical display position. 

Aligning Marker Value Display 

This section describes how to align maker value displays. 
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Value Description 

On 
(Align ON) 

Displays marker values to align to the display position of trace 1. 

Off 
(Align OFF) 

Displays marker values in the display position defined for each trace. 

1. Press Marker Fctn key. 

2. Click Annotation Options. 

3. Click Align to toggle ON/OFF. 
  

Displaying All Marker Values for Displayed Traces 

This section describes how to display all marker values for displayed traces. 
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Value Description 

Displays all 
(Active Only OFF) 

Displays all marker values for displayed traces. 

Displays active markers 
(Active Only ON) 

Displays markers for the active trace only. 

1. Press Marker Fctn key. 

2. Click Annotation Options. 

3. Click Active Only to toggle ON/OFF. 



Measurement 

289 

 

Searching for Positions that Match Specified Criteria 

 Overview 

 Setting Search Range 

 Setting Multiple Range 

 Automatically Executing a Search (Search Tracking) 

 Searching for Maximum and Minimum Values 

 Searching for the target value (Target search) 

 Searching for the peak 

Other topics about Data Analysis 

Overview 

You can search for a position that matches your specified criteria by using 
the Marker Search feature. Marker Search allows you to search for a 
position that matches any of the following criteria. 

 Maximum value 

 Minimum value 

 Target (a point that has a target measurement value) 

 Target nearest to marker position 

 Target on left/right-hand side nearest to marker position 

 Multiple Target  (Searching all target points at one time) 

 Peak 

 Maximum peak (for a positive peak), minimum peak (for a 
negative peak) 

 Peak on left/right-hand side nearest to marker position 

 Multiple Peak (Searching all peak points at one time) 

Setting Search Range 

The Marker Search feature allows you to set part of the sweep range as the 
search target (Partial Search feature) as well as the entire search range. 
For the Partial Search feature, you can select whether to couple traces in 
the channel. The Marker Statistics value is calculated by using the search 
range.  

Procedure to Turn ON/OFF Trace Coupling within Search Range 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate the trace for which you want to set the search range. 

2. Press Marker Search key. 
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3. Click Search Range. 

4. Click Couple to toggle ON/OFF trace coupling within the search 
range. 

Procedure to Set Search Range 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate the trace for which you want to set the search range. 

2. Press Marker Search key. 

3. Click Search Range. 

4. Click Search Range to turn ON the Partial Search feature. 

5. Click Start, then enter the start value (lower limit) of the search 
range. 

6. Click Stop, then enter the stop value (upper limit) of the search 
range. 

Procedure to Show Statistics Value of the Search Range 

1. Set and define a search range as described above.   

2. Press Marker Fctn key. 

3. Click Statistics to turn ON. The statistics values are calculated and 
displayed on the screen. 

Setting Multiple Range 

The Multiple Range feature allows you to set up to 16 search range in a 
channel. You can select more than one marker in a search range. You can 
select to couple the search range among the traces in the channel.    

The Marker Statistics value is calculated by using the search range of the 
active marker. If no active marker is selected, by default the search range 
of marker 1 is used.  

Procedure to Place Multiple Markers within a Search Range (in Multiple Range)  

The below example shows how to place multiple markers within several 
search range on two traces. In this example, stimulus is set for two. Then, 
two multiple ranges are set and two markers are assigned to each search 
range as min and max. The effect of search range coupling and trace 
coupling on multiple range is also shown in this example.  

Setting up traces and stimulus 

1. Display > Num of Traces > 2. 

2. Display > Allocate Traces > . 

3. Start > 2.0000 GHz. 
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4. Stop > 8.0000 GHz. 

5. Scale > Autoscale All. 

Turning ON and setting up multiple range 

1. Select Trace 1. 

2. Press Marker Search key. 

3. Click Search Range > Search Range > ON to turn ON the partial 
search feature. 

4. Click Multiple Range > Multiple Range > ON to turn ON the multiple 
search range feature. 

5. Click Target Range and select within 1 to 16 which represents the 
search range number. In this example, select 1 which represents 
Search Range 1. 

6. Click Start, then enter 3.0000 GHz, the start value (lower limit) of the 
search range. 

7. Click Stop, then enter 4.5000 GHz, the stop value (upper limit) of the 
search range.  

8. Similarly, click Target Range > 2.  

9. Start > 5.0000 GHz.  

10. Stop > 6.5000 GHz.  

11. The search range is set for both, Trace 1 and Trace 2. Note that 
the search range is not displayed as no Marker is assigned to these 
search range. 

Assigning markers to search range 

1. Marker > Marker 1 to turn it ON.  

2. Marker Search > Search Range > Multiple Range > Target Range > 1 to 
activate search range 1.  

3. Similarly, turn ON Marker 2. 

4. Activate search range 1, by following Step 2.  

5. Note that now, search range 1 is displayed, and marker 1 and 
marker 2 are placed within search range 1. 

Moving markers to min or max 

1. Marker > Marker 1 to activate it.  

2. Marker Search > Max. Marker 1 is placed at the maximum point 
within search range 1. 
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3. Marker > Marker 2 to activate it.  

4. Marker Search > Min. Marker 2 is placed at the minimum point within 
search range 1. 

Using search range coupling and marker coupling in multiple search range 

1. Select Trace 2. 

2. By default, search range coupling is turned ON. Marker Search > 
Search Range > Couple > OFF to turn OFF search range coupling. 

3. Marker > Marker 3 to activate it.  

4. Activate search range 2.  

5. Note that Trace 1 displays search range 1 while Trace 2 displays 
search range 2. 

6. Marker Search > Max. Marker 3 is now placed at the maximum point 
within search range 2. Marker 3 at Trace 1 is in parallel with Marker 
3 at Trace 2. However, Trace 1 still displays search range 1 while 
Trace 2 displays search range 2. 

7. By default, marker coupling is turned ON. Marker Fctn > Couple > 
OFF to turn OFF marker coupling. 

8. Marker > Marker 4 to activate it. As marker coupling is turned OFF, 
marker 4 is activated for Trace 2 only. To learn more about marker 
coupling, refer to Setting up markers for each trace/Setting up 
markers for coupled operations between traces. 

9. Activate search range 2.  

10. Marker Search > Min. Marker 4 is now placed at the minimum 
point within search range 2. However, note that Marker 4 is not 
shown at Trace 1. 

Procedure to Show Statistics Value of the Active Search Range 

1. Click Search Range > Multiple Range > Target Range. 

2. Select the search range number which you want its statistics value to 
be calculated and shown on the screen.  

3. Press Marker Fctn key. 

4. Click Statistics to turn ON the display of statistics data.   

Automatically Executing a Search (Search Tracking) 

Search tracking is a function that sets a search to be repeated every time a 
sweep is done even if the execution key for the search (maximum, 
minimum, peak, and target) is not pressed. This function facilitates 
observation of measurement results such as the maximum value of traces 
(e.g., the insertion loss of a band pass filter). 
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Performing Search Tracking 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate the trace on which you want to set up search tracking. 

2. Press Marker Search key. 

3. Click Tracking and turn the search tracking function ON/OFF. 

Searching for Maximum and Minimum Values 

You can search for the maximum or minimum measured value on the trace 
and move a marker to that point. 

  

 
  

Search for maximum 
(Max) 

Move active marker to point on trace where measured 
value is greatest 

Search for minimum 
(Min) 

Move active marker to point on trace where measured 
value is lowest 

  

Procedure 

1. Activate the marker you are using to search for the maximum and 
minimum values. 

2. Press Marker Search key. 

3. Click the corresponding softkey to move the marker to the maximum 
or minimum measured value. 

 When the data format is in Smith chart or polar 
format, execute the search only for the main response value. 

Searching for the target value (target search) 
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The target search is a function that searches for a target that matches the 
pre-defined target value and transition type(s) (positive, negative, or both 
positive and negative) and then moves the marker to that target. 

Target and Transition Types 

A target is a point that has a specific measured value on the trace. Targets 
can be divided into the two groups shown below depending on their 
transition type. 

Transition type: 
Positive (Positive) 

When the value of the target is larger than the measured 
value that immediately precedes it (on the left side) 

Transition type: 
Negative (Negative) 

When the value of the target is smaller than the measured 
value that precedes immediately it (on the left side) 

  

 
Executing a Target Search 

The following three methods are available for executing the target search: 

Target search 
(Search Peak) 

The marker moves to the peak with maximum response value if the 
peak polarity is Positive or Both or to the peak with minimum 
response value if the peak polarity is Negative. 

Search left 
(Search Left) 

Executes the search from the current marker position to the smaller 
stimulus values and moves the marker to first target encountered. 

Search right 
(Search Right) 

Executes the search from the current marker position to the larger 
stimulus values and moves the marker to first target encountered. 
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Procedure 

1. Activate the marker you are using for the target search. 

2. Press Marker Search key. 

3. Click Target  > Target Value, then enter the target value. 

4. Click Target Transition, then select a transition type. 

5. Press the corresponding softkey to move the marker to the target. 

 When the data format is in Smith chart or polar 
format, execute the search for the main response value of the 
two marker response values. 

 Changing the settings of target value or transition 
type executes new search for multiple target. 

Searching all target points at one time (Multiple Target) 

The multi-target search is a function that searches for targets that match 
to pre-defined target value and transition type(s) (positive, negative, or 
both of positive and negative) and displays markers on the targets being 
searched. 

Depending on the number of detected targets, markers 1 through 9 are 
displayed from the start frequency. The reference marker is not affected. 

When the multi-target search is executed, search and tracking settings for 
markers 1 through 9 are ignored and the settings for the multi-target 
search are used.  

Procedure 
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1. Press Marker Search > Multi Target > Target Value, then enter the 
target value. 

2. Click Target Transition, then select a transition type. 

3. Click Search Multi Target to show the markers on the multiple target. 

4. Changing the settings of target value or transition type executes new 
search for multiple target. 

5. Press Marker > Clear Marker Menu > All OFF to clear all markers. 

 Search Range is applied for multiple target search, 
however Multiple Range is not applied. 

 Search tracking is valid for multiple peak search. 

Searching for the peak 

The peak search function enables you to move the marker to the peak on 
the trace. 

Definition of the peak 

A peak is a measurement point whose value is greater or smaller than the 
adjoining measurement points on its right and left sides. Peaks are 
classified into the following two types depending on the difference in 
magnitude from the measurement points on either side of it. 

Positive 
peak 
(Positive) 

A peak whose measured value is greater than those of the 
measurement points on either side of it (peak polarity: positive) 

Negative 
peak 
(Negative) 

A peak whose measured value is smaller than those of the measuring 
points on either side of it (peak polarity: negative) 

About Peak Excursion Value 

The peak excursion value is the smaller of the differences in measured 
values from the adjoining peaks of the opposite polarity. 
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Executing a Peak Search 

The following three methods are available for executing the peak search: 
  

Peak 
search 
(Search 
Peak) 

Moves the marker to the maximum peak when peak polarity is Positive 
or Both. Moves the marker to the minimum peak when peak polarity is 
Negative. 

Left 
search 
(Search 
Left) 

Executes the search from current marker position to the smaller stimulus 
values and moves the marker to first peak encountered. 

Right 
search 
(Search 
Right) 

Execute the search from current marker position to the larger stimulus 
values and moves the marker to first peak encountered. 
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Procedure 

1. Activate the marker you are using for the peak search. 

2. Press Marker Search key. 

3. Click Peak > Peak Excursion, then enter the lower limit for the peak 
excursion value. 

4. Click Peak Polarity, then select a peak polarity.  

5. Click the corresponding softkey to move the marker to the peak. 

 When the data format is in Smith chart or polar 
format, execute the search for the main response value of the 
two marker response values. 

 Changing the settings of peak excursion value or 
peak polarity executes new search for multiple peak. 

Searching all peaks at one time (Multiple Peak Search) 

The multi-peak search function enables you to display markers on multiple 
peaks on traces. Depending on the number of detected peaks, markers 1 
through 9 are displayed from the start frequency. The reference marker is 
not affected. 

When the multiple peak search is executed, search and tracking settings 
for markers 1 through 9 are ignored and the settings for the multiple peak 
search are used.  

Procedure 

1. Press Marker Search > Multi Peak > Peak Excursion, then enter the 
lower limit for the peak excursion value. 
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2. Press Peak Polarity, then select a peak polarity. 

3. Press Search Multi Peak to show the markers on the multiple peaks. 

4. Changing the settings of peak excursion value or peak polarity 
executes new search for multiple peak. 

5. Press Marker > Clear Marker Menu > All OFF to clear all markers. 

 Search Range is applied for multiple peak search, however 
Multiple Range is not applied. 

 Search tracking is valid for multiple peak search. 
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Determining the Bandwidth of the Trace (Bandwidth Search) 

 Overview 

 Executing a Bandwidth Search 

Other topics about Data Analysis 

Overview 

The bandwidth search is a function for determining the bandwidth of the 
trace, center frequency, cut-off points (on the higher frequency and the 
lower frequency sides), Q, and insertion loss, based on the position of the 
active marker . The definitions of the parameters determined through the 
bandwidth search are shown in below. 

 
  

Bandwidth 
Parameter 

Definition 

Insertion loss (loss) The measured value of the position of the active marker at 
the time the bandwidth search is executed. 

Lower frequency cut-
off point (low) 

Lowest frequency of two measurement points, both separated 
by the defined bandwidth value from the active marker 
position. 

Higher frequency 
cut-off point (high) 

Highest frequency of two measurement points, both 
separated by the defined bandwidth value from the active 
marker position. 
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Center frequency 
(cent) 

Frequency at the midpoint between the lower frequency cut-
off and higher frequency cut-off points. (high+low)/2 

Bandwidth (BW) The difference in frequency between the higher frequency 
cut-off and lower frequency cut-off points. (high-low) 

Q Value obtained by dividing the center frequency by the 
bandwidth.(cent/BW) 

Executing a Bandwidth Search 

1. Place the active marker at the desired point on the trace on which 
the bandwidth search is executed. The response value of this active 
marker itself is the insertion loss in the bandwidth search (loss). 

2. Press Marker Search key. 

3. Click Bandwidth Value and enter the defined bandwidth value in the 
entry area that appears. 

4. Click Bandwidth to turn on the bandwidth search. In the upper left of 
the trace display, six bandwidth parameters are displayed. 

Bandwidth search results 
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Determining the Bandwidth of the Trace (Notch Search) 

 Overview 

 Executing a Notch Search 

Other topics about Data Analysis 

Overview 

The notch search function is used to obtain the bandwidth, center 
frequency, cutoff points (high-frequency side and low-frequency side), Q, 
and insertion loss of a trace based on the active marker position. The notch 
search function starts from the left side of the active marker position, and 
ends when points that meet the conditions are found. 

The figure and the table below shows the definition of parameters obtained 
by notch search function. The notch value in figure below must be specified 
by the user. 

Bandwidth Parameters 

 
Definition of bandwidth parameters 

Bandwidth 
parameter name 

Definition 

Insertion loss 
(loss) 

Measurement value at the active marker position when the 
notch search is executed. 
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Lower cutoff point 
(low) 

Lower frequency of the 2 points on both sides that have the 
measurement value apart from the active marker position by 
the notch value. 

Higher cutoff point 
(high) 

Higher frequency of the 2 points on both sides that have the 
measurement value apart from the active marker position by 
the notch value. 

Center frequency 
(cent) 

Frequency of the middle point between the lower cutoff point 
and the higher cutoff point (high + low)/2. 

Bandwidth (BW) Frequency difference between the higher cutoff point and the 
lower cutoff point ( high – low ). 

Q Value obtained by dividing the center frequency by the 
bandwidth (cent/BW). 

Executing a Notch Search 

1. Place the active marker on the desired point on the trace on which 
the notch search is executed. The response value of this active 
marker itself is the insertion loss in the notch search (loss). 

2. Press Marker Search. 

3. Press Notch Value and enter the notch value in the entry area that 
appears. 

4. Press Notch to turn on the notch search. In the upper left of the trace 
display, six bandwidth parameters are displayed (see the figure 
below). 
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 For more information on displaying the notch search 

result, see Notch Search 



Measurement 

305 

Determining the Mean, Standard Deviation, and p-p of the Trace 

 Overview 

 Displaying Statistical Data 

Other topics about Data Analysis 

Overview 

You can easily determine the statistics data for a trace (mean, standard 
deviation, and peak-to-peak). The definitions for the statistics data elements 
are shown below. 

  

 
  

Statistics data 
element 

Definition 

Mean (mean) 

 
(n: number of points; xi: measured value at the i-th 
measurement point) 
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Standard deviation 
(s. dev) 

 
(n: number of points; xi: measured value at the i-th 
measurement point; mean: Mean) 

Peak-to-peak (p - p) 

  

Max - Min 

(Max: greatest measured value; Min: smallest measured value 

Displaying Statistical Data 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate the trace for which statistical data is required. 

2. Press Marker Fctn key. 

3. Click Statistics to turn on the display of statistics data. 
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Comparing Traces/Performing Data Math 

 Overview 

 Performing Data Math Operations 

Other topics about Data Analysis 

Overview 

Each of the traces for which measured data is displayed is provided with an 
additional trace, called a memory trace, that temporarily stores measured 
data. You can use the memory trace to compare traces on the screen or to 
perform complex data math between the memory trace and measured 
data. 

The following data math operations are available: 

Value Description 

Data / 
Memory 

Divides the measured data by the data in the memory trace. This function 
can be used to evaluate the ratio of two traces (e.g., evaluating gain or 
attenuation). 

Data * 
Memory 

Multiplies the measured data by a memory trace. 

Data -
 Memory 

Subtracts a memory trace from the measured data. This function can be 
used, for example, to subtract a vector error that has been measured and 
stored (e.g., directivity) from data subsequently measured on a device. 

Data + 
Memory 

Adds the measured data and the data in the memory trace. 

Performing Data Math Operations 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate the trace to be stored in memory. 

2. Press Display key. 

3. Press Data -> Mem to store the measured data in memory. 

4. Press Data Math. 

5.  Select the data math operation to perform. 

6. Press Display. 

7. Select the type of data to display on the screen. 

8. Send the trigger to make measurements. 
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Performing Parameter Conversion of Measurement Results 

 Overview 

 Procedure 

Other topics about Data Analysis 

Overview 

You can use the parameter conversion function to convert the measurement 
results of the S-parameter (Sab) to the following parameters. 

  Equivalent impedance (Zr) and equivalent admittance (Yr) in 
reflection measurement 
 

 
 Equivalent impedance (Zt) and equivalent admittance (Yt) in 

transmission measurement 
 

 
 Inverse S-parameter (1/Sab) 

where: 

Z0a: Characteristic impedance of port a 

Z0b: Characteristic impedance of port b 

 Z/Y Transmission Shunt 
 



Measurement 

309 

 
  

 Conjugation 
 
Conjugation converts the measurement value to complex conjugate 
number. 
  

When the fixture simulator function is ON and the port impedance function is 
ON, the value set in the port impedance conversion is used. In other cases, 
the system Z0 (preset value: 50 ohm) is used. 

Procedure 
ON/OFF 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate a trace on which you want to use the marker. 

2. Press Analysis key. 

3. Click Conversion. 

4. Click Conversion to turn ON the conversion function. 
Selecting Conversion Target Parameter 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate a trace on which you want to use the marker. 

2. Press Analysis key. 

3. Click Conversion > Function. 

4. Click the softkey corresponding to the parameter to which you want 
to convert the result. 

When the conversion function is ON, the selected parameter is displayed in 
Trace Status Area. 
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Limit Test 

 Overview 

 Concept of Limit Test 

 Displaying Judgement Result of Limit Test 

 Defining Limit Line 

 Limit line offset 

 Initializing the limit table 

Other topics about Data Analysis 

Overview 

The limit test feature allows you to set the limit line for each trace and 
then perform the pass/fail judgment for the measurement result. 

Concept of Limit Test 

The limit test is a function to perform pass/fail judgment based on the limit 
line you set with the limit table. 

In the limit test, if the upper limit or lower limit indicated by the limit line 
is not exceeded, the judgment result is pass; if it is exceeded, the 
judgment result is fail for all measurement points on the trace. 
Measurement points in a stimulus range with no limit line are judged as 
pass. 

 The targets of the pass/fail judgment are 
measurement points only. Parts interpolated between 
measurement points are not judged. 

You define the limit line by specifying the stimulus value (Begin Stimulus) 
and response value (Begin Response) of the begin point, the stimulus 
value (End Stimulus) and response value (End Response) of the end point, 
and the type (lower limit/upper limit). For more information, refer to 
Defining the limit line. 

When the limit test is on, measurement points that fail are displayed in red 
on the screen and the trace's pass/fail judgment result based on the 
results of individual measurement points (fail if one or more measurement 
points on the trace fail) is also displayed. You can check the pass/fail 
judgment result for the channel (fail if one or more traces fail in any of the 
limit test, the ripple test or the bandwidth test within the channel) on the 
screen as well. For more information, refer to Displaying judgment result of 
limit test. 
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In addition to viewing the screen, you can check the judgment result of the 
limit test by the following methods. 

 Beep that occurs when the judgment result is fail. 

 Using the status register. 
  

Displaying Judgement Result of Limit Test 
Judgment result of measurement points and trace 

Measurement points that fail are displayed in red on the screen. The 
judgment result of the trace is indicated by Pass or Fail displayed in the 
upper right part of the graph. 

 
  

Judgment result of channels 

If a channel has a judgment result of fail, the message below appears on 
the screen (it will be judged as failed if one or more unsatisfactory trace 
exists in any of the limit test, the ripple test or the bandwidth test within 
the channel.) 
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Follow these steps to turn on/off the display of the channel fail message. 

1. Press Analysis key. 

2. Click Limit Test. 

3. Click Fail Sign. Each press toggles between on/off. 
  

Defining Limit Line 

To use the limit test, you must first define the limit line. You can define a 
limit table for each trace, and you can define up to 100 limit lines 
(segments) in a limit table. 

Defining a segment 

The following steps describe how to define a segment. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace on which the limit test function will be used. 

2. Press Analysis key to display the Analysis menu. 

3. Click Limit Test to display the softkeys associated with the limit test. 

4. Click Edit Limit Line to display the limit table. 

 
5. Using the limit table, create/edit a segment. Initially, no segments 

are entered in the limit table. At the same time, the Edit Limit Line 
menu used to create/edit the limit table is displayed. 

6. Click Add to add a segment to the limit table and then specify the 
segment parameter values shown below. 
  

Segment Parameter Description 

Type Select the type of segment from the following: 

OFF Segment not used for the limit test 

MIN Segment at which the minimum is specified 

MAX Segment at which the maximum is specified 
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Begin Stimulus Specify starting point for stimulus value on the limit line 

End Stimulus Specify ending point for stimulus value on the limit line 

Begin Response Specify starting point for response value on the limit line 

End Response Specify ending point for response value on the limit line 

 The range in which stimulus values can be specified 
is from -500 G to +500 G. When a value outside the range is 
entered, a suitable value within the range is specified. Once the 
stimulus value is specified, changing the sweep range of the 
E5071C does not affect the stimulus value. 

 The range in which response values can be specified 
is from -500 M to +500 M. When a value outside this range is 
entered, a suitable value within the range is specified. After the 
response value is specified, changing formats results in 
changing the units but not the value. 

 
 You can define a limit line that is able to freely 

overlap the stimulus range of another limit line. 
 
Defining one limit line having the same type as a second limit 
line whose stimulus range overlaps with the first one results in 
two or more limit values at the same measurement point. In 
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this case, the limit value to be used in the limit test is defined 
as follows: 

 When two or more limit values whose type is set to 
maximum (MAX) exist, the smallest one is used as the 
maximum. 

 When two or more limit values whose type is set to minimum 
(MIN) exist, the largest one is used as the minimum. 

 Even if the span of the sweep range on the E5071C 
is set to 0, enter the two parameters of Begin Stimulus and End 
Stimulus. 

 When two or more response values are returned as a 
result of using the Smith or polar chart format, the first 
response value of the marker provides the object of the limit 
test. 

Saving/calling the limit table 

You can save the limit table to a file that you can then freely bring up on 
the screen later and use. You can import a file saved in CSV format 
(extension: *.csv) into spreadsheet software on a PC for later use (a 
numerical value will be saved as strings that include its unit). 

 
1. Display the limit table. 

2. In the Edit Limit Line menu, press Export to CSV File to open the Save 
As dialog box. In this step, CSV (extension: *.csv) is selected as the 
file type 
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3. Specify the folder in which to save the file and enter the file name. 
Press Save to save the limit table displayed on the screen to the file. 

4. Conversely, to recall a saved limit table, press Import from CSV File in 
the Edit Limit Line menu to display the Open dialog box. In this step, 
CSV (extension: *.csv) is selected as the file type. 

5. After specifying the folder containing the file, select the file. Press 
Open to display the limit table on the screen. 

6. The limit table can be called from any trace of any channel, 
regardless the channel or trace as of saving in a file. 

Limit Table Saved in CSV Format 

The limit table is saved in the following format. 

 On the first line, the channel number of the active channel that was 
valid when the file was saved is output. 

 On the second line, the trace number of the active trace that was 
valid when the file was saved is output. 

 The third line provides the header showing the items for the 
segments to be output on the fourth and later lines. 

 Data on segments are output on the fourth and later lines. 
"# Channel 1" 

"# Trace 1" 

Type,             Begin Stimulus,             End Stimulus, Begin Response, End Response 

MAX, 200.0000000 MHz, 400.0000000 MHz, -100 dB, -100 dB 

MAX, 490.0000000 MHz, 510.0000000 MHz, -10 dB, -10 dB 

MIN, 490.0000000 MHz, 510.0000000 MHz, -20 dB, -20 dB 

MIN, 600.0000000 MHz, 800.0000000 MHz, -100 dB, -100 dB 
Turning the limit test ON/OFF 

You can set the limit test ON/OFF for each trace individually. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace on which the limit test function will be used. 

2. Press Analysis key to display the Analysis menu. 

3. Press Limit Test to display the Limit Test menu. 
  

Softkey Function 

Limit Test Sets the limit test ON/OFF. 

Limit Line Sets the limit line display ON/OFF. 
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Edit Limit 
Line 

Opens the limit table for editing the limit line. See 
Defining_the_limit_line. 

Limit line offset 

By adding a certain offset to the limit value, you can adjust the limit line so 
that it conforms to the device output. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace on which the limit test function will be used. 

2. Press Analysis key to display the Analysis menu. 

3. Click Limit Test to display the softkeys for the limit test. 

4. Click Limit Line Offsets to display the limit line offset function menu. 
The following functions correspond to each softkey. 
  

Softkey Function 

Stimulus Offset Adds a certain offset to the stimulus value of the entire 
segment in the limit table. (Stimulus offset) 

Amplitude 
Offset 

Adds a certain offset to the response value of the entire 
segment in the limit table. (Amplitude offset) 

Marker -> Amp. 
Ofs. 

Adds the amplitude offset by the same amount as the 
retrieved value of the active marker . You can confirm the 
current value set for the amplitude offset by pressing 
Amplitude Offset. (Marker amplitude offset) 

Stimulus offset 
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Amplitude offset 

 
  

Initializing the limit table 

The following operations initialize the limit table. 
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 At power-on 

 When presetting 

 When calling a limit table with zero segments 

 When Clear Limit Table - OK is pressed in the Edit Limit Line menu 
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Bandwidth Test 

 Overview 

 Displaying Bandwidth Test Results 

 Bandwidth Test Setup 

 Turning Bandwidth Test and Displaying Results ON/OFF 

Other topics about Data Analysis 

Overview 

The bandwidth test function can be used for testing bandwidth for the 
band-pass filters. 

The bandwidth test find the peak of a signal in the passband and locates a 
point on each side of the passband at an amplitude below the peak 
specified in test setup. The frequency between these two points is the 
bandwidth of the filter. Then the obtained bandwidth is compared to 
minimum and maximum allowable bandwidth that you specify beforehand. 

 
  
  

Displaying Bandwidth Test Results 
Test Result for Trace 

The test result of the trace will be indicated in the upper-right area of the 
graph for each trace, following BWn:. "n" denotes the trace number. The 
results are shown as Pass, Wide, Narrow, or >Span (Fail). You can also 
display the bandwidth value. 
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For information on how to display the results, see Turning On/Off 
Bandwidth Test and Displaying Results. 

 
Test Results for Channel 

If any channel is unsatisfactory, the message will be displayed as shown in 
Judgment result of channels. (It will be judged as failed if one or more 
failed traces are found for the limit test, ripple test, or bandwidth test 
within the channel.) 

You can also specify this On/Off setting from the Fail Sign, which is 
provided in the limit test menu and ripple test menu. From the bandwidth 
test menu, follow the steps below to turn it on/off. 

1. Press Analysis key. 

2. Click Bandwidth Limit. 

3. Click Fail Sign. This menu toggles between on and off. 

In addition to the screen, the following features also let you confirm the 
test results: 

 Beep notifying the result was unsatisfactory 

 Status register 

Bandwidth Test Setup 
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You must set up the bandwidth threshold and the upper and lower limits 
before you can use the bandwidth test function. You can specify the 
threshold, upper limit, and lower limit for each trace. 

Operational procedure 

Follow the steps below to set up the bandwidth test. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate the trace to which you want to apply the bandwidth test 
function. 

2. Press Analysis key to display the Analysis menu. 

3. Click Bandwidth Limit to display the softkeys for the bandwidth test. 

4. Click N dB Points to specify the bandwidth threshold. The unit is dB. 

5. Press Min Bandwidth to enter the lower limit for the bandwidth. 
Similarly, press Max Bandwidth to enter the upper limit for the 
bandwidth. The unit is Hz for both Min and Max bandwidths. 

 If the data format is Smith chart or polar, the limit 
test is performed for the main response value among the two 
marker response values. 

Turning Bandwidth Test and Displaying Results ON/OFF 

You can configure the on/off setting of the bandwidth test function for each 
trace independently. 

Operational procedure 

Follow the steps below to configure the on/off setting of the bandwidth 
test. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace Prev keys 
to activate the trace to which you want to apply the bandwidth test 
function. 

2. Press Analysis key to display the Analysis menu. 

3. Click Bandwidth Limit to display the softkeys for the bandwidth test. 

4. Click BW Test and turn ON the bandwidth test. You can display the 
bandwidth marker on the screen by turning BW Marker ON. To 
display the bandwidth value, turn BW Display ON. 



E5071C 

322 

 

Ripple Test 

 Overview 

 Concept of Ripple Test 

 Displaying Ripple Test Results 

 Configuring Ripple Limit 

 Saving/Recalling Ripple Limit Table 

 Turning ON/OFF Ripple Test and Result Display 

 Initializing Limit Table 

Other topics about Data Analysis 

Overview 

Independently of the limit test, you can evaluate the measurement results 
on a pass/fail basis by setting a limit for the ripple. This function is called 
the ripple test. 

Concept of Ripple Test 

The ripple test is a function for evaluating the results on a pass/fail basis 
based on the ripple limit, which is set using the ripple limit table. You can 
specify up to 12 frequency bands, which permits a test for each frequency 
band. 

The ripple test judges the measurement as "Pass" when the ripple value 
specified with the ripple limit is not exceeded by any of the measurement 
points on the trace; otherwise, it judges the measurement as "Fail." For 
the measurement points in a stimulus range without a specified ripple 
limit, the test judges the measurement as "Pass." 

 The measurement point alone is the target of 
evaluation for pass/fail. The interpolated part between 
measurement points is not evaluated. 

The ripple limit is defined with the start point stimulus value, end point 
stimulus value, ripple limit value, and type (on/off.) For detailed 
information, see Configuring ripple limit. 

While the ripple test function is turned on, the measurement points 
corresponding to a "fail" judgment will be indicated in red on the screen, 
and the trace's test results based on the results of each measurement 
point will be displayed (judged as "fail" if one or more red measurement 
point exist on the trace). For information on how to display the results, see 
Turning on/off ripple test and displaying results. You can also confirm the 
channel test results on the screen (judged as "fail" if one or more failed 
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traces appear in the limit test, ripple test, or bandwidth test within the 
channel). 
  

Displaying Ripple Test Results 
Measurement point and test results 

Failed measurement points will be displayed in red on the screen. The test 
result for the trace will be indicated as Pass or Fail in the upper-right area 
of the graph. You can also display the ripple value at the selected 
frequency band. 

The result will be displayed as Ripln:Pass (or Fail) for each trace. n denotes 
the trace number. Bn will be followed by the ripple value (if the ripple 
display is turned off, only Bn will be displayed without the ripple value). 

For example, in the following figure, Ripl1:Pass in the first line indicates 
the result for trace 1. The value following B3 is the ripple value at the third 
frequency band specified in the ripple test. Similarly, the second line 
indicates the test result for trace 2, showing the ripple value at the first 
frequency band. 

For information on how to display the results, see Turning on/off ripple test 
and displaying results. 

 
Test result for channel 

If a channel has a judgment result of "fail," the message will be displayed 
as shown in Test Result for Trace. (It will be judged as failed if one or more 
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failed traces are found in the limit test, ripple test, or bandwidth test within 
the channel.) 

 
You can also specify the On/Off setting for the Fail Sign in the limit test 
menu and as well as in the bandwidth test menu. From the ripple test 
menu, follow the steps below to turn it on/off. 

1. Press Analysis key. 

2. Click Ripple Limit. 

3. Click Fail Sign. This menu toggles between on and off. 

In addition to the screen, the following features also let you confirm the 
test results: 

  Beep notifying that the result was "fail" 

 Status register 

Configuring Ripple Limit 

You must configure the ripple limit before you can use the ripple test 
function. You can specify a ripple limit table for each trace, where up to 12 
ripple limit bands (frequency bands) can be configured. 

Operational procedure 

Follow the steps below to configure the ripple limits. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace on which you want to apply the ripple test 
function. 

2. Press Analysis key to display the Analysis menu. 
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3. Click Ripple Limit to display the softkeys for to the ripple test. 

4. Click Edit Ripple Limit to display the ripple limit table shown below. 
 
 

 
5. Create or edit the bands by using softkeys. Note that no frequency 

band is provided in the ripple limit table by default. The Edit Ripple 
Limit menu is also displayed, which can be used for creating or 
editing the frequency band. 

6. Click Add to add a frequency band to the ripple limit table and then 
specify the following parameters for the frequency band: 
  

Parameter Description 

Type Selects a frequency type, either ON or OFF. 

ON Band used for the ripple test. 

OFF Band not used for the ripple test. 

Begin Stimulus Specifies the start point for the stimulus value in the ripple test. 

End Stimulus 

  

Specifies the end point for the stimulus value in the ripple test. 

Max Ripple Specifies the ripple limit value. 

 Acceptable range for the stimulus value: -500G to 
+500G. If any outranging value is specified, it will be reset to 
fall within the range. 
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 Even if the E5071C's sweep range is changed after 
the stimulus value has been set, the stimulus value is not 
susceptible. 

  Example of ripple limit configuration 

 
 The individual frequency bands for the ripple test can 

overlap each other; in this case, the ripple limit test is 
performed for each frequency band. 

 Even if the E5071C's span value is set to zero, you 
must enter a parameter for both Begin Stimulus and End 
Stimulus. 

 If the data format is Smith chart or polar, the limit 
test is performed for the main response value among the two 
marker response values. 

Saving/Recalling Ripple Limit Table 

The ripple limit table can be saved in a file and recalled later for use on the 
screen. The file is saved in the csv format (with the extension *.csv), and 
values are saved as a character string with the unit. The csv formatted file 
can also be reused in spreadsheet software made for PCs. 

Follow the steps below to save/recall the ripple limit table. This operation 
should be done by using the external keyboard and/or mouse. 

1. Display the ripple limit table. 
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2. Click Export to CSV File from the Edit Ripple Limit menu to open the 
dialog box. At this time, CSV Files (with the extension *.csv) is 
selected as the file type. 

3. Specify any folder in which you want to save the file, and enter the 
file name. Click Save to save the ripple limit table displayed on the 
screen to a file. 

4. To recall the saved ripple limit table, click Import from CSV File from 
the Edit RippleLimit menu to display the Open dialog box. At this 
time, CSV Files (with the extension *.csv) is selected as the file type. 

5. Specify the folder that contains the file, and then select the file. Click 
Open to recall the saved limit table on the screen. 

 You can recall a limit table from a trace on any 
channel independently of the channel and trace that were active 
when the limit table was saved to the file. 

The ripple limit table is saved in the following format: 

 In the first line, the channel number for the active channel at the 
time of file saving will be output. 

 In the second line, the trace number for the active trace at the time 
of file saving will be output. 

 The third line is a header indicating the segment items that are 
output from the fourth line onward. 

 From the fourth line onward, the segment data are output. 
Operational procedure 

"# Channel 1" 

"# Trace 1" 

Type, Begin Stimulus, End Stimulus, MaxRipple 

ON, 933.0000000 MHz, 964.0000000 MHz, 1.5 dB 

ON, 938.0000000 MHz, 953.0000000 MHz, 500 mdB 

ON, 953.0000000 MHz, 960.0000000 MHz, 300 mdB 

Turning ON/OFF Ripple Test and Result Display 

You can set the limit test ON/OFF for each trace individually. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace on which you want to apply the ripple test 
function. 

2. Press Analysis key to display the Analysis menu. 

3. Click Ripple Limit to display the softkeys for to the ripple test. 

4. Click the following corresponding softkeys. 
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Softkey Function 

Ripple 
Test 

Sets the ripple test ON/OFF. 

Ripple 
Limit 

Sets the ripple limit line display ON/OFF. 

Ripple 
Value 

Sets how the ripple values are displayed. Available settings are 
off, absolute value (difference between maximum and minimum 
values within the band) display, and margin (difference between 
absolute value of ripple and ripple limit) display. 

Ripple 
Value 
Band 

Selects the band for which you want to display the ripple value. 

Edit Ripple 
Limit 

Opens the ripple limit table for editing the ripple limit. To use the 
ripple test function, you must first define the ripple limit. 

Initializing Limit Table 

The following operations initialize the limit table. 

 At power-on 

 When presetting 

 When calling a Ripple table with zero segments 

 When Clear Limit Table > OK is clicked in the Edit Ripple Line menu 
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Equation Editor 

 Overview 

 Using Equation Editor 

 Equation Editor Examples 

 Equation History 

 Functions and Constants 

 Converting S Parameters to H, Y, Z, F & T Parameters 

 Operators used in Equation Editor 

Other topics about Data Analysis 

Overview 

Equation Editor allows you to enter an algebraic equation of standard 
mathematical operators and functions, referencing data that is available in 
the E5071C. Once a valid equation is entered and enabled, the display of 
the active trace is replaced with the results of the equation, and updated in 
real-time as new data is acquired.  For equations that can be expressed 
with Equation Editor's supported functions, operators, and data, there is no 
need for off-line processing in a separate program. 

For example, on entering the equation “Example=S21/(1-S11)” in the 
E5071C Equation Editor (4 in the Figure below), the resulting trace is 
computed as each S21 data point divided by one minus the corresponding 
S11 data point. For a 201 point sweep setup, the computation is repeated 
201 times, once for each point. 

As another example, if you want the ENA to make a directivity 
measurement of your 3-port DUT, then the desired result is the sum and 
difference of LogMag formatted traces, which can be expressed as: S12 + 
S23 - S13.   

Because Equation Editor operates on unformatted complex data, the 
required equation is: 

DIR = S12 * S23 / S13 

DIR becomes a display label to help you identify the computed data trace. 
On the equation trace, set the format to LogMag. 

Using Equation Editor 

The step-by-step procedure of using Equation Editor is described below: 



E5071C 

330 

 
1. Select a trace in which you want to enter the equation and activate 

the trace. 

2. Activating a trace is required as Equation Editor works on 
traces. 

2. Follow the steps below to enter an equation: 

1. Press Display. 

2. Click Equation Editor (1 in the figure above). The Equation 
Editor dialog box appears. 

3. Enter an equation in the equation field (4 in the figure above). 

 Referring to traces in a different channel is NOT 
available with Equation Editor on the ENA. 

 The equation can be entered with the software 
keyboard enabled by selecting Keyboard... (3 and 3a in the 
figure above). 
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3. Follow the steps below to apply the defined equation. When a valid 
equation is entered, the Equation Enabled check box becomes 
available for checking. 

1. Check Equation Enabled check box (2a in the figure above). 

2. Click Apply. The equation becomes visible and annotation of 
[Equ] (2b in the figure above) is displayed in the trace title 
area. 

3. Click Close to hide the dialog box. 

4. The equation can also be applied by selecting Display > Equation 
ON. 

 If error correction is not turned on, then the raw, 
uncorrected data is used in the equation trace. 

 If an equation is NOT valid (i.e. referring to a trace 
that is not measured in the measured channel), annotation of 
[Equ!] is displayed in the trace title area instead. 

Equation Editor Examples 

The following examples may help you in getting started with Equation 
Editor: 

  
Offset each data point in trace 2 from trace 1 by XdB 

The equation is entered into trace 2 as "Offset= 
data(1)*pow(10,X/20)" (4 in the figure e5071c282). 

  
To multiply a trace by X-times in log format 

The equation is entered as "Example_Trace= pow(data,X)" (4 in the 
figure e5071c282). 

  
Differential Return Loss using a 2-port ENA 

The equation is entered as "Sdd11= (S11-S21-S12+S22)/2)" (4 in the 
figure e5071c282). 

 For detailed on mixed-mode S-parameters on the 2-
port ENA, refer to the related FAQ on the Agilent website. 

  
CMRR of a Balanced Component 

The equation is entered as "CMRR =  data(2) / data (1)" (4 in the figure 
e5071c282) 
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where: 

data (1) - a trace that measures Scc21 with Fixture Simulator 

data (2) - a trace that measures Sdd21 with Fixture Simulator 

Equation History 

Equation Editor has the capability to save and recall all previously defined 
equations, which can be accessed by clicking the ... button (shown as 5 in 
the figure e5071c282). All equations can be viewed in the Equation 
History dialog box. 

To view the equations in the list, follow this procedure: 

1. Open Equation Editor by Display > Equation Editor 

2. Enter an equation and click Apply in the Equation Editor dialog box 
(Figure e5071c282) to save the defined equation in the directory of 
the ENA. To view a list of saved equations, click the ... button (5 in 
Figure e5071c282) to  open the Equation History dialog box. 
 

 
  

3. To store an equation in the History List, the equation must be 
applied first. This can be done by clicking on the Apply button. 

3. To edit the equations in the list, click Edit History. The text file of 
history list is opened with Notepad. 
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4. The History List is stored as a text file 
D:\Agilent\Equation\history.txt and can save a maximum of 50 
lines (equations) with a maximum of 254 character per line 
(equation). 

Functions and Constants 

The following table describes the different functions and constant available 
in the E5071C Equation Editor. In the following table: 

 Function(scalar x) means that the function requires a scalar value. If 
a complex value is entered, it is automatically converted to a scalar 
value; complex(x,y) -> scalar(x) 

 Function(complex x) means that the function requires a complex 
value. If a scalar value is entered, it is automatically converted to a 
complex value; scalar(x) -> complex(x, 0) 

 a,b are arguments that are used in the function. 

Basic Math Functions 

Function Description 

abs(complex a) returns the sqrt(a.re*a.re+a.im*a.im) 

acos(scalar a) returns the arc cosine of a in radians 

asin(scalar a) returns the arc sine of a in radians 

atan(scalar a) returns the arc tangent of a in radians 

atan2(complex a) returns the phase of a = (re, im) in radians 

atan2(scalar a, 
scalar b) 

returns the phase of (a, b) in radians 

conj(complex a) returns the conjugate of a 

cos(complex a) takes a in radians and returns the cosine 
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cpx(scalar a, scalar 
b) 

returns a complex value (a+ib) from two scalar values 

exp(complex a) returns the exponential of a 

im(complex a) returns the imaginary part of a as the scalar part of the 
result (zeroes the imaginary part) 

ln(complex a) returns the natural logarithm of a 

log10(complex a) returns the base 10 logarithm of a 

mag(complex a) returns sqrt(a.re*a.re+a.im*a.im) 

phase(complex a) returns atan2(a) in degrees 

pow(complex 
a,complex b) 

returns a to the power b 

re(complex a) returns the scalar part of a (zeroes the imaginary part) 

sin(complex a) takes a in radians and returns the sine 

sqrt(complex a) returns the square root of a, with phase angle in the half-
open interval (-pi/2, pi/2] 

tan(complex a) takes a in radians and returns the tangent 

Constants 

e 2.71828182845904523536 

PI 3.14159265358979323846 

 
 

 Mutual transformation is automatically made for scalar and 
complex. 
 
scalar(x) -> complex(x, 0) 
complex(x, y) -> scalar(x) 

Advanced Math Functions 

In the following table: a,b,c,d are arguments of complex value that are 
used in the function. For 2-port network measurement: a,b,c,d 
corresponds to Sii,Sji, Sij, Sjj respectively. 

 The functions can also be defined by scalar 
arguments with port numbers of the ENA. For example, the 
function, kfac(1,2) returns the K-factor of 2-port measurement 
between port 1 and port 2 of the ENA. 
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 When a scalar argument of the port number in the 
function is out of range (i.e. mu1(1,3) for the 2-port ENA), the 
ENA indicates an error message, “Equation runtime error” and 
equation is not reflected on the trace. 

 Z0 means the system characteristic impedance (Z0) which can be 
accessed under Cal. 

 Although the port impedance for each port can be 
changed with the port impedance conversion function by Fixture 
Simulator, the change is not reflected on the computed trace by 
Equation Editor. 

Function Description 

A(complex a, complex b, 
complex c, complex d) 

F11 conversion = ((1+a)*(1-d) + b*c)/(2*b) 

A(scalar i, scalar j) returns A(Sii, Sji, Sij, Sjj) 

B(complex a, complex b, 
complex c, complex d) 

F12 conversion = Z0*((1+a)*(1+d) - b*c)/(2*b) 

B(scalar i, scalar j) returns B(Sii, Sji, Sij, Sjj) 

C(complex a, complex b, 
complex c, complex d) 

F21 conversion = (1/Z0)*((1-a)*(1-d) - b*c)/(2*b) 

C(scalar i, scalar j) returns C(Sii, Sji, Sij, Sjj) 

D(complex a, complex b, 
complex c, complex d) 

F22 conversion = ((1-a)*(1+d) + b*c)/(2*b) 

D(scalar i, scalar j) returns D(Sii, Sji, Sij, Sjj) 

H11(complex a, complex b, 
complex c, complex d) 

H11 conversion = Z0*((1+a)*(1+d) - b*c)/((1-
a)*(1+d) + b*c) 

H11(scalar i, scalar j) returns H11(Sii, Sji, Sij, Sjj) 

H12(complex a, complex b, 
complex c, complex d) 

H12 conversion = 2*c/((1-a)*(1+d) + b*c) 

H12(scalar i, scalar j) returns H12(Sii, Sji, Sij, Sjj) 

H21(complex a, complex b, 
complex c, complex d) 

H21 conversion = -2*b/((1-a)*(1+d) + b*c) 

H21(scalar i, scalar j) returns H21(Sii, Sji, Sij, Sjj) 
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H22(complex a, complex b, 
complex c, complex d) 

H22 conversion = (1/Z0)*((1-a)*(1-d) - b*c)/((1-
a)*(1+d) + b*c) 

H22(scalar i, scalar j) returns H22(Sii, Sji, Sij, Sjj) 

kfac(complex a, complex b, 
complex c, complex d) 

k-factor = (1 - abs(a)^2 - abs(d)^2 + (abs(a*d - 
b*c)^2)/(2*abs(b*c)) 

kfac(scalar i, scalar j) returns kfac(Sii, Sji, Sij, Sjj) 

MAPG(complex a, complex b, 
complex c, complex d) 

maximum available power gain = 
abs(b/c)*(kfac(a,b,c,d) - sqrt(kfac(a,b,c,d)^2 - 1)) 

MAPG(scalar i, scalar j) returns MAPG(Sii, Sji, Sij, Sjj) 

MSG(complex a, complex b, 
complex c, complex d) maximum stable power gain = abs(b)/abs(c) 

MSG(scalar i, scalar j) returns MSG(Sii, Sji, Sij, Sjj) 

mu1(complex a, complex b, 
complex c, complex d) 

µ-factor = (1 - abs(a)^2) / (abs(d - conj(a) * (a*d-
b*c)) + abs(b*c)) 

mu1(scalar i, scalar j) returns mu1(Sii, Sji, Sij, Sjj) 

mu2(complex a, complex b, 
complex c, complex d) 

µ-factor = (1 - abs(d)^2) / (abs(a - conj(d) * (a*d-
b*c)) + abs(b*c)) 

mu2(scalar i, scalar j) returns mu2(Sii, Sji, Sij, Sjj) 

T11(complex a, complex b, 
complex c, complex d) T11 conversion = -(a*d - b*c)/b 

T11(scalar i, scalar j) returns T11(Sii, Sji, Sij, Sjj) 

T12(complex a, complex b, 
complex c, complex d) T12 conversion = a/b 

T12(scalar i, scalar j) returns T12(Sii, Sji, Sij, Sjj) 

T21(complex a, complex b, 
complex c, complex d) T21 conversion = -d/b 

T21(scalar i, scalar j) returns T21(Sii, Sji, Sij, Sjj) 

T22(complex a, complex b, 
complex c, complex d) T22 conversion = 1/b 
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T22(scalar i, scalar j) returns T22(Sii, Sji, Sij, Sjj) 

Y11(complex a, complex b, 
complex c, complex d) 

Y11 conversion = (1/Z0)*((1-a)*(1+d) + 
b*c)/((1+a)*(1+d) - b*c) 

Y11(scalar i, scalar j) returns Y11(Sii, Sji, Sij, Sjj) 

Y12(complex a, complex b, 
complex c, complex d) 

Y12 conversion = (1/Z0)*(-2*c)/((1+a)*(1+d) - b*c) 

Y12(scalar i, scalar j) returns Y12(Sii, Sji, Sij, Sjj) 

Y21(complex a, complex b, 
complex c, complex d) 

Y21 conversion = (1/Z0)*(-2*b)/((1+a)*(1+d) - b*c) 

Y21(scalar i, scalar j) returns Y21(Sii, Sji, Sij, Sjj) 

Y22(complex a, complex b, 
complex c, complex d) 

Y22 conversion = (1/Z0)*((1+a)*(1-d) + 
b*c)/((1+a)*(1+d) - b*c) 

Y22(scalar i, scalar j) returns Y22(Sii, Sji, Sij, Sjj) 

Z11(complex a, complex b, 
complex c, complex d) 

Z11 conversion = Z0*((1+a)*(1-d) + b*c)/((1-a)*(1-
d) - b*c) 

Z11(scalar i, scalar j) returns Z11(Sii, Sji, Sij, Sjj) 

Z12(complex a, complex b, 
complex c, complex d) 

Z12 conversion = Z0*(2*c)/((1-a)*(1-d) - b*c) 

Z12(scalar i, scalar j) returns Z12(Sii, Sji, Sij, Sjj) 

Z21(complex a, complex b, 
complex c, complex d) 

Z21 conversion = Z0*(2*b)/((1-a)*(1-d) - b*c) 

Z21(scalar i, scalar j) returns Z21(Sii, Sji, Sij, Sjj) 

Z22(complex a, complex b, 
complex c, complex d) 

Z22 conversion = Z0*((1-a)*(1+d) + b*c)/((1-a)*(1-
d) - b*c) 

Z22(scalar i, scalar j) returns Z22(Sii, Sji, Sij, Sjj) 

 For both mu1 and mu2, conj is the complex 
conjugate. For scalars a and b, conj(a+ib)=(a-ib). 

Channel Parameter Data 

data corrected data 
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data(scalar i) corrected data of trace i (trace number) 

mem memory data 

mem(scalar i) memory data of trace i (trace number) 

xAxis x-axis data 

xAxis(scalar i) x-axis data of trace i (trace number) 

S11 - S44 S-parameter data 

 When a trace number is out of range, the ENA 
indicates an error message, “Equation runtime error” and 
equation is not reflected on the trace. The maximum number of 
traces can be set by System > Misc Setup > Channel/Trace 
Setup. 

Converting S-Parameters to H, Y, Z, F & T-Parameters 

The following section provides definition of the two port parameters in 
Equation Editor of the ENA. 

1. Hybrid parameters (H) 
 

 
  

2. Admittance parameters (Y) 
 

 
  

3. Impedance parameters (Z) 
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Fundamental parameters (F) 
 

 
  

4.    

 
 
 
 
 

 
  

5. Scattering transfer parameters (T) 
 

 
  

S-parameters of 2-port network can be converted to Hybrid parameters 
(H), Admittance parameters (Y), Impedance parameters (Z), Fundamental 
parameters (F) and Scattering transfer parameters (T) using the following 
functions: 

1. Converting S-parameters to H-parameters 
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2. Converting S-parameters to Y-parameters 
 

 
  

3. Converting S-parameters to Z-parameters 
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4. Converting S-parameters to F-parameters 
 

 
  

5. Converting S-parameters to T-parameters 
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Where: 
 
Ds=S11S22 - S12S21 
  

Operators used in Equation Editor 

Operator Description 

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Power 

( Open parenthesis 

) Close parenthesis 

, Comma - separator for arguments 

= Equal (optional) 

E Exponent (as in 23.45E6) 
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 Priority of operators is:  
 
1. ^   
2. *,/ 
3. +,- 
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Data Output 

Data Output 

 Saving and Recalling Instrument State 

 Saving/Recalling Instrument State for Each Channel into/from 
Memory 

 Saving Trace Data to a File 

 Saving the Screen Image to a File 

 Printing Displayed Screen 
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Saving and Recalling Instrument State 

 Overview 

 Compatibility of Files (Saving and Recalling) 

 Saving Data 

 Recall Procedure 

 Recall Procedure Using "Recall by File Name" 

 Priority of Recalling Configuration File at Startup 

Other topics about Data Output 

Overview 

You can save the instrument state of the E5071C into a file on mass 
storage and then recall it later to reproduce that state. You can select the 
stored data from the following four types. 

Type Stored data and usage 

State only 
(State Only) 

Saves the setting of the E5071C and reproduces the state when it 
was saved by recalling it later into the E5071C. 

State and 
calibration 
data (State & 
Cal) 

Saves the setting of the E5071C and calibration data (calibration 
coefficient array) to reproduce the state when it was saved by 
recalling it later into the E5071C. At this time, you can perform error 
correction of measured values by using the recalled calibration data. 

State and 
trace (State 
& Trace) 

Saves the setting of the E5071C and traces (error-corrected data 
array  and error-corrected memory array) to reproduce the state 
when it was saved by recalling it later into the E5071C. At this time, 
the traces are also recalled and displayed on the screen. 

State, 
calibration 
data, and 
traces (All) 

Saves the setting of the E5071C, calibration data, and traces to 
reproduce the state when it was saved by recalling it later into the 
E5071C. At this time, the calibration data and traces are also recalled. 

In addition, the "user-preset" function is provided to allow the user to 
freely set up an instrument state recalled when the preset function is 
executed. 

Compatibility of Files (Saving and Recalling) 

Files saved with the E5071C cannot be recalled with the E507xA/B. The 
other compatibility of saving/recalling the instrument state file is as 
follows: 

 Compatibility between different frequency models 
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      Recalling by 
E5071C 
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Y 

  E5070A/B Y Y Y Y Y Y Y Y 

  

N N 

  E5071A/B N N N N N N Y Y N N 

 Y: Recall is possible 

 N: Recall is impossible 

 Y*: Recall is only possible for the revision A.11.0x and above 

 Y#:Recall is only possible for the revision A.11.20 and above. 
However, warning message prompts "Incompatible recall file". 
Some state data may be lost.  

 When state files with calibration data that are saved 
with E5070A/B and E5071A/B, only states and trace data are 
recalled. 

 Recalling state file saved in models without Bias Tee 
onto models with Bias Tee: 

1. When the Start/Stop frequency is set to below 100 kHz at 
the time of save, it should be changed to 100 kHz at recall. 
In such cases, Center/Span frequency should also be 
changed.  

2. Similarly, calibration factor can also be recalled. However, if 
some calibration points are below 100 kHz at the time of 
save, C? or C! is displayed after recall.  
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 As a general rule, its not advisable to use the 
calibration factor of one unit onto the other. 

  
Compatibility between  different number of ports models 

 If the stored data is "state only (State Only)," files saved with a 
model having a smaller number of ports can be recalled with a model 
having a larger number of ports, but the opposite is not possible. 

    Recalling 

  Option: 
number 
of port 

2 Ports 4 
Ports 

Saved 
File 
by 

2 Ports Y Y/ c 

4 Ports N Y 

Y: Recall is possible 

N: Recall is impossible 

Y/ c: Only when the stored data is "state only (State Only)," recall is 
possible. 

Compatibility when the maximum number of channels/traces is different 

 You cannot recall files saved by specifying all channels/traces (All) as 
the save target. 

 If the number of channels/traces at save does not exceed that at 
recall, you can recall files saved by specifying the displayed 
channel/trace (Disp Only) as the save target. 

Compatibility when the Firmware revision is different 

 Files that are saved with later firmware revisions cannot be recalled 
by prior firmware revisions. 

 Recalling the state file which is saved by prior firmware revision may 
lose some settings. 

 Recalling the state file which is saved by prior firmware revision may 
cause a sweep time change and C? is displayed. In this case, re-
calibration is recommended. 

Compatibility when the system spec. version (available with ":SERV:SREV?") is different 

 When Files that are saved with different system spec. versions 
include calibration data, only states and trace data are recalled. 

 If you recall an incompatible file, an error occurs and the device 
recovers to the presetting. 

Saving Data 
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Selecting Content to be Saved 

  This setting takes effect both when saving the entire 
instrument state into a file and when saving the instrument 
state for each channel into memory. 

1. Press Save/Recall key. 

2. Click Save Type. 

3. Click the softkey corresponding to the content of the instrument 
state you want to save. 

Selecting Save Target Channel/Trace 

1. Press Save/Recall key. 

2. Click Channel/Trace and select the save target from all 
channels/traces (All) or displayed channel/traces only (Disp Only). 

If you specify the displayed channel/traces only as the save target, you 
can reduce the file size. However, for channels/traces that are not 
displayed, you cannot recall and reproduce the instrument state separately 
held for each channel/trace at a later time. 

 Faster Recall 

From Firmware revision A.08.0x or later, the recall speed has been 
increased in the DISP only mode. In Firmware revision below A.08.0x, 
preset was done for hidden channels.  In Firmware revision A.08.0x or 
later, hidden channels are not made preset and results in a faster recall. 

 
Specifying the Trigger Source Setting After Recall (Auto Trigger Source)  

Once auto trigger source is set to OFF and the state file is saved with State 
& Trace or All, trigger source remains to the setting determined by user 
instead of changing to manual. When auto trigger source is set to ON, 
trigger source will change to manual automatically at the save. This allows 
you to hold the trace after recall because the trigger is not generated 
internally. By default, auto trigger source is set to ON.  This function is 
available in firmware revision A.11.20 and later. 
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To turn ON/OFF the auto trigger source: 

1. Press Save/Recall key. 

2. Click Auto Trig Source > ON|OFF. 
Saving Instrument State 

Follow the procedure below to save internal data from the E5071C. 

1. Press Save/Recall key. 

2. Click Save State. 

3. Click the softkey corresponding to the destination you want to save. 
  

Softkey Description 

State01 to 
 State08 

Save the instrument state into the state number. 

Autorec Save the instrument state as the auto recall setting. The E5071C 
is automatically configured with this state at the startup. 
  

This key saves the state into the "D:Autorec.sta". 

When Autorec.sta file is found on the D: drive at startup, the 
E5071C is automatically configured using the saved settings. To 
disable the auto recall function, delete the Autorec.sta files. 

User Pres Save the instrument state as user preset. The user can preset 
the analyzer at user saved status. 

File 
Dialog... 

Save the instrument state as your desired file name. You can 
enter a file name using the Input from the front panel buttons on 
the dialog box when storing a file. 

  If D:\Autorec.sta is found on the system at startup, 
the E5071C is automatically configured using the saved 
settings. When the external floppy disk drive is connected as A: 
drive, then if A:\Autorec.sta is found at startup, the E5071C is 
also automatically configured using the saved settings. If both 
files are found, A:\Autorec.sta is recalled. To disable the auto 
recall function, delete the Autorec.sta files. 

 An asterisk (*) in the upper right of the softkey 
indicates that the corresponding file of the softkey already 
exists. If you save into the existing file, the existing file is 
copied as backup.sta and then overwritten. 

Recall Procedure 

Follow the procedure below to recall internal data from the E5071C. 
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1.  If you recall a file that includes traces (its content was set to 
State &Trace or All when it was saved), the trigger source is 
automatically set to Manual. 

1. Press Save/Recall key. 

2. Click Recall State. 
When you want to recall State01.sta - State08.sta, Autorec.sta 

1. Press State01 - State08 or Autorec. 
When you want to recall other files 

1. Press File Dialog... to open the Open dialog box. 

2. Select the folder and the file using the external keyboard and mouse. 

3. Click Open. 

The following warning messages may appear when recall fails: 

Warning 
Message 

Note 

Model Mismatch This message is displayed when the state file of E5070B/E5071B 
is recalled by E5071C options 2D5, 4D5, 2K5 and 4K5 . 

Unsupported 
Version 

This message is displayed when the state file generated from a 
newer version of Firmware is recalled. 

Invalid No. of 
Ports 

This message is displayed when the state file generated from a 
Firmware having different Port Options is recalled. 

Source 
Attenuator 
Option Mismatch 

This message is displayed when the state file generated from a 
Firmware having different Source Attenuator Option is recalled. 

Power Sweep 
Option Mismatch 

This message is displayed when the state file generated from a 
Firmware having different Power Sweep Option is recalled. 

Invalid No. of 
Points 

This message is displayed when the Maximum No. of Points are 
not enough. 

External Test 
Set Option 
Mismatch 

This message is displayed when the state file generated from a 
Firmware having different External Test Set Option is recalled. 

Frequency 
Option Mismatch 

This message is displayed when the state file generated from a 
Firmware having different Frequency Option is recalled. 

ch x, tr y, z pts 
required 

This message is displayed when the Recall Function cannot recall 
data with maximum channel or traces. The number of 
channels/traces should be higher than the recall state file to 
recover from the error. More information is available in Setting 
upper limit of channels and traces. 
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 The warning message listed above: 
1. May not appear in all failures 
2. Appears on the screen only when recall is done from soft key 
by Recall State or Recall by File Name. 
3. Displays "Recall Failed" once when the recall is done through 
GPIB or VBA. 
4. Is not kept in Error queue. This means that when 
SCPI.SYSTem.ERRor is executed, "Recall Failed" is returned. 
5. These messages are supported for state files created in 
Firmware revision A.09.10 or later. 

 When a user file is used in Extending the Calibration 
Plane Using Network De-embedding, Determining 
Characteristics After Adding a Matching Circuit, or Determining 
the Characteristics that Result from Adding a Matching Circuit to 
a Differential Port and the setup status is saved, a recall error 
will occur if the user file is not located in the same folder as 
when the state was saved. 

 Pressing Save/Recall > Explorer executes Windows 
Explorer. This helps you to browse the files in the ENA hard disk 
drive. 

Recall Procedure Using "Recall by File Name" Feature 

You can use the recall feature with the Recall by File Name softkey for files 
you have named freely and saved in the D:\State folder. This function lets 
you recall a file you have named freely and saved by simple softkey 
operation, eliminating annoying operation using the Open dialog box. 

 Although there is no limit to the number of files 
saved in a folder, only up to 50 files are displayed on the 
softkeys. If more than 50 files are saved in a folder, they are 
sorted in the order of numbers 0 to 9 and alphabetic characters 
A to Z and the first 50 files are displayed as softkeys. 
 
Although there is no limit to the number of characters of a file 
name, only up to 12 characters are displayed on the softkey. If 
a file name exceeds 12 characters, the first 12 characters are 
displayed on the softkey and the remaining characters are 
omitted and replaced with "...". 
  

 Different files may be displayed on softkeys with the 
same name or a saved file is not displayed on any softkey 
because of the above limitations. 

1. Press Save/Recall key 



Measurement 

353 

2. Click Recall by File Name. 

3.  Files that have been named and saved in the D:\State folder are 
displayed on softkeys. Press the key for the file you want to recall. 

Priority of Recalling Configuration File at Startup 

If several instrument configuration files exist at the startup of the E5071C, 
only one file is recalled and set at a time in the following order of priority. 

If these files do not exist, the normal preset (factory preset) is executed. 

Priority Recalled file 

1 Configuration file for the auto-recall function in the A drive (If external 
floppy disk drive is connected.) 

2 Configuration file for the auto-recall function in the D drive 

3 Configuration file for the user-preset function in the D drive. Executed 
when the preset operation mode is User and the file (D:\UserPreset.sta) 
exists. 
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Saving/Recalling Instrument State for Each Channel into/from 
Memory 

 Overview 

 Saving Instrument State for Each Channel 

 Recalling Instrument State for Each Channel 

 Deleting Saved Instrument State (Clearing all Registers) 

Other topics about Data Output 

Overview 

The E5071C allows you to save/recall the instrument state for each 
channel independently. This function allows you to save the instrument 
state of the active channel independently into one of four registers (A to D, 
volatile memory) and to recall the instrument state from the register to 
restore it as the state of the currently active channel. As in the case of 
saving the entire state of the instrument into a file, you can select items to 
be saved from four kinds. 

Since you can recall the instrument state for each channel that was saved 
with this function from a different channel that the one used to save it, this 
function is very useful for copying an instrument state between channels. 

 Unlike when saving the entire instrument state, the 
instrument state for each channel is saved into volatile memory 
instead of a file, so if you turn off the power, this state is lost. 

Saving Instrument State for Each Channel 

1. Press Channel Next/Channel Prev keys to activate a channel whose 
state you want to save. 

2. Press Save/Recall key. 

3. Click Save Channel. 

4. Click one of State A to State D to save the instrument state of the 
active channel to the specified register. 

 For registers having saved data, the * symbol is 
displayed to the right of their softkey label. If you specify one of 
these, its content is overwritten. 

Recalling Instrument State for Each Channel 

1. Press Channel Next/Channel Prev keys to activate a channel 
whose state you want to recall and restore. 

2. Press Save/Recall key. 
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3. Click Recall Channel. 

4. Click the softkey of the register in which the state you want to 
restore is saved. This instrument state is recalled to the active 
channel. 

Deleting Saved Instrument State (Clearing all Registers) 

1. Press Save/Recall key. 

2. Click Save Channel. 

3. Click Clear States. The contents of all the registers are deleted. 
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Saving Trace Data to a File 

 Saving Data in CSV Format 

 Saving Data in Touchstone Format 

Other topics about Data Output 

Saving Data in CSV Format 

The E5071C allows the user to save data for the active trace on the active 
channel to a CSV file (file extension *.csv) and to load the data into PC 
application software for further processing. 

Trace data are saved in the format shown below. 
Example of saved trace data 

"# Channel 1" 

"# Trace 1" 

Frequency,                    Formatted Data,            Formatted Data 

+3.00000000000E+005, +1.41837599227E-002, +1.43446459328E-006 

+4.27985000000E+007, +1.41275293412E-002, +2.02407834551E-004 

+8.52970000000E+007, +1.41334093048E-002, +4.00643331604E-004 

+1.27795500000E+008, +1.41240661092E-002, +6.09250514670E-004 

+1.70294000000E+008, +1.41402155348E-002, +8.05620003993E-004 

The first line shows the number of the active channel at the time the data 
was saved. 

The second line shows the number of the active trace at the time the data 
was saved. 

The third line is a header line indicating the contents of each item of trace 
data written on the fourth line onward. 

The fourth line onward shows the trace data. The amount of data is 
determined by the number of points (frequency) assigned to the trace. 

Saving Trace Data 

Follow the procedure below to save trace data from the E5071C. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace to be saved. 

2. Press Save/Recall key. 

3. Click Save Trace Data to open the Save As dialog box. 

4. Select the destination folder and input a file name. 

5. Click Save to save the file. 

Saving Data in Touchstone Format 
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You can also save trace data of a E5071C active channel to a Touchstone 
format file, based on 1- to 4-port models. 

Touchstone file data format 

You can save data in "log magnitude - angle", "linear magnitude - angle", 
or "real number - imaginary number." 

When AUTO is selected, the data format is automatically set according to 
the display format of the active trace. However, when the display format of 
the active trace is set to one other than log magnitude format (LogMag), 
linear magnitude format (LinMag), or real-imaginary number format 
(Real/Imag), the data format is automatically set to real-imaginary 
number. 

You can use data saved in Touchstone format for a circuit simulator such 
as Agilent Advanced Design System (ADS) on your PC (personal computer) 
or workstation. For more information on the ADS, refer to the operation 
manual that comes with the system. 

 The fixture simulator function enables you to recall 
to the E5071C the s2p (2-port Touchstone file) file type used to 
save user-defined matching circuit information. However, no 
other type of file saved in Touchstone format can be recalled to 
the E5071C. 

 The port reference impedance value when outputs 
the touchstone format file has to be the same impedance value 
(real) to every measurement port. 

 You can output the measurement result when using 
complex port impedance conversion, or when setting different 
port impedance at each port. However, the touchstone file is 
valid only when the same impedance value (real) to every 
measurement port is used. 
When you recall the file saved with above condition, the file is 
recalled as single normalized reference Z0 defined at option 
line, and it provides in-consistency result.  

File types of Touchstone files 

File types of the E5071C Touchstone files are s1p, s2p, s3p, and s4p. The 
file type indicates the number of ports of the data structure that is output 
to the Touchstone file. 

Data structure in Touchstone file 

Data structure of the Touchstone file consists of a header part and a data 
part. The contents of the file is text data, which is ready to be read with a 
general text editor. 

The header part consists of the comment line and option line. 
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 Comment line is preceded by an exclamation mark (!), and includes 
returned value of *IDN?, file created date, calibration state, list of all 
S parameters of a specified port, and port impedance setting when 
saving the data.  

 Option line includes format information. 

The header parts of s1p and s4p are shown below. 

Header of s1p 

!Agilent Technologies,E5071B,<ID>,<FW Revision> 
!Date <Date> 
!Data & Calibration Information 
!Freq Sww:Method(Stat) 
!PortZ PORTw:R+jX 
!Above PortZ is port Z conversion or system Z0 setting when saving the data. 
!When reading, reference impedance value at option line is always used" 
# Hz S FMT R Z0 

Header of s4p 

!Agilent Technologies,E5071B,<ID>,<FW Revision> 
!Date <Date> 
!Data & Calibration Information 
!Freq Sww:Method(Stat) Sxw:Method(Stat) Syw:Method(Stat) Szw:Method(Stat) 
. 
. 
!PortZ PORTw:R+jX       Portx:R+jX      Porty:R+jX      Portz:R+jX 
!Above PortZ is port Z conversion or system Z0 setting when saving the data. 
!When reading, reference impedance value at option line is always used" 
Swz:Method(Stat) Sxz:Method(Stat) Syz:Method(Stat) Szz:Method(Stat) 
# Hz S FMT R Z0 

Comment line 

Touchstone data files include comments. Comments are preceded by an 
exclamation mark (!). 

Each item has the following meaning: 

Parameter Description 

Sww to Szz S parameters of the selected test port; corresponds in ascending 
order, beginning with w to z. 

Method Calibration type applied to S parameter. 

Stat 

  

State of S parameter calibration and error correction setting (ON, 
OFF, or --) 

ON = Error correction is set to ON 
OFF =Error correction is set to OFF 
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-- = Calibration is not performed 

PORTw to 
PORTz:  

Single-end port impedance setting when saving the data. This is not 
valid when reading the file. When reading, the reference impedance 
value Z0 at option line is always used. 

  

Option Line 

The option line is formatted as follows. 

# Hz S FMT R Z0 

Parameter Description 

FMT Data format 

RI = Real number - imaginary number 
MA = Linear magnitude - angle 
DB = Log magnitude - angle 

Z0 Reference impedance value 

  

The structure of the data part depends on the combination of the selected 
file type and specified port. 

  When the S parameter of a port on which calibration 
is not performed is specified, if data measured with the S 
parameter exists, that data are output to a Touchstone file. If 
no measurement data exists, 0 (for log magnitude - angle, log 
magnitude = -200 dB) is output in the corresponding field. 

The following figures show the data structures of files saved in Touchstone 
format. 

1-port Touchstone file 
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 2-port Touchstone file 

 
  

 3-port Touchstone file 
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 4-port Touchstone file 

 
Restrictions when saving data in Touchstone format 

The following restrictions apply when saving measurement data into 
Touchstone format. 
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 When both fixture simulation and port impedance conversion are on, 
all Z0 of the ports to be saved must be set to the same value. If Z0 
is different among the ports, no error occurs, but only the Z0 of the 
smallest port number is output to the header. 

 When the time domain function is on, the saved data are not the 
displayed data but the data of the S parameter before conversion. 

 For data saved in touchstone format, data operation, time domain, 
parameter conversion, data format, electrical delay, equation editor, 
and smoothing are not reflected in the output data. 

 An error occurs when attempting to save data that use the frequency 
offset function. 

Saving procedure 

Follow the steps below to save trace data in Touchstone format. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to select the trace to be saved. 

2. Press Save/Recall key. 

3. Click SnP > SnP Format. 

4. Click the softkey that corresponds to the data format you want to 
save. 
  

Softkey Function 

Auto Data format is automatically set according to the display 
format of the active trace. When the display format of the 
active trace is set to one other than log magnitude format 
(LogMag), linear magnitude format (LinMag), or real-
imaginary number format (Real/Imag), the data format is 
automatically set to real-imaginary number. 

LogMag/Angle Select "log magnitude - angle" data format 

LinMag/Angle Select "linear magnitude - angle" data format 

Real/Imaginary Select "real - imaginary number" data format 

5. Click the softkey for s1p, s2p, s3p, or s4p according to the file type 
you want to save. 

6. Click the softkey that corresponds to the combination of ports that 
you want to save. For example, when pressing s3p in Step5, softkeys 
displayed are 1-2-3, 1-2-4, 1-3-4, and 2-3-4. If you want to save the 
data of the channel for which port 1, port 2, and port 4 are 
measured, press 1-2-4. 
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7. SaveAs dialog box opens. For its operations, use an external 
keyboard and mouse. 

8. Specify the folder to which the file should be saved, enter a file 
name, and then press Save to save the file. 

 When saving data in a sweep process, the data 
during sweep is saved into a Touchstone file. That is, the 
previous sweep data is saved as data that has not been swept; 
or, if sweep was not performed previously, zero data might be 
saved. Therefore, you should set the active channel to the HOLD 
state when saving data into a Touchstone file. 
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Saving the Screen Image to a File 

 Overview 

 Saving Screen Image as File 

Other topics about Data Output 

Overview 

Along with printing, the E5071C allows the user to save screen images as 
bitmap (.bmp) or portable network graphics (.png) files. Saved files can be 
loaded into PC application software for further processing. 

Saving Screen Image as File 

Follow the procedure below to save a screen image to a file. 

1. Display the screen to be saved as a file. If you want to save the 
screen with a white background, set the display mode to inverted 
display before saving the screen. For details about display mode, see 
Setting Display Colors. 

2. Press System key. The screen image at the time System key is 
pressed is the image that will be saved. 

3. Press Dump Screen Image to open the Save As dialog box. "Bitmap 
Files (*.bmp)" or "Portable Network Graphics (*.png)" can be 
selected as the file type. 

4. Select the file type. 

5. Select the destination folder and type a file name. 

6. Press Save to save the screen image of E5071C to a file. 
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Printing Displayed Screen 

 Overview 

 Printed/Saved Images 

 Print Procedure 

Other topics about Data Output 

Overview 

By connecting a printer to the USB port of the E5071C, you can print the 
displayed screen of the E5071C. 

Printed/Saved Images 

The display image saved in the volatile memory (clipboard) is 
printed/saved. If no image is saved in the clipboard, the image displayed 
at the time of print execution is printed/saved. 

Saving image to clipboard 

The System key also has a screen capture feature. When you press System 
key, the image displayed on the screen immediately before pressing is 
saved in the clipboard. 

 The image in the clipboard is cleared when you 
execute print/save. 

Print Procedure 
Preparation before printing 

Follow these steps to prepare for printing: 

1. Turns off the E5071C. 

2. Turn on the printer and connect it to E5071C. 

3. Turn on the E5071C. 

4. Press System key. 

5. Press Printer Setup. The Printers window opens. The icons of the 
printers that have been connected are displayed in the window. 
When you connect a print for the first time, it is automatically 
registered and its icon is added in the window. 

6.  The printer with the check mark ( ) on its icon is selected as the 
default printer for printing. If you want to change it, select 
(highlight) the icon of your preferred printer in the Printers window 
and then click Set as Default Printer in the File menu. 

7. Click Printing Preferences...  in the File menu. The Printing 
Preferences dialog box for the selected printer appears. Set items 
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necessary before printing such as Page Size and then click the OK 
button . 

8. Click Close in the File menu. 
Executing print 

Follow these steps to print the screen information: 

1. Display the screen you want to print. 

2. Press System key to save the currently displayed screen onto the 
clipboard. 

3. As necessary, press Invert Image to toggle between [OFF] for 
printing in colors close to the actually displayed screen and [ON] for 
printing in inverse colors. 

4. Click Print to start printing. 

5. To cancel the printing in progress, press Abort Printing. 

  If you start printing when the printer is not ready 
(for example, it is not turned on) by mistake, the Printers Folder 
dialog box  may appear. In this case, click Cancel to close the 
Printers Folder dialog box, prepare your printer, and then start 
printing again. 
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Optimizing Measurements 

Optimizing Measurements 

 Expanding Dynamic Range 

 Reducing Trace Noise 

 Improving Phase Measurement Accuracy 

 Improving Measurement Throughput 

 Performing Segment-by-Segment Sweep (segment sweep) 

 Setting Shift LO 
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Expanding Dynamic Range 

 Overview 

 Lowering Receiver Noise Floor 

Other topics about Optimizing Measurement 

Overview 

The dynamic range is the finite difference between the maximum input 
power level and the minimum measurement power level (noise floor) of 
the analyzer. In evaluating a characteristic accompanied by a large change 
in the amplitude (the pass band and stop band of a filter, for example), it 
is important to increase the dynamic range. 

Lowering Receiver Noise Floor 

Lowering the noise floor of the receiver enables you to expand the dynamic 
range. The following methods can be used to lower the receiver noise floor. 

  Narrowing the IF bandwidth 

 Turning on Sweep Averaging 
Narrowing the IF bandwidth 

Narrowing the receiver IF bandwidth enables you to reduce the effect of 
random noise on measurements. Narrowing the IF bandwidth to 1/10 the 
original bandwidth causes the receiver noise floor to decrease by 10 dB. 
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To specify the IF bandwidth, follow the steps described below. 

1. Press Channel Next/Channel Prev keys to select a channel on which to 
specify the IF bandwidth. 

2. Press Avg key. 

3. Click IF Bandwidth, then  Change the IF bandwidth in the data entry 
area. 

Turning on Sweep Averaging 

Using sweep averaging also enables you to reduce the effects of random 
noise on measurements. 

Sweep averaging averages data from each point (vector quantity) based 
on the exponential average of a continuous sweep weighted by the 
averaging factor specified by the user. Sweep averaging is expressed in 
following equation. 

 
where: 
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 An = Result of the calculation of sweep averaging for the nth sweep 
operation at the point in question (a vector quantity) 

 Sn = Measurement value obtained at the nth sweep operation at the 
point in question (a vector quantity) 

  F = Sweep averaging factor (an integer between 1 and 999) 

 
Define the sweep averaging by following the steps below. 

1. Press Channel Next/Channel Prev keys to select the channel on which 
you want to define the sweep averaging. 

2. Press Avg key. 

3. Click Avg Factor, then change the averaging factor in the data entry 
area. 

4. Click Averaging to turn ON the averaging. 

5. Clicking Averaging Restart resets n to 1 in Sweep Averaging 
equation in Turning on Sweep Averaging 



Measurement 

371 

 

Reducing Trace Noise 

Any of the following methods can be used to lower the trace noise. This 
section provides the description of Turing on Smoothing. 

 Turning on Smoothing 

 Turning on Sweep Averaging 

  Narrowing IF Bandwidth 

Other topics about Optimizing Measurements 

Turning on Smoothing 

Smoothing can be used to reduce noise that has relatively small peaks. By 
turning on smoothing, the value of each point on a trace is represented by 
the moving average over the values of several nearby points. The 
smoothing aperture (percentage of sweep span) defines the range of 
points to be included in the calculation of the moving average. 

 You can define the smoothing trace by trace. 
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Setting up smoothing 

Set up the smoothing operation by following the steps below: 

1.  Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace on which smoothing will be defined. 

2. Press Avg key. 

3. Click Smo Aperture, then  change the smoothing aperture (%) in the 
data entry area. 

4. Click Smoothing to turn ON smoothing. 



Measurement 

373 

 

Improving Phase Measurement Accuracy 

This section describes the following functions that can be used to improve 
phase measurement accuracy. 

 Electrical Delay 

 Velocity Factor 

 Phase Offset 

 Port Extensions and Loss Values 

Other topics about Optimizing Measurements 

Electrical Delay 

Electrical Delay is a function that adds or removes a pseudo-lossless 
transmission line with a variable length corresponding to the receiver 
input. Using this function enables you to improve the resolution in phase 
measurement and thereby measure deviation from the linear phase. You 
can specify the electrical delay trace by trace. Depending on the media 
type, the calculation method of the electrical delay, which is required to 
correct the phase delay, differs. 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the phase trace for which you want to specify the 
electrical delay. 

2. Press Scale key. 

3. Click Electrical Delay. 

4. Change the electrical delay (in seconds) in the data entry area. 

5. Click Media, and select a media type for calculating the electrical 
delay. If the electrical delay is 0 second, the calculation result is 
always the same regardless of media type. 
  

Softkey    Function 

Coaxial Selects Coaxial as the media type. 

Waveguide Selects Waveguide as the media type. 

6. If you have selected Waveguide as the media type, click Cutoff 
Frequecy, and specify a cutoff frequency. 

7. The cutoff frequency is available only when the media type is 
Waveguide. 



E5071C 

374 

For how to determine the deviation from a linear phase, see Measuring the 
Deviation from a Linear Phase. 

Procedure using marker 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to set the electrical delay. 

2. Place the active marker in an appropriate position. 

3. Press Maker Fctn. 

4. Click Marker -> Delay to set the electrical delay to the group delay 
value at the position of the active marker (a value smoothed with the 
aperture of 20% regardless of the smoothing setting). 

Phase offset 

Phase offset is a function used to add or subtract a predetermined value 
relative to the frequency to and from the trace. Using this function enables 
you to simulate the phase offset occurring as a result of, say, adding a 
cable. 

The phase offset can be specified from - 360° to +360° . 
Using the Phase Offset Function 

1. Press Channel Next/Channel Prev keys and Trace Next/Trace prev keys 
to activate the trace for which you want to specify the phase offset. 

2. Press Scale key. 

3. Click Phase Offset, then enter the phase offset (° ) in the data entry 
area. 

Velocity factor 

The velocity factor is the ratio of the propagation velocity of a signal in a 
coaxial cable to the propagation velocity of that signal in free space. The 
velocity factor for a common cable is about 0.66. The propagation velocity 
depends on the dielectric constant (εr) of the dielectric substance the 
cable. 

 
By specifying the velocity factor, you can match the equivalent length (in 
meters) appearing in the data entry area to the actual physical length 
when using the Electrical Delay or Setting port extensions to specify the 
electrical delay (in seconds). 

You can define the velocity factor channel by channel. 
Using the velocity factor 

1.  Press Channel Next/Channel Prev keys to activate the channel for 
which you want to specify the velocity factor. 
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2. Press Cal key. 

3. Click Velocity Factor, then the velocity factor in the data entry area. 

Port Extensions and Loss Values 
Setting port extensions 

Port Extension is a function for moving the calibration reference plane by 
specifying the electrical delay. This function is useful, for example, when 
you cannot directly perform calibration at the DUT terminal because the 
DUT is inside the test fixture. In such a case, this function enables you to 
first perform calibration at the test fixture terminal and then move the 
calibration plane to the DUT terminal by extending the port. 

Port extension corrects the electrical delay of each test port (phase shift) 
only. It cannot remove errors caused by the loss in and incorrect matching 
of cables, adapters, or test fixtures. 

 You can define port extension channel by channel. 
Setting port extension for one particular channel does not affect 
other channels. 

 Auto Port Extension does not supports waveguide 
port extension. 

Operational procedure 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set port extension. 

2. Press Cal key. 

3. Click Port Extensions, and then Select Extension Port 1/2/3/4. 

4. Specify Loss values by clicking Loss. 
Setting coaxial delay, waveguide delay and cut off frequency 

Follow the steps below to set coaxial or waveguide delay: 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set port extension. 

2. Press Cal key. 

3. Click Port Extensions. 
  

Softkey Function 

Auto Port Extension Sets the Auto Port Extension 

Extension Port 1 Sets port extension (in seconds) for test port 1. 

Extension Port 2 Sets port extension (in seconds) for test port 2. 
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Extension Port 3 Sets port extension (in seconds) for test port 3. 

Extension Port 4 Sets port extension (in seconds) for test port 4. 

4. Click Extension Port n where n can be from 1 to 4. 

5. Click Waveguide to set delay in sec. 

6. Click Cutoff Frequency to set cut off frequency of selected port. 

7. Click Coax. Extension to set the coaxial extension in sec. 

8. If you want to use waveguide port extension, then setting of 
coaxial delay is not necessary. If only waveguide measurement 
is needed, coaxial delay should be set to zero. Coaxial extension 
value should be set while measuring adapters between coaxial 
and waveguide. 

Waveguide delay and Cut off frequency can be set using the following 
commands: 

SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).WAVeguide.TIME 

SCPI.SENSe(Ch).CORRection.EXTension.PORT(Pt).WAVeguide.CUToff 

 System Z0 should be changed to 1 ohm before 
calibration when using waveguide calibration kit and measuring 
waveguide devices. 

 Some calibration kits such as the waveguide 
calibration kit have operational frequency range defined by 
Minimum and Maximum frequency. When the E5071C stimulus 
setting is out of the operational frequency range, you cannot 
click Done key or finish the calibration by remote control. In this 
case, use a calibration kit that has proper frequency range, or 
change the E5071C stimulus setting to proper range that the 
calibration kit can cover. Refer to the calibration kit manual or 
definition in the E5071C with Cal > Modify Cal Kit > Define STDs 
for the Maximum & Minimum frequency of the calibration kit. 

Setting loss values 

In addition to port extension, you can set loss values for each port. By 
correcting loss due to port extension, more accurate measurement results 
are obtained. 

There are two types of loss value settings: loss values at two frequency 
points for a specified port, and a DC loss value. You can make these 
settings at the same time for each port. 

 You can set loss values channel by channel. Setting 
loss values for one particular channel does not affect other 
channels. 
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1. Setting loss values 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set loss values. 

2. Press Cal key. 

3. Click Port Extensions. 

4. Click Extension Port n where n can be from 1 to 4. 

5. Click Loss to set a loss value. 

6. Click Loss1 [OFF] to toggle to Loss1 [ON] (enabled), and enter a loss 
value (Loss1) and a frequency (Freq1). 

7. If you want to set loss at two frequency points, press Loss2 [OFF] to 
toggle to Loss [ON] (enabled), and enter a loss value (Loss2) and a 
frequency (Freq2). 

8. If you want to set loss values for other ports, repeat steps 4 to 6. 

 Expression to calculate loss using Loss 1: 
 

 
  Expression to calculate loss using Loss 1 and Loss 2: 

 

 
 When you specify two frequency points, set the 

lower frequency to Loss1, and the higher one to Loss2. 

2. Setting a DC loss value 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set DC loss values. 

2. Press Cal key. 

3. Click Port Extensions > Loss. 
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4. Click Select Port to select the port for which you want to set a DC loss 
value. 

5. Click Loss at DC, then enter a DC loss value. 

6.  If you want to set a DC loss value for other ports, repeat steps 4 to 
5. 

Enabling port extensions and loss values 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to enable port extension. 

2. Press Cal key. 

3. Click Port Extensions. 

4. Turn on Extensions. 
Using the auto port extension function 

The auto port extension function measures port extension and loss values 
for each port using the OPEN/SHORT standard connected to the port, 
automatically calculates them, and set them. 

Softkey Function 

Auto Port Extension Select Ports Sets the Ports (1 to 4) 

Measure OPEN Performs a OPEN measurement 

Measure SHORT Performs a Short measurement 

Method Sets the Span 

Include Loss Sets Loss ON/OFF 

Adjust Mismatch Sets Adjust Mismatch ON/OFF 

   

When the auto port extension function is completed, the port extensions 
and loss values are updated to the calculated values. 

  You can use both open and short measurement values in the 
auto port extension function. Note that in this case, the average 
value of the calculation results is used for updating. 

 You can set the auto port extension function channel by 
channel. Setting the auto port extension function for one 
particular channel does not affect other channels. 

 When the sweep type is power sweep or the frequency offset 
function is ON, the auto port extension is not available. 

 Auto Port Extension does not supports waveguide port 
extension. 
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1. Selecting a port(s) 

Select the port(s) for which you want to use the auto port extension 
function. 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set auto port extension. 

2. Press Cal key. 

3. Click Port Extensions > Auto Port Extension > Select Ports to select 
the port(s) for which you want to use the auto port extension 
function. 

2. Setting frequencies used for calculation 

Set the frequency points with which you want to calculate a loss value. 

1. Press Channel Next/Channel Prev keys to activate the channel to set 
auto port extension. 

2. Press Cal key. 

3. Click Port Extensions > Auto Port Extension > Select Ports > Method 
to set the frequencies used for calculation. 
 
  

Softkey Function 

Current 
Span 

Executed using the frequency range set currently. 

Active 
Marker 

Executed using the frequency at the active marker. In this case, 
the result is applied to Loss1. Loss2 is ignored. 

User Span Executed using a start value and a stop value you set. 

4. If you have selected User Span, use User Span Start and User Span Stop 
to set a start value and a stop value. 

5. For Current Span and User Span, a frequency point at 1/4 of the 
frequency range is set to Freq1; a frequency point at 3/4 of the 
frequency range is set to Freq2. 
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6. If the setting is not made before starting OPEN/SHORT standard 
measurement, it does not affect the calculation result. 

 

3. Specifying a loss value as a calculation target 

Specify whether you want to include a loss value in the calculation result. 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set auto port extension. 

2. Press Cal key. 

3. Click Port Extensions > Auto Port Extension > Select Ports > Include 
Loss to turn it on. 

 If the setting is not made before starting the 
measurement of the OPEN/SHORT standard, it does not affect 
the calculation result. 

4. Specifying a DC loss value as a calculation target 

Specify whether you want to include a DC loss value in the calculation 
result. 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to set auto port extension. 

2. Press Cal key. 

3. Click Port Extensions > Auto Port Extension > Adjust Mismatch to turn 
it on. 
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 If the setting is not made before starting the 
measurement of the OPEN/SHORT standard, it does not affect 
the calculation result. 

5. Measuring the OPEN/SHORT standard and executing calculation 

Calculate port extensions and loss values based on the calculation results 
using the OPEN/SHORT standard. 

1. Press Channel Next/Channel Prev keys to activate the channel for 
which you want to want to set auto port extension. 

2. Press Cal key. 

3. Click Port Extensions > Auto Port Extension. 

4. If you use the OPEN standard, click Measure OPEN, and select the 
port(s) for which you want to execute measurement. Execution is 
restricted to ports selected in Selecting a port(s) 

5. If you use the SHORT standard, click Measure SHORT, and select the 
port(s) for which you want to execute measurement. Execution is 
restricted to ports selected in Selecting a port(s). 

 If a port extension value or loss value has been set, 
the value is updated to the calculated result. 

 If you execute both open measurement and short 
measurement, the average of the calculation results is reflected 
to the port extension and loss value. 

6. Deleting the result of open/short measurement 

When you exit from the softkey menu in the same level after open/short 
measurement, the measurement results are deleted. Note that you can use 
a GPIB command. 

  Port extension and loss values that have been 
calculated are not cleared. 
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Improving Measurement Throughput 

This section explains the methods to improve measurement throughput. 

 Change Sweep Mode 

 Turning OFF the updating of information displayed on the LCD screen 

 Turning OFF system error correction 

 Turning ON the Fixed RF Range  

Other topics about Optimizing Measurements 

Change Sweep Mode 

The E5071C provides the two sweep modes: Stepped Mode and Swept 
Mode. 

Mode Stepped Swept 

Measurement 
Reliability 

High Low 

Sweep Time Long Short 

Restrictions on 
measurement 

No Particular 
restriction 

DUT with long electrical delay cannot 
be measured correctly. 

Procedure to select the sweep mode 

1. Press Sweep Setup key. 

2. Click Sweep Mode. 

3. Select Stepped or Swept for your appropriate sweep mode. 
Overview 

In the stepped mode, the frequency is changed stepwise and sampling is 
performed at a fixed frequency for each measurement point. On the other 
hand, in the swept mode, sampling is performed with the frequency always 
swept for each measurement point. 
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In the stepped mode, a certain time should be allowed until the frequency 
becomes stable at each measurement point, since the frequency is 
changed stepwise. Therefore, the sweep time in the swept mode is 
generally shorter than that in the stepped mode. However, if the 
measurement point interval is extremely large, the sweep to the next 
measurement point frequency cannot be completed within the sampling 
time due to the limitations of the instrument's frequency sweep speed. This 
causes a certain waiting time until the start of measurement of the next 
measurement point, and thus in this case the swept mode actually has a 
longer sweep time. 

Although there is some difference depending on the IF bandwidth setting, 
when the measurement point interval is approximately 30 MHz or less, the 
sweep time in the swept mode is shorter than that in the stepped mode. 

When you use the swept mode, you should confirm that there is no 
measurement-related problem before performing the actual measurement. 

 The swept mode has the following disadvantages. 

 DUTs with long electrical delay time cannot be measured correctly. 
For more information, refer to Notes for measuring DUTs with long 
electrical delay time 

 Trace noise may increase compared to the stepped mode because 
sampling is performed while sweeping the frequency. 

 The specifications are not guaranteed 
Notes for measuring DUTs with long electrical delay time 
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When sweeping the frequency of a signal applied to the DUT (F), there is a 
frequency difference between the input side and output side of the DUT 
due to the delay time that occurs in the DUT (Delta T). This frequency 
difference (Delta F) becomes larger as the electrical delay time of the DUT 
becomes longer and the frequency sweep speed becomes faster, as shown 
in the following equation. 

 
When measuring a DUT with long electrical delay time, if you perform 
measurement (sampling) while sweeping the measurement signal as in the 
swept mode, a measurement error occurs due to the difference between 
the frequency outputted from the source port and the frequency actually 
measured at the receiver port. 

Therefore, when measuring a DUT with a long electrical delay time, 
generally use the stepped mode to prevent the measurement error 
described above. However, if you need to shorten the sweep time, 
evaluate the measurement error as described below to determine the 
sweep mode that should be used. 

Turning OFF the updating of information displayed on the LCD screen 

If you are using the E5071C with HDD revision CFxxx or CNxxx, turning 
OFF the updating of information displayed on the LCD screen eliminates 
the processing time required to update displays within the analyzer, 
improving measurement throughput. If it is not necessary to check 
displayed information during measurements, turning OFF real-time 
updating is an effective means of improving throughput. 

The updating of information displayed on the LCD screen can be switched 
using the following procedure: 

Turning OFF the updating of information 

1. Press Display key. 

2. Click Update to switch the updating of displayed information on the 
LCD screen ON/OFF. 

When the LCD screen update is turned OFF, Update Off appears on 
Instrument Status Bar. 

For HDD revision CHxxxx, turning OFF the information update on the LCD 
screen does not contribute to any improvement in measurement 
throughput.  

Turning OFF system error correction 

The E5071C executes Port Characteristics Correction in the data processing 
flow shown in Data Processing Flowchart, by using the system calibration 
data set at the factory. This system error correction process is not required 
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if the user performs proper calibration by using the Cal key and the 
softkeys that subsequently appear, which automatically turns on error 
correction. 

By turning OFF system error correction, you can reduce the data 
processing time needed during measurement and thus improve 
measurement throughput. 

 When you turn ON/OFF system error correction, all 
calibration data set by user calibration is deleted. 

1. Press System key. 

2. Click Service Menu > System Correction. 

 
3. Click OK to turn ON/OFF system error correction. 

Turning ON the Fixed RF Range 

The E5071C sets proper RF ranges of all test ports prior to every sweep. 
When you turn RF Range Fixed mode ON, the E5071C fixes RF ranges of all 
test ports so that it reduces 2 ms per each sweep from setting time before 
the measurement. This reduction will not be displayed in Sweep Time, 
though you can verify it by monitoring Handler I/O signals or *OPC? query.  

This setting is available at the firmware revision A.11.00 or higher. 

To turn ON/OFF the RF ranging, follow the below procedure: 
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1. Press System key. 

2. Click Service Menu > RF Range Fixed. 

3. Toggle between the ON and OFF selection. When ON is selected,setting 
time is shortened by 2ms. This setting is applied to all the channels. 

 This function is applicable for the E5071C with maximum 
frequency option of 8.5 GHz and below (option x4x/x6x/x8x). 

 This function does not reduce setting time when you use 
the E5091A/92A with the E5071C, though it is possible to turn 
ON/OFF this function. 

 If the RF Range Fixed mode status is changed after a 
calibration is performed, the calibration data will be useless and C! 
will be displayed. See Checking Calibration Status for details.  In this 
case, it is strongly recommended to perform a calibration again. 

 Turning ON this function may degrade some analog 
performances such as dynamic range. See the data sheet for detail. 
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Performing a Segment-by-Segment Sweep 

This section describes the concept of the segment sweep and how to 
perform it. 

 Concept of Segment Sweep 

 Conditions for Setting Segment Sweep 

 Items that can be set for Each Segment 

 Sweep Delay/Sweep Time in Segment Sweep 

 Turning ON/OFF Segments Individually 

 Frequency/Order Base Display 

 Arbitrary Segments 

 Setting Segment Sweep Procedure 

Other topics about Optimizing Measurements 

Concept of Segment Sweep 

To perform a segment sweep, you must define two or more frequency 
ranges, called segments, and then specify the number of points, IF 
bandwidth, power level, sweep mode, sweep delay time, and sweep time 
for each segment. All segments are swept sequentially as if swept in one 
sweep operation. 

 By skipping the frequency range, which does not 
need to be measured, you can sweep and measure only the 
portions you need. 

 You can define the optimum measurement conditions 
for each of the segments you designate. For example, you can 
specify as many points as possible in a segment requiring high 
trace resolution and as few points as possible in a segment not 
requiring high resolution. This shortens the measurement time, 
enabling you to optimize the overall measurement throughput 
by not having to perform the entire operation under the same 
measurement conditions of a particular frequency range. 

To evaluate a band pass filter having the transmission characteristics 
shown in the following figure. for example, you can select the frequency 
ranges you need from A through G and determine the measurement 
conditions shown in the table below This enables you to measure them 
simultaneously in one sweep operation. 
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Frequency ranges (segments) from the figure above and their measurement 
conditions 

  Start 
frequenc
y 

Stop 
frequenc
y 

Numbe
r of 
points 

IF 
Bandwidt
h 

Sweep 
mode 

Stat
e 

Shif
t LO 

A 440 MHz 915 MHz 50 50 kHz Steppe
d 

ON OFF 

B 915 MHz 980 MHz 130 70 kHz Steppe
d 

ON OFF 

C 980 MHz 1.035 
GHz 

60 50 kHz Steppe
d 

ON OFF 

E 1.07 GHz 2 GHz 100 70 kHz Swept ON OFF 

G 2.6 GHz 3 GHz 40 70 kHz Swept ON OFF 

Conditions for Setting Segment Sweep 

The following conditions apply when setting up a segment sweep. 

 The frequency range of a segment must not overlap with that of 
another segment. (The start frequency of a segment must be higher 
than the stop frequency of the immediately preceding segment). 

 The start frequency of segment 1 must be greater than lowest 
frequency and the stop frequency of the last segment less than 
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highest frequency, as per the frequency range depending on the 
option. 

 When the start frequency and stop frequency of a segment are not 
the same, you can define from 2 to 1601 points in a segment. 

 When the start frequency and stop frequency of a segment are the 
same, you can define from 1 to 1601 points in a segment. 

 You can set the total number of points in the segment table from 2 
to 1601. 

 You can set the number of segments in the segment table to 
between 1 and 201. 

 You can turn ON or OFF segments. 

 You can turn ON or OFF the Shift LO. 

Items that can be set for Each Segment 

For the segment sweep, you can set the sweep range, the number of 
points, IF bandwidth, power level, sweep delay time, sweep mode, sweep 
time and segment ON/OFF for each segment. 

You can set the items in the following table to ON/OFF for each segment. If 
you enable the segment-by-segment setting, you can make the setting for 
each segment in the segment table; if you disable it, the setting in the 
following table is used. 

Item When segment-by-segment setting is disabled 

IF 
bandwidth 

For all segments, the IF bandwidth for the linear/log sweep (set with 
Avg key > IF Bandwidth) is set. IF bandwidth can be set independently 
for each port in the segment sweep.  

Power level For all segments, the power level for the linear/log sweep (set with 
Sweep Setup key > Power) is set. Power level can be set independently 
for each port in the segment sweep.  

Sweep delay 
time 

For all segments, 0 is set. 

Sweep mode For all segments, the sweep mode for the linear/log sweep (set with 
Sweep Setup key > Sweep Mode) is set. 

Sweep time For all segments, the auto sweep time mode is set. 

Segment 
ON/OFF 

For all segments, ON is set. 

Shift LO For all segments, OFF is set. 

Sweep Delay/Sweep Time in Segment Sweep 
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The definitions for sweep delay time and sweep time, which you can 
specify in the segment sweep, are shown in figure below. 

  

 
Turning ON/OFF Segments Individually 

From the firmware revision A.09.60, each segment can be turned ON or 
OFF individually. The minimum number of points turned ON must be 2. 

If the total number of points turned ON are less than 2, the segments with 
the highest frequency ranges is automatically turned ON to meet the 
minimum number of points.  

Frequency/Order Base Display 

You can choose between frequency-based and order-based display as the 
method of displaying traces when executing a segment sweep. 
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Arbitrary Segments 

With this function, the segments can have the below features: 

 Overlapping frequencies 

 The stop frequency is less than the start frequency (reverse sweep).  

However, there are several limitation: 

 Sweep mode: Stepped only. 

 Sweep time: When reverse sweep is performed, the sweep time and 
the wait time before the measurement point becomes longer. 

 Segment display: It is recommended to use Order Base Segment 
Display (Sweep Setup > Segment Display > Order Base) as the 
Frequency Base Segment Display may cause incorrect results. 

You can turn ON arbitrary segments by following the steps below: 

1. Press Sweep Setup> Edit Segment Table > Arbitrary Segments > ON. 

 Unusual results may occur when using arbitrary segments 
with markers, display settings, limit lines, formatting and some 
calibration features.  

 When the segment table has both forward and reverse 
frequency sweep, the correction interpolation may not work properly. 
Use the same segment table setting at both, correction and 
measurement. (Make a measurement at the condition where "Cor" is 
displayed.) 

 When the number of data of segment table exceeds its 
limitation, the error of "Segment Data Overflow" occurs. In this case, 
reduce the measurement data size (i.e. NOP, number of channels). 

Procedure 
Creating a segment table 

1. Press Channel Next/Channel Prev keys to select the channel for which 
you want to create the segment table. 

2. Press Sweep Setup key. 

3. Click Edit Segment Table. The segment table appears in the lower part 
of the screen. 

4. To change the frequency range setting mode or to set the IF 
bandwidth, power level, sweep delay time, sweep mode, sweep time 
for each segment, and segment ON/OFF use the following softkeys. 

 When setting the segment table using the front 
panel keys or keyboard, you need to place focus on 
(select) the operation target (segment table of softkey) 
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first. You can change the focus by pressing Focus key in 
the ENTRY Block. When the focus is placed on the 
segment table, the window frame of the segment table is 
displayed as bright as the window frame of the active 
channel. When the focus is placed on the softkey menu, 
the softkey menu title area is displayed in blue. 
  

Softkey Function 

Freq 
Mode 

Switches the frequency range setting mode (start/stop or 
center/span). 

List IFBW Toggles ON/OFF the IF bandwidth setting for each segment; the row 
for setting (IFBW) only appears in the segment table when this is 
ON. 

List 
Power 

Toggles ON/OFF the power level setting for each segment; the row 
for setting (Power) only appears in the segment table when this is 
ON. 

 If you toggle List Power ON, the linear/log sweep 
(set with Sweep Setup > Power) setting is ignored.  

List Port 
Power 

Toggles ON/OFF the port power level setting for each segment; the 
rows for setting (Power 1  to Power 2 or Power 4) only appears in the 
segment table when this is ON. 

 When both List Power and List Port Power is 
turned ON, the older setting is turned OFF automatically.   

List Delay Toggles ON/OFF the sweep delay time setting for each segment; the 
row for setting (Delay) only appears in the segment table when this 
is ON 

List 
Sweep 
Mode 

Toggles ON/OFF the sweep mode setting for each segment; the row 
for setting (Sweep Mode) only appears in the segment table when 
this is ON 

List Time Toggles ON/OFF the sweep time setting for each segment; the row 
for setting (Time) only appears in the segment table when this is ON 

List State Toggles ON/OFF the state of each segment; the row for setting 
(State) only appears in the segment table when this is ON 

List Shift 
LO 

Toggles ON/OFF the Shift LO setting for each segment; the row for 
setting (Shift LO) only appears in the segment table when this is ON 

List Port 
IFBW 

Toggles ON/OFF the IF bandwidth setting of the sweep stimulated 
from port X (X =  1 to 2, or to 4) for each segment. For example, 
"IFBW 2" refers to the IF bandwidth of the sweep stimulated from 
Port 2. The rows for setting (IFBW 1 to IFBW 2 or IFBW 4) only 
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appears in the segment table when this is ON. The below conditions 
should be met. In the event the conditions are not met, the 
conditions will be changed automatically: 

Sweep Mode: Stepped 
Sweep Time: Auto 
Minimum Frequency: 6.26 MHz 

 When both List IFBW and List Port IFBW is turned 
ON, the older setting is turned OFF automatically.  

5. Enter each item in the following table for each added segment (line) 
to create the segment table. To create the segment table, use the 
hardkeys and softkeys. 
  

Start Sets the start value of the sweep range 

Stop Sets the stop value of the sweep range 

Center Sets the center value of the sweep range 

Span Sets the span value of the sweep range 

Points Sets the number of points 

IFBW Sets the IF bandwidth 

Power Sets the power level; the power range is common to the settings 
for the linear/log sweep (Sweep Setup key > Power Range) 

Port 
Power 

Sets the power level for Port 1, Port 2, Port 3 and Port 4 
independently 

Delay Sets the sweep delay time 

Sweep 
Mode 

Sets the sweep mode; you need to select one of the following 
items: 

STEPPED: Stepped mode 

SWEPT: Swept mode 

Time Sets the sweep time; to specify the auto setting (AUTO), enter 0 as 
the sweep time 

State Sets the state of each segment 

Shift LO Sets the state of Shift LO. 

Port 
IFBW 

Sets the IF BW for Port 1, Port 2, Port 3 and Port 4 independently 

Useful functions when using a mouse 
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By right-clicking on the selected cell, you can use the following shortcut 
menu. 

Shortcut Function 

Copy Copies the value in the selected cell into the clipboard (internal temporary 
storage memory) 

Paste Pastes the value data in the clipboard to a newly selected cell 

Insert Adds a new line above the selected cell 

Delete Deletes the line containing the selected cell 

In the character-by-character edit mode, you can also use the following 
shortcut menu. 

Shortcut Function 

Undo Undoes the change and restore the value before the change 

Cut Cuts the selected string and store it into the clipboard (temporary 
memory) 

Copy Copies the selected string into the clipboard 

Paste Pastes the string in the clipboard to a newly selected cell 

Delete Deletes the selected string 

Select All Selects the entire string in the cell 

Executing segment sweep 

To execute a segment sweep by using the segment table you have 
created, you must specify the sweep type for that sweep operation by 
following the steps below. 

1. Press Channel Next/Channel Prev keys to select the channel on which 
you will execute the segment sweep operation. 

2. Press Sweep Setup Key. 

3. Press Sweep Type > Segment. 
Setting up the segment display 

Define the method of displaying traces when the segment sweep is 
executed by following the steps described below. 

1. Press Channel Next/Channel Prev keys to select the channel on which 
you will define the segment display. 

2. Press Sweep Setup Key. 

3. Click Segment Display. 
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4. Select the segment display. 

Softkey Function 

Freq Base Displays the X-axis as the axis for linear frequencies (frequency-
based display) 

Order 
Base 

Displays the X-axis as the axis for the points (order-based 
display) 

Saving a newly created segment table in CSV format 

As discussed in Creating a segment table, you can export the newly 
created segment table as a CSV (comma-separated value) formatted file 
(so it can be used easily in software that requires a different format). 

1. Press Sweep Setup Key. 

2. Click Edit Segment Table > Export to CSV File to open the Save As 
dialog box. Note that CSV Files (*.csv) will already be selected as the 
file type when the dialog box first opens. 

3. Type the file name in the File Name area and Click Save to save the 
segment table. 

Calling a segment table saved in CSV Format 

By importing a segment table file saved by E5071C, you can set up the 
segment table. 

 It is possible to recall a file from a different channel 
where it was saved. 

1. Press Sweep Setup Key. 

2. Click Edit Segment Table > Import from CSV File to open the Open 
dialog box. Note that CSV Files (*.csv) will already be selected as the 
file type when the dialog box first opens. 

3. Select the CSV format file to be imported, and click Open to call up 
the segment table. 

 You cannot import a CSV-formatted file 
created/edited in spreadsheet software into the E5071C. 

 You cannot import CSV-formatted files created in 
firmware revision A.09.60 or later to firmware revisions before 
revision A.09.60. 
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Measurement Examples 

Measurement Examples 

 Measuring the SAW Bandpass Filter Using the Segment Sweep 

 Evaluating a Duplexer 

 Measuring the Deviation from a Linear Phase 

 Measuring an Unbalanced and Balanced Bandpass Filter 

 Measuring Parameters with Cable 

 Evaluating Transmission Characteristics of a Front End Module 

 Executing Power Calibration 



Measurement 

399 

Measuring SAW Bandpass Filter using Segment Sweep 

 Overview 

 Procedure 

Other Measurement Examples 

Overview 

This section illustrates how to use the segment sweep function to evaluate 
a SAW bandpass filter with a center frequency of 947.5 MHz. 

Procedure 

Here, the DUT is evaluated by following the steps. 

Step Description 

1. Determine the Segment Sweep 
Conditions 

The segment sweep conditions are 
determined according to the 
characteristics of the DUT. 

2. Create a Segment Sweep Table The segment sweep conditions are 
entered in the E5071C. 

3. Select the Segment Sweep as the 
Sweep Type 

The segment sweep is selected as the 
sweep type. 

4. Execute the Calibration A 2-port ECal is performed between the 
test ports connecting the DUT. 

5. Connect the DUT The DUT is connected. 

6. Execute the Measurement A trigger is applied to perform the 
measurement. 

7. Define the Setup for Display The choice is made between frequency 
base and order base as the method of 
displaying segments. 

  
  

1. Determine the Segment Sweep Conditions 

The following figure shows the results of evaluating the transmission 
characteristics of the SAW bandpass filter in the range of 440 MHz to 3 
GHz by using the linear sweep. 

Transmission characteristics of SAW bandpass filter (440 MHz to 3 
GHz, linear sweep) 
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The measurement conditions are determined for each frequency range. 
Here, the segment sweep is performed following the sweep conditions 
shown in the following table. 

Frequency Range Measurement Conditions 

Start Stop Number of Points IF Bandwidth 

440 MHz 915 MHz 
(Marker 1) 

47 

  

70 kHz 

  

915 MHz 
(Marker 1) 

980 MHz 
(Marker 2) 

130 100 kHz 

  

980 MHz 
(Marker 2) 

1.035 GHz 
(Marker 3) 

55 

  

70 kHz 

  

1.07 GHz 
(Marker 4) 

2 GHz 
(Marker 5) 

93 

  

70 kHz 

  

2.6 GHz 
(Marker 6) 

3 GHz 41 70 kHz 
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2. Create a Segment Sweep Table 

Follow the steps below to make entries in the segment sweep table. 

1. Display the segment table. 
  

Setup Description Key Operation 

Presetting Preset > OK 

Displaying the segment table Sweep Setup > Edit Segment Table 

2. Display the IF bandwidth setting column in the segment table. 
  

Setup Description Key Operation 

Moving the focus to the softkey menu Focus  

Display of IF bandwidth setting column: ON List IFBW (turn it ON) 

When setup items (power level, delay time, sweep mode, and sweep 
time in this case) are not displayed in the segment table, the setting 
for the channel in use applies to all segments. 

3. Enter the setup data in the segment table. 
  

Setup Description Key Operation 

Moving the focus to the segment table (select) Focus 

Segment 1 

Start frequency: 440 MHz 4 > 4 > 0 > M/µ 

Stop frequency: 915 MHz 9 > 1 > 5 > M/µ 

Number of points: 47 4 > 7 > x1 

IF bandwidth: 70 kHz 7 > 0 > k/m 

Segment 2 

Start frequency: 915 MHz 9 > 1 > 5 > M/µ 

Stop frequency: 980 MHz 9 > 8 > 0 > M/µ 

Number of points: 130 1 > 3 > 0 > x1 

IF bandwidth: 100 kHz 1 > 0 > 0 > k/m 
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Segment 3 

Start frequency: 980 MHz 9 > 8 > 0 > M/µ 

Stop frequency: 1.035 GHz 1 > . > 0 > 3 > 5 > G/n 

 Number of points: 55 5 > 5 > x1 

IF bandwidth: 70 kHz 7 > 0 > k/m 

Segment 4 

Start frequency: 1.07 GHz 1 > . > 0 > 7 > G/n 

Stop frequency: 2 GHz 2 > G/n 

Number of points: 93 9 > 3 > x1 

IF bandwidth: 70 kHz 7 > 0 > k/m 

Segment 5 

Start frequency: 2.6 GHz 2 > . > 6 > G/n 

Stop frequency: 3 GHz 3 > G/n  

Number of points: 41 4 > 1 > x1 

IF bandwidth: 70 kHz 7 > 0 > k/m 

 Completed segment table 
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3. Select the Segment Sweep as the Sweep Type 

The segment sweep is selected as the sweep type. 

Setup Description Key Operation 

Sweep type: Segment sweep Sweep Setup > Sweep Type > Segment 

4. Execute the Calibration 

In this step, a 2-port ECal is executed on the two ports to be used. 

    1.   Connect the ECal module across test ports 1 and 2. 

Connecting the ECal module 
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    2.   Execute the 2-port ECal. 

Setup Description Key Operation 

Executing a 2-port ECal between test ports 1 
and 2 

Cal > ECal > 2 Port ECal > Port 
1-2 

5. Connect the DUT 

The DUT is connected across test ports 1 and 2. 

Connecting the DUT 
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6. Execute the Measurement 

A trigger is applied to perform the measurement. 

Setup Description Key Operation 

Trigger mode: Single Trigger > Single (Or Continuous) 

7. Define the Setup for Display 

The choice is made between frequency base and order base as the segment 
display mode. 

Setup Description Key Operation 

Segment display: Frequency base or 
order base 

Sweep Setup > Segment Display > Frequency 
Base | Order Base 

  

Segment display: Frequency/Order base 
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Evaluating a Duplexer 

 Overview 

 Procedure 

Other Measurement Examples 

Overview 

This section illustrates how to evaluate a duplexer (Tx center frequency: 
1.88 GHz, Rx center frequency: 1.96 GHz). 

Procedure 

Here, the DUT is evaluated by following the steps described in table below. 

Steps Description 

1. Determine the Segment 
Sweep Conditions 

Segment sweep conditions are determined 
according to the characteristics of the DUT. 

2. Create a Segment Sweep 
Table 

The segment sweep conditions are entered in the 
E5071C. 

3. Select the Segment Sweep 
as the Sweep Type 

The segment sweep is selected as the sweep type. 

4. Execute the Calibration A full 3-port calibration is executed by using the 2-
port ECal module. 

5. Connect the DUT The DUT is connected. 

6. Define the Setup for Display The number of traces to be displayed, split display, 
and measurement parameters are specified. 

7. Execute the Measurement A trigger is applied to execute the measurement. 

8. Define the Setup for the 
Segment Display and Scale 

The setup for segment display and for the scale are 
defined. 

9. Analyze the Parameters The evaluation parameters for the duplexer are 
determined. 

10. Define the Setup for a Limit 
Table 

The setup for the limit table is defined. 

11. Execute the Limit Test The limit test is executed. 

1. Determine the Segment Sweep Conditions 

A segment sweep is performed by following the sweep conditions shown in 
table below. 
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Start Stop Number of Points 

1.73 GHz 1.83 GHz 50 

1.83 GHz 2.03 GHz 400 

2.03 GHz 2.13 GHz 50 

3.65 GHz 4.03 GHz 38 

5.5 GHz 6.02 GHz 52 

2. Create a Segment Sweep Table 

Entries are made in the segment sweep table following the steps described 
below. 

    1.   Display the segment table. 

Setup Description Key Operation 

Presetting Preset > OK 

Displaying the segment table Sweep Setup > Edit Segment Table 

    2.   Enter the setup data in the segment sweep table. 

In this step, the IF Bandwidth, power level, delay time, and sweep time are 
not entered segment by segment. By turning off the display of those 
parameters on the segment table, you can use, in each segment without 
making a change: 

 the IF Bandwidth (preset value: 70 kHz) of the channel specified by 
using Avg > IF Bandwidth 

 Power level (preset value: 0 dBm) of the channel specified by using 
Sweep Setup > Power 

 Sweep delay time (preset value: 0 sec) of the channel specified by 
using Sweep Setup > Sweep Delay 

 Sweep mode (preset value: Stepped mode) of the channel specified 
by using Sweep Setup > Sweep Mode 

 Sweep time (preset value: Automatic) of the channel specified by 
using Sweep Setup > Sweep Time. 



Measurement 

409 

 
3. Select the Segment Sweep as the Sweep Type 

The segment sweep is selected as the sweep type. 

Setup Description Key Operation 

Sweep type: Segment 
sweep 

Focus (Moves the focus to the softkey menu) > Return > 
Sweep Type > Segment 
(or Sweep Setup > Sweep Type > Segment) 

4. Execute the Calibration 

In this step, a 2-port ECal module and 3-/4-port module installed in the 
E5071C are used to execute calibration on the three ports used in the 
measurement. 

1. Connect the USB port of the 2-port ECal module and the USB port of 
the E5071C with a USB cable. The connection may be made while 
the unit is powered. 

2. Load and execute the 3-/4-port ECal programs. 
  

Setup Description Key Operation 

Opening the VBA Project 
Open dialog box 

Macro Setup > Load Project 

Loading ECalAssistant.VBA 

  

Select D:\Agilent\ECalAssistant.VBA and press 
the Open button. 

Executing the program Macro Run 
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3.   The EcalAssistant (start) dialog box appears. 
 

 
  

4.  Click Next to display the EcalAssistant (port/channel selection) dialog 
box. 
 

 
  

5. Following the instructions in the dialog box, select the type of ECal, 
test ports, and the channel. 
  

Setup Description Key Operation 

Select Ports   

ECal type: Full 3-port calibration 3 Port 



Measurement 

411 

Test ports to be used for ECal: 1, 2, and 3 1, 2, 3 

Select Channel   

Channel on which ECal is to be executed: Channel 1 Channel: 1 

6.  Click Next. The EcalAssistant (connection) dialog box appears. Select 
3-port/Channel:1. 
 

 
 
Connecting the ECal module 
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7. Click Next. The calibration dialog box for Port 1-2 appears. 
 

 
8. Click Measure to Calibrate Port 1-2 settings. After successful calibration 

of Port 1-2, a new dialog box appears. 
 

 
9. Click Next. The dialog box for the calibration of port 1-3 appears. 

 

 
10. Click Measure to Calibrate Port 1-3 settings. After successful 

calibration of Port 1-3, a new dialog box appears. 
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11. Click Next. The dialog box for the calibration of port 2-3 appears. 

 

 
  

12. Click Measure to Calibrate Port 2-3 settings. After successful 
calibration of Port 2-3, a new dialog box appears. 
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13. The EcalAssistant (complete) dialog box appears. Click Done to 
terminate the calibration. 

ECalAssistant (complete) dialog box 

 
5. Connect the DUT 

The DUT is connected to test ports 1, 2, and 3. 

 
   
6. Define the Setup for Display 

The setup for display is defined. 

Setup Description Key Operation 

Number of traces to be displayed: 5 Display > Number of Traces > 5 
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Trace placement: Trisected 

Allocate Traces >  

Measurement Parameter   

Trace 1: S13 Meas - S13 

Trace 2: S21 Trace Next > Meas > S21 

Trace 3: S23 Trace Next > Meas > S23 

Trace 4: S33 Trace Next > Meas > S33 

Trace 5: S11 Trace Next > Meas > S11 

7. Execute the Measurement 

A trigger is applied to execute the measurement. 

Setup Description Key Operation 

Trigger mode: Single (or continuous) Trigger > Single (or Continuous) 

8. Define the Setup for the Segment Display and Scale 

The setup for the scale is defined. 

Setup Description Key Operation 

Segment display: Order base Sweep Setup > Segment Display > Order Base 

Reference Line Position   

Trace 1: 10 Trace Next > Scale > Reference Position > 1 > 0 > x1 

Trace 2: 10 Trace Next > Reference Position > 1 > 0 > x1 

Trace 3: 10 Trace Next > Reference Position >  1 > 0 > x1 

Trace 4: 9 Trace Next > Reference Position > 9 > x1 

Trace 5: 9 Trace Next > Reference Position > 9 > x1 

  

 Measurement result (segment display: order base) 
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9. Analyze the Parameters 

The parameters for the duplexer are determined. 

    1.   Determine the insertion loss and 3-dB bandwidth for Tx. 

Setup Description Key Operation 

Marker coupling: OFF Marker Fctn > Couple (Turn it OFF) 

Activating Trace 1 Trace Next 

Marker 1: ON Marker 

Search/Tracking: ON Marker Search > Tracking (Turn it 
ON) 

Moving the marker 1 to the trace 
maximum 

Max 

Bandwidth search: ON Bandwidth (Turn it ON) 

The insertion loss (loss) in this example is -1.243 dB, and the 3-dB 
bandwidth (BW) is 85.53 MHz. 

    2.   Determine the insertion loss and 3-dB bandwidth for the Rx. 
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Setup Description Key Operation 

Activating Trace 2 Trace Next 

Marker 1: ON Marker 

Search/Tracking: ON Marker Search > Tracking (Turn it ON.) 

Moving Marker 1 to the trace maximum Max 

Bandwidth search: ON Bandwidth (Turn it ON) 

The insertion loss (loss) in this example is -1.627 dB and the 3-dB 
bandwidth (BW) is 71.04 MHz. 

    3.   Determine the isolation between Tx and Rx. 

Setup Description Key Operation 

Activating Trace 3 Trace Next 

Marker 1: ON Marker  

Search/Tracking: ON Marker Search > Tracking (Turn it ON) 

Moving Marker 1 to the peak 
near 1.92 GHz 

Peak - Search Left or Search Right ( press as 
many times as necessary) 

The isolation (response value of marker 1)  in this example is -6.612 dB. 

    4.   Determine the return loss of Tx. 

Setup Description Key Operation 

Activating Trace 4 Trace Next 

Marker 1: ON Marker 

Search/Tracking: ON Marker Search > Tracking (Turn it ON) 

Moving Marker 1 to the peak in 
the pass band 

Peak > Search Left or Search Right ( press as 
many times as necessary) 

The return loss (response value of Marker 1)  in this example is 12.65 
dB. 

    5.   Determine the return loss of Rx. 

Setup Description Key Operation 

Activating Trace 5 Trace Next 

Marker 1: ON Marker 
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Search/Tracking: ON Marker Search > Tracking (Turn it ON) 

Moving Marker 1 to the peak in 
the pass band 

Peak > Search Left|Search Right ( press as 
many times as necessary) 

       The return loss (response value of Marker 1)  in this example is 13.80 
dB. 

    6.   Turn on the marker table display. 

Setup Description Key Operation 

Marker table display: ON Marker Fctn > Marker Table (Turn it ON) 

Activating Marker Table 

 
10. Define the Setup for a Limit Table 

Follow the steps below to make entries in the limit table. 

    1.   Display the limit table for Trace 1 (S13). 

Setup Description Key Operation 

Activating Trace 1 Trace Next 

Displaying a limit table Analysis > Limit Test > Edit Limit Line 

    2.   Enter the setup data in the limit table for trace 1. 
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Completed limit table for trace 1 

 
    3.   Display the limit table for Trace 2 (S21). 

Setup Description Key Operation 

Activating Trace 2 Trace Next  

    4.   Enter the setup data in the limit table for trace 2. 

Completed limit table for trace 2 

 
11. Execute the Limit Test 

The limit test is executed. 

    1.   Turn on the limit line and limit test for Trace 1. 

Setup Description Key Operation 

Activating Trace 1 Trace Prev 

Limit Line: ON Analysis > Limit Test - Limit Line (Turn it ON) 

Limit Test: ON Limit Test (Turn it ON) 

    2.   Turn on the limit line and limit test for Trace 2. 

Setup Description Key Operation 

Activating Trace 2 Trace Next 

Limit Line: ON Limit Line (Turn it ON) 

Limit Test: ON Limit Test (Turn it ON) 
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    3.   Apply a trigger to execute the measurement. 
  

Setup Description Key Operation 

Trigger Mode: Single Trigger > Single (or Continuous) 

  

Limit test results 

 
    4.   Maximize the screen display of Trace 1 to examine its details. 

Setup Description Key Operation 

Activating Trace 1 Trace Prev 

Maximizing the display of Trace 1 Trace Max  

Enlarged display of trace 1 
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    5.   Maximize the screen display of Trace 2 to examine its details. 

Setup Description Key Operation 

Activating Trace 2 Trace Prev  (The display of Trace 2 is maximized.) 

Enlarged display of trace 2 
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Measuring the Deviation from a Linear Phase 

 Overview 

 Procedure 

Other Measurement Examples 

Overview 

This section illustrates how to determine the deviation from a linear phase 
in the pass band of a 1.09-GHz bandpass filter. 

Procedure 

Here, the DUT is evaluated by following the steps. 

Step Description 

1. Connect the DUT The DUT is connected. 

2. Define the Measurement 
Conditions 

The measurement conditions are defined. 

3. Execute the Calibration The calibration is executed. 

4. Connect the DUT and 
Execute the Auto Scale 

The DUT is connected again to execute the auto scale 
function. 

5. Specify the Electrical Delay The electrical delay is specified. 

6. Measure the Deviation 
from a Linear Phase 

The statistics data function (peak-to-peak) is used to 
determine the deviation from a linear phase. 

1. Connect the DUT 

Connect the DUT as shown below. 
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2. Define the Measurement Conditions 

The measurement conditions are defined by following the steps described 
below. 

Setup Description Key Operation 

Presetting Preset > OK 

Center frequency: 1.09 GHz Center > 1 > . > 0 > 9 > G/n 

Frequency span: 20 MHz Span > 2 > 0 > M/u 

Measurement parameter: S21 Meas > S21 

Data format: Expand Phase Format > Expand Phase 

Executing the Auto Scale Scale > Auto Scale 

3. Execute the Calibration 

The THRU response calibration is executed. 

Setup Description Key Operation 

Executing the THRU 
response 

(A THRU standard is connected instead of a DUT) Cal > 
Calibrate > Response (Thru) > Thru > Done 

4. Connect the DUT and Execute the Auto Scale 
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The DUT is connected again as shown in Connect the DUT to execute the 
auto scale. 

Setup Description Key Operation 

Executing the auto scale Scale > Auto Scale 

  

 
5. Specify the Electrical Delay 

The electrical delay is entered to flatten the phase trace. 

Setup Description Key Operation 

Entering the electrical 
delay 

Scale > Electrical Delay > Up/Down Arrow keys or Rotary 
Knob (Flattening a trace) 

6. Measure the Deviation from a Linear Phase 

The statistics data is used to read the deviation from a linear phase (peak-
to-peak). 

Setup Description Key Operation 

Executing the auto scale Scale > Auto Scale 
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Displaying the statistics data Marker Function > Statistics (Turn it ON.) 
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Measuring Unbalanced-Balanced Bandpass Filter 

 Overview 

 Procedure 

Other Measurement Examples 

Overview 

This section introduces an example of actually evaluating the unbalanced 
and balanced SAW bandpass filter with a center frequency of 942.5 MHz. 
The following figure shows the measurement circuit in the condition for 
evaluating a DUT. 

 
  

Procedure 

Here, the DUT is evaluated by following the steps. 

Step Description 

1. Connecting the DUT The DUT is connected. 

2. Setting the Measurement Conditions The measurement conditions are 
defined. 

3. Performing Calibration The full 3-port calibration is 
executed. 

4. Setting a Balance Conversion Topology The balance conversion topology is 
specified. 

5. Selecting Measurement Parameters The mixed-mode S-parameters are 
selected. 
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6. Extending the Calibration Plane (removing 
the cause of error) 

The calibration reference plane is 
extended. 

7. Setting the Port Reference Impedances The port reference impedances are 
specified. 

8. Adding a Matching Circuit A matching circuit is added. 

1. Connecting the DUT 

Connect the DUT to the E5071C by using the instrument's three test ports. 

 
  
  

2. Setting the Measurement Conditions 

Follow the procedure below to set the measurement conditions. The 
measurement parameters for balanced measurements should be set after 
unbalanced-balanced conversion. Here, set the measurement parameters 
for observing the characteristics achieved during unbalanced 
measurements. 

Setting Description Key Operation 

Preset for setting Preset > OK 

Center frequency: 940 MHz Center > 9 > 4 > 0 > M/u  

Frequency span: 200 MHz Span > 2 > 0 > 0 > M/u 
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Number of traces: 2 Display > Num of Traces > 2 

Trace-1 measurement 
parameter: S21 

Meas > S21 

Trace-2 measurement 
parameter: S31 

Trace Next > Meas > S31 

Allocate a trace to upper and 
lower displays 

Display > Allocate Traces >  

Auto-scale all traces Scale > Auto Scale All 

  

 
  
  

3. Performing Calibration 

Perform a full three-port calibration for the three ports to be used. 

1. Set the type and conditions of calibration. 
  

Setting Description Key Operation 



E5071C 

430 

Calibration kit to use: 85033D Cal > Cal Kit > 85033D 

Type of calibration: Full three port 
calibration 

Calibrate > 3-Port Cal 

Test ports to calibrate: 1, 2, 3 Select Ports > 1-2-3 (check 
only) 

2.  Perform a reflection calibration. 
  

Setting Description Key Operation 

Select reflection calibration Reflection 

Perform Port 1 calibration (With the OPEN connected) Port 1 
OPEN 

  (With the SHORT connected) Port 1 
SHORT 

  (With the LOAD connected) Port 1 
LOAD 

Perform Port 2 calibration (With the OPEN connected) Port 2 
OPEN 

  (With the SHORT connected) Port 2 
SHORT 

  (With the LOAD connected) Port 2 
LOAD 

Perform Port 3 calibration (With the OPEN connected) Port 3 
OPEN 

  (With the SHORT connected) Port 3 
SHORT 

  (With the LOAD connected) Port 3 
LOAD 

3. Perform a transmission calibration. 
  

Setting Description Key Operation 

Select transmission calibration Return > Reflection 

Perform a Port 1-to-Port 2 calibration (With thru connection) Port 1-2 Thru 

Perform a Port 1-to-Port 3 calibration (With thru connection) Port 1-3 Thru 
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Perform a Port 2-to-Port 3 calibration (With thru connection) Port 2-3 Thru 

4. Finish the calibration. 
  

Setting Description Key Operation 

Complete the calibration and then 
calculate and store calibration 
coefficients. 

Return > Done (This causes Correction 
to turn ON.) 

Calibration property display: ON Return > Return > Property (Turns it 
ON.) 

  

4. Setting a Balance Conversion Topology 

Follow the procedure below to set the balanced conversion topology. 

Setting Description Key Operation 

Set port 1 on the DUT to unbalanced and 
port 2 on the DUT to balanced. 

Analysis > Fixture Simulator > Topology > 
Device > SE-Bal (check only) 

Set the connecting destination of port 1 
on the DUT (unbalanced) to test port 1 of 
the analyzer. 

Port 1 (se) > 1 (check only) 

Set the connecting destination of port 2 
on the DUT (balanced) to test ports 2 and 
3 of the analyzer. 

Port 2 (bal) > 2-3 (check only) 

5. Selecting Measurement Parameters 

1.   Display four traces. 
  

Setting Description Key Operation 

Number of traces: 4 Display > Number of Traces > 4 

Trace allocation: 4-part split 

Allocate Traces >  

2.   Set the measurement parameter (mixed mode S-parameter) and 
data format for trace 1. 
  

Setting Description Key Operation 

Fixture simulator: ON Analysis >  Fixture Simulator > 
Fixture Simulator (turns it ON) 
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Unbalanced-balanced conversion of 
trace 1: ON 

BalUn (turns it ON) 

Measurement parameter: Sds21 Meas > Sds21 

          

3. Set the measurement parameter (mixed mode S-parameter) and 
data format for trace 2. 
  

Setting Description Key Operation 

Unbalanced-balanced conversion of 
trace 2: ON 

Trace next > Analysis > Fixture 
Simulator > BalUn (turns it ON) 

Measurement parameter: Scs21 Meas > Scs21 
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4. Set the measurement parameter (mixed mode S-parameter) and 
data format for trace 3. 
  

Setting Description Key Operation 

Unbalanced-balanced conversion 
of trace 3: ON 

Trace next > Analysis > Fixture Simulator 
> BalUn (turns it ON) 

Measurement parameter: Sss11 Meas > Sss11 

Data format: Smith chart (marker 
display: R+jX) 

Format > Smith > R + jX 



E5071C 

434 

            

5. Set the measurement parameter (mixed mode S-parameter) and 
data format for trace 4. 
  

Setting Description Key Operation 

Unbalanced-balanced conversion of 
trace 4: ON 

Trace next > Analysis > Fixture 
Simulator > BalUn (turns it ON) 

Measurement parameter: Sdd22 Meas > Sdd22 

Data format: Smith chart (marker 
display: R+jX) 

Format > Smith > R + jX 

The following figure shows the setting results for each parameter. 
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6. Extending the Calibration Plane (removing the cause of error) 

In this section you will use the port extension function to remove an 
electrical delay caused by cables or fixtures located between the calibration 
reference plane and the DUT to be evaluated. If you can provide a two-port 
Touchstone data file representing the characteristics of the network to be 
removed, the network removal function allows you to remove the network 
and extend the calibration reference plane. 

Follow the procedure below to set port extension for each test port. 

Setting Description Key Operation 

Port extension of test port 1: 260 ps Cal > Port Extensions > Extension Port 1 > 
. > 2 > 6 > G/n 

Port extension of test port 2: 260 ps Extension Port 2 > . > 2 > 6 > G/n 

Port extension of test port 3: 260 ps Extension Port 3 > . > 2 > 6 > G/n 

Port extension: ON Extensions (turns it ON) 

The following figure shows the results of extending the calibration 
reference plane. 
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7. Setting the Port Reference Impedances 

With the reference impedances of two test ports in unbalanced 
measurements set to Z0, conversion of those ports into balanced ports 
permits the impedance of the balanced ports' common mode to be 
automatically set to Z0/2 and the impedance of their differential mode to 
be automatically set to 2Z0. 

1.  Set the port reference impedance of port 1 on the DUT (unbalanced) 
to 50 ohm. 
  

Setting Description Key Operation 

Reference impedance of test 
port 1: 50 ohm 

Analysis > Fixture Simulator > Port Z conversion 
> Port 1 Z0 Real > 5 > 0 > x1 

2. In order to set the impedance of the differential mode of port 2 on 
the DUT (balanced) to 200 ohm , set the impedances of two 
unbalanced ports before conversion each to 100 ohm. 
  

Setting Description Key Operation 

Reference impedance of test port 2: 100 
ohm 

Port 2 Z0 Real > 1 > 0 > 0 > 
x1  
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Reference impedance of test port 3: 100 
ohm 

Port 3 Z0 Real > 1 > 0 > 0 > x1 

3. Always set the reference impedances of the two test ports before 
balanced conversion to the same value. 

4.  Turn on the port reference impedance conversion function. 
  

Setting Description Key Operation 

Port reference impedance conversion: ON Port Z Conversion (turns it ON) 

The reference impedance of the command mode of port 2 on the DUT is 
set to 50 W . The impedance of the differential mode of that port may be 
set and modified independently of setting the two-port reference 
impedances before balanced conversion. For more information, see 
Converting Reference Impedance of Balanced Port. 

8. Adding a Matching Circuit 

Here, add an inductance of 47 nH in parallel to port 2 on the DUT 
(balanced). It is also possible to add a matching circuit to the port before 
unbalanced-balanced conversion. For more information, see Determining 
the Characteristics that Result from Adding a Matching Circuit to a 
Differential Port. 

 The balance matching circuit (Differential matching 
circuit embedding) is not applied to single-ended S-parameter 
results. For example, the balance matching circuit is not applied 
to the imbalance parameter as it is derived from single-ended 
S-parameters. 

Setting Description Key Operation 

Selecting a matching 
circuit: 
Shunt L - Shunt C 

Return (or Analysis > Fixture Simulator) > Diff. Matching 
> Select Circuit > Shunt L-Shunt C 
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Inductance: 47 nH L > 4 > 7 > G/n 

C=0, G=0, R=0 (checks that C, G, and R have been set to 0.) 

Differential matching 
circuit function: ON 

Diff. Matching (turns it ON) 
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Measuring Parameters with Cable 

 Overview 

 Procedure 

Other Measurement Examples 

Overview 

This section introduces an example of how to detect the location of a 
mismatch that occurs in a cable by using the time domain function. 

Procedure 

In this example, a DUT is evaluated according to the steps. 

Step Description 

1. Setting the Measurement Conditions Set the measurement conditions. 

2. Executing Calibration Execute calibration. 

3. Connecting the DUT Connect the DUT. 

4. Auto Scale Execute auto scale. 

5. Setting the Time Domain Function Set the time domain function. 

1. Setting the Measurement Conditions 

Follow these steps to set the measurement conditions: 

Setting Description Key Operation 

Presetting Preset > OK 

Stop frequency: 3 GHz Stop > 3 > G/n  

Number of points: 201 Sweep Setup > Points > 2 > 0 > 1 > x1 

Specifying the low-pass mode sweep 
condition 

Analysis > Transform > Set Freq Low Pass 

Measurement parameter: S11 Meas > S11 

2. Executing Calibration 

By following 1-Port Calibration (reflection test), execute 1-port calibration 
on port 1. 
  

3. Connecting the DUT 

Connect the DUT as shown below. 
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4. Auto Scale 

Execute the auto scale function. 

Setting Description Key Operation 

Executing auto scale Scale > Auto Scale 
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5. Setting the Time Domain Function 

Set the conversion function to display the response in the time domain. If 
you enable this setting, the response in time domain is displayed as shown 
figure below. A peak indicating a small mismatch appears at the location of 
the connector. 

Setting Description Key Operation 

Data format: real Format > Real 

Setting the transformation type to low-pass 
impulse 

Analysis > Transform > Type > 
Lowpass Imp 

Setting the window type to maximum. Window > Maximum 

Setting the display range: from 0 s to 20 ns Start > 0 > x1 

Stop > 2 > 0 > G/n 

Enabling the transformation function Transform (set to ON) 

Executing auto scale Scale > Auto Scale 
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Evaluating Transmission Characteristics of a Front End Module 

 Overview 

 Procedure 

Other Measurement Examples 

Overview 

This example shows how to measure the transmission characteristics of a 
6-port front end module, as shown in the following figure, by using the 
E5071C and the E5091A. 

 
Procedure 

In this example, a DUT is evaluated according to the procedure shown in 
table below. 

Procedure Description 

1. Determining Measurement Conditions Determine the measurement conditions 
such as the sweep conditions and 
measurement ports. 

2. Setting Channel Window Allocation Set the allocation of the channel windows 
on the screen. 

3. Setting the Test Ports Determine the test port assignment for 
each channel. 
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4. Setting Control Line Set the E5091A's control line. 

5. Setting Sweep Conditions Set the sweep range and the number of 
points. 

6. Setting Balance Conversion Topology Set the balance port and unbalance port 
assignment. 

7. Selecting Measurement Parameter Set the measurement parameter. 

8. Executing Calibration Perform calibration using 4-port ECal. 

9. Connecting DUT Connect the DUT. 

10. Executing Measurement Execute the measurement and perform 
auto scale. 

  

1. Determining Measurement Conditions 

In this example, perform measurement under the measurement conditions 
in table below. 

C
h. 

Start 
freque
ncy 

Stop 
freque
ncy 

NO
P 

Test 
port 
assignm
ent 

Contr
ol 
line 

Meas. 
parame
ter 

Calibratio
n 

Ty
pe 

Por
t 

1 400 
MHz 

1.4 GHz 20
1 

Port 1 - 
Port A 
Port 2 - 
Port T1 
Port 3 - 
Port R1+ 
Port 4 - 
Port R1- 

Line 
1: 
Low 
Line 
2: 
High 

S12 Full 
2-
Por
t 

1,2 

2 880 
MHz 

1 GHz 10
1 

Line 
1: 
Low 
Line 
2: 
Low 

Sds21 Full 
3-
Por
t 

1,3
,4 

3 1.34 
GHz 

2.34 
GHz 

20
1 

Port 1 - 
Port A 
Port 2 - 
Port T2 
Port 3 - 
Port R2+ 
Port 4 - 
Port R1- 

Line 
1: 
High 
Line 
2: 
Low 

S12 Full 
2-
Por
t 

1,2 

4 1.665 
GHz 

2.015 
GHz 

10
1 

Line 
1: 

S31 Full 
2-

1,3 
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Low 
Line 
2: 
Low 

Por
t 

2. Setting Channel Window Allocation 

Set the screen to split into 2 rows and 2 columns to assign channel 
windows after preset. 

Setting Description Key Operation 

Execute preset Preset > OK 

Allocate channel windows 

Display > Allocate Channels >  

3. Setting the Test Ports 

1. Display the E5091A setup menu and select the 9-port model for ID1. 
  

Setting Description Key Operation 

Display the E5091A setup menu System > Multiport Test Set Setup 

Select the 9-port model for ID1 Test Set 1 > Select Test Set > E5091_9 

2. Display the E5091A properties. 
  

Setting Description Key Operation 

Display the E5091A properties Property 

3.  Select the test ports assigned to ports 1 to 4 for channel 1. 
  

Setting Description Key Operation 

Assign test port A to port 1. Port1 > A 

Assign test port T1 to port 2. Port2 > T1 

Assign test port R1+ to port 3. Port3 > R1+ 

Assign test port R1- to port 4. Port4 > R1- 

4. Assign test ports for channels 2, 3, and 4. Press the Channel Next key 
to switch the active channel and then make the same setting of 
channel 1. 
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5. Enable the control of the E5091A. 
  

Setting Description Key Operation 

Enable the control of the 
E5091A. 

Control (set it to ON) 

4. Setting Control Line 

1. Set the bits of the control line for channel 1. 
  

Setting Description Key Operation 

Set channel 1 to the active 
channel. 

Channel Next 

Line 1: Low Control Lines (check only) 

Line 2: High Control Lines > Line 1 (set it to 
High) 

2. Set the control line for channels 2, 3, and 4 according to the same 
procedure of channel 1. 

5. Setting Sweep Conditions 

1. Set the sweep conditions for channel 1. 
  

Setting Description Key Operation 

Set channel 1 to the active 
channel. 

Channel Next 

Start frequency: 400 MHz Start > 4 > 0 > 0 > M/u  

Stop frequency: 1.4 GHz Stop > 1 > . > 4 > G/n 

Number of points: 201 Sweep Setup > Point > 2 > 0 > 1 
> x1  

2. Set sweep conditions for channels 2, 3, and 4 according to the same 
setting of channel 1. 

6. Setting Balance Conversion Topology 

For channel 2, set the balance conversion topology in order to perform 
measurement that includes the balanced port. 
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Setting Description Key Operation 

Set channel 2 to the active channel. Channel Next (press it until channel 2 is 
activated) 

Set DUT port 1 to unbalance and DUT 
port 2 to balance. 

Analysis > Fixture Simulator > Topology > 
Device > SE-Bal 

Set the destination to which DUT port 1 
(unbalance) is connected to test port 1 of 
the analyzer. 

Port 1 (se) > 1 

Set the destination to which DUT port 2 
(balance) is connected to test ports 3 and 
4 of the analyzer. 

Port 2 (bal) > 3-4 

Unbalance-balance conversion for trace 
1: ON 

BalUn (set it to ON) 

Fixture simulator: ON Fixture Simulator (set it to ON) 

7. Selecting Measurement Parameter 

1. Select the measurement parameter for trace 1 of channel 1. 
  

Setting Description Key Operation 

Set channel 1 to the active 
channel. 

Channel Next  (press it until channel 1 is 
activated) 

Measurement parameter for trace 
1: S12 

Meas > S12 

 The subscript of the measurement parameter means 
the test port of the E5071C. Check the test port assignment and 
select the measurement parameter. 

2. Set measurement parameter for channels 2, 3, and 4 according to 
the same setting of channel 1. 

8. Executing Calibration 

1. Display the Ecal menu. 
  

Setting Description Key Operation 

Display the ECal menu. Cal > ECal 

2. Set channel 1 to the active channel. 
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Setting Description Key Operation 

Switch the active channel. Channel Next  

3. Check the test ports assigned to ports 1 to 4 in the E5091A 
properties and connect the 4-port ECal module to those port. 

 
4. Execute the calibration. 

  

Setting Description Key Operation 

Select full 2-port calibration. 2-Port ECal 

Select the port and execute the calibration. 1-2 
  

5. Perform calibration for channels 2, 3, and 4 according to the same 
procedure as in Step 2 to Step 4. 

 Because the test port assignment setting for 
channels 1 and 2 and that for channels 3 and 4 are the same, 
you need not change the ECal connection. 

9. Connecting DUT 

Connect the DUT as shown below. 
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10. Executing Measurement 

1. Display the trigger menu. 
  

Description Key Operation 

Display the trigger menu. Trigger 

2. Set the trigger source to "manual." 
  

Setting Description Key Operation 

Set the trigger source to "manual." Trigger Source > Manual 

3.     Set the trigger mode for channel 1 to "continuous." 
  

Setting Description Key Operation 

Set channel 1 to the active channel. Channel Next 
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Set the trigger mode to "continuous." Continuous 

4. Set the trigger mode for channels 2, 3, and 4 to "continuous" 
according to the same procedure as in Step 3. 

5. Execute the measurement. 
  

Setting Description Key Operation 

Generate a trigger event. Trigger 

6. Repeat the following procedure to execute auto scale for all of the 
channels. 
  

Setting Description Key Operation 

Set the active channel. Channel Next 

Execute auto scale. Scale > Auto Scale 
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Executing Power Calibration 

 Overview 

 Procedure 

Other Measurement Examples 

Overview 

This section shows an example of executing power calibration using the 
E4418B power meter and the E4412A power sensor. 

 Power calibration may not be executed when the 
specified frequency and level is out of range of the power sensor 
specification. 

Procedure 

In this example, power calibration is executed according to the steps 
shown in table below. 

Step Description 

1. Connecting Power Meter Connects the power meter to the E5071C. 

2. Selecting Power Meter 

a. Setting Address of GPIB 
Power Meter 

b. Setting USB Power Meter 

Configures the power meter's USB/GPIB interface and 
GPIB address with the E5071C. 

3. Setting Stimulus 
Condition 

Sets conditions such as the power level and 
frequency. 

4. Executing Zero 
Adjustment and Calibration 
of Power Sensor 

Executes zero adjustment and calibration of the power 
sensor. 

5. Setting Calibration Data 
Measurement Conditions 

Selects the port, selects the power sensor, sets the 
number of measurements at one point, and sets the 
tolerance during power calibration. 

6. Connecting Power Sensor Connects the power sensor. 

7. Measuring Calibration 
Data 

Executes the measurement of calibration data. 

1. Connecting Power Meter 

Connect the GPIB connector on the E4418B (GPIB address: 14) to the 
E5071C through USB/GPIB Interface. 
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 From Firmware revision 9.2, E5071C supports USB 
enabled power sensors. When you connect USB enabled power 
sensor for the first time, new hardware wizard runs. For more 
information, refer to Setting system controller (USB/GPIB 
interface) 

2. Selecting Power Meter 

Follow the steps to select the power meter 

Setting Description Key Operation 

USB/GPIB System > Misc Setup > Power Meter Setup 
> Select Type > USB/GPIB 

Setting Address of GPIB Power Meter 

Follow these steps to configure the power meter's GPIB address. 

Setting Description Key Operation 

GPIB address of the power meter: 14 System > Misc Setup > GPIB Setup > 
Power Meter Address > 1 > 4 > x1 

 You can also set the GPIB address of power meter by pressing 
System > Misc Setup > Power Meter Setup > GPIB Address 

Setting USB Power Meter 

Follow these steps to configure the USB power meter 

Setting Description Key Operation 

USB power meter System > Misc Setup > Power 
Meter Setup > USB 

3. Setting Stimulus Condition 

Follow these steps to configure the stimulus conditions: 

Setting Description Key Operation 

Presetting Preset > OK 

Sweep type: Power Sweep Setup > Sweep Type > Power Sweep 

Fixed frequency: 1 GHz Sweep Setup > Power > CW Freq > 1 > G/n 

Start value: -40 dBm Start > +/- > 4 > 0 > x1 

Stop value: -10 dBm Stop > +/- > 1 > 0 > x1 

Number of points: 61 Sweep Setup > Points > 6 > 1 > x1 

4. Executing Zero Adjustment and Calibration of Power Sensor 
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Execute the zero adjustment and calibration of the power sensor according 
to the E4418B Power Meter User's Guide. 

5. Setting Calibration Data Measurement Conditions 

Follow these steps to set the calibration data measurement conditions: 

Setting Description Key Operation 

Selecting the test port: 1 Cal > Power Calibration > Select Port > 
1 

Selection of power sensor: A Cal > Power Calibration > Use Sensor [ 
A ] 

Number of measurements at one 
measurement point: 4 

Cal > Power Calibration > Num of 
Readings > 4 > x1 

Tolerance during power calibration: 5 dB Cal > Power Calibration > Tolerance  > 
5 > x1 

  
  

6. Connecting Power Sensor 

Connect the power sensor as shown below. 

 
  

7. Measuring Calibration Data 

Follow this step to measure the calibration data: 
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Setting Description Key Operation 

Measuring calibration data Cal > Power Calibration > Take Cal Sweep 
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Fixture Simulator 

Fixture Simulator 

 Overview of Fixture Simulator 

 Extending the Calibration Plane using Network De-embedding 

 Converting the Port Impedance of the Measurement Result 

 Determining Characteristics After Adding a Matching Circuit 

 Obtaining Characteristics After Embedding/De-embedding 4/6/8-port 
Network 

 Evaluating Balanced Devices (balance-unbalance conversion 
function) 

 Converting Reference Impedance of Balanced Port 

 Determining the Characteristics that Result from Adding a Matching 
Circuit to a Differential Port 

 Example of Using Fixture Simulator 
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Overview of Fixture Simulator 

 Overview 

 Functions for Single-Ended (Unbalanced) Port 

Other topics about Fixture Simulator 

Overview 

The Fixture Simulator is a function that uses software in the E5071C to 
simulate various measurement conditions based on the measurement 
results. The functions available in Fixture Simulator are as follows: 

 Network de-embedding 

 Port reference impedance conversion 

 Matching circuit embedding 

 4-port network embedding/de-embedding 

 Balance-unbalance conversion 

 Differential/Common port reference impedance conversion 

 Differential matching circuit embedding 

Data processing flow diagram of fixture simulator 
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 The E5071C adopts the power wave definition for its S-

parameter calculation. Reference document: "Power waves and 
Scattering Matrix. K. Kurokawa" 

Port extension is an independent function from the fixture simulator, but if 
the fixture simulator function is on, data processing is automatically 
executed as a function of the fixture simulator to improve the data 
processing efficiency. (Measurement result is the same as when the fixture 
simulator is turned off.) Port extension moves the calibration reference 
location by setting an electrical delay for a single-ended port. Port 
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extension can eliminate only electrical delay (phase shift) for each single-
ended port. Loss or mismatch cannot be eliminated by this function. 

Functions for Single-Ended (Unbalanced) Port 

The following three functions are applied to single-ended ports (unbalanced 
ports). Balance-unbalance conversion can additionally be applied to single-
ended ports. 

Network de-embedding 

A function that uses software to remove an arbitrary network (50 ohm 
system) defined by a two-port Touchstone data file from each test port 
(single-ended) and to extend the calibration plane. This makes it possible 
to remove networks that create error elements between the calibration 
plane and the DUT, thereby enabling a more realistic evaluation of the 
DUT. 

For the setup procedure of the network de-embedding function, see 
Extending the Calibration Plane Using Network De-embedding. 

Port reference impedance conversion 

A function that uses software to convert an S-parameter measured with a 
50 ohm port reference impedance into a value measured with an arbitrary 
impedance. 

For the setup procedure of port reference impedance conversion, see 
Converting the Port Impedance of the Measurement Result. 

Matching circuit embedding 

A function for converting an original measurement result into a 
characteristic determined under the condition of inserting a matching 
circuit between the DUT and the test port (single-ended). The matching 
circuit to be inserted is either selected from the five predetermined circuit 
models or provided by a designated arbitrary circuit defined in a two-port 
Touchstone file. 

For the setup procedure used for matching circuit embedding, see 
Determining Characteristics After Adding a Matching Circuit. 

4-port network embedding/de-embedding 

This is a feature to embed (in terms of numerical calculation) your desired 
network that you have defined in a 4-port Touchstone data file into 
measurement results or to de-embed it from them. 

When you use this as de-embedding, the embedded matching circuit and a 
part of networks in the DUT are removed. 

For information on how to operate this function, refer to Obtaining 
Characteristics After Embedding/De-embedding 4-port Network. 

 When the 4-port network embedding/de-embedding 
feature reads a 4-port Touchstone data file, it does not 
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automatically convert the file's normalized impedance value to 
adapt to the port reference impedance setting value of the 
analyzer. 

Balance-unbalance conversion (4 ports option only) 

A function that uses software to convert the measurement results in an 
unbalanced DUT state, which are obtained by connecting the DUT to the 
test port of the E5071C, into measurement results in a balanced state. Two 
test ports of the E5071C are connected to one balanced port of the DUT. 

For the setup procedure used for balance-unbalance conversion, see 
Evaluating Balanced Devices (balance-unbalance conversion function). 

Functions for balanced port (4 ports option only) 

The following two functions are applied to a balanced (differential) port 
converted by balance-unbalance conversion. 

Differential/Common port impedance conversion (4 ports option only) 

A function for converting the differential mode port impedance of a 
balanced port after an balance-unbalance conversion. Balance-unbalance 
conversion automatically converts the differential mode port impedance at 
the balanced port into 2Z0 and the common mode port impedance into 
Z0/2, compared with the two pre-conversion port impedances of Z0. 
Differential port impedance conversion further converts a differential port 
impedance after balance-unbalance conversion into an arbitrary port 
impedance. 

For the setup procedure used for differential port impedance conversion, 
see Converting Reference Impedance of Balanced Port. 

Differential matching circuit embedding (4 ports option only) 

A function for converting the measurement results obtained from balance-
unbalance conversion into a characteristic under the condition of inserting 
a matching circuit in the balanced port. 

For setup procedure of differential matching circuit embedding, see 
Determining the Characteristics that Result from Adding a Matching Circuit 
to a Differential Port. 
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Extending the Calibration Plane Using Network De-embedding 

 Overview 

 Using Network De-embedding Function 

Other topics about Fixture Simulator 

Overview 

Network de-embedding is a function for performing measurements, test 
port by test port, by removing the characteristics of an arbitrary network 
defined by a Touchstone data file. By removing the characteristics of the 
cable, test fixtures, etc. between the actual calibration plane and the DUT, 
the calibration plane can be correspondingly extended. The network de-
embedding function can be used together with the port extension function. 

Port extension and calibration plane extension using network de-
embedding 

 
Using Network De-embedding Function 

1. Prepare a two-port Touchstone data file (.s2p format) corresponding 
to the network to be removed. 

 A Touchstone data file is defined for a single 
normalized impedance value (real). Thus, when preparing a 
Touchstone data file with the 2-port network de-embedding 
feature, be sure to specify the same port reference impedance 
value (real) to both 2-port network in the file. 

 For a network defined in the user file, it is assumed 
that port 1 is connected to the test port and port 2 is 
connected to the DUT. 
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2. Press Analysis key, then click Fixture Simulator > De-Embedding. 

3. Click Select Port. 

4. Click 1, 2, 3, or 4 to select the test port from which the network de-
embedding is performed. 

5. Click User File. 

6. Using the dialog box that appears, select the Touchstone data file 
defining the characteristics of the network to be removed. Once the 
file is selected, the selection of Select Type automatically changes to 
User. To cancel a user-defined file that has been set up, click Select 
Type > None. 

7. Repeat the procedure to set up the Touchstone data file for each port 
from which a network is to be removed. 

8. Click De-Embedding to turn the network de-embedding function ON. 

9. Click Return. 

10. If Fixture Simulator is OFF, press the key again to turn it ON. 
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Converting the Port Impedance of the Measurement Result 

 Overview 

 Converting Port Impedance 

Other topics about Fixture Simulator 

Overview 

The measured value obtained by using a port impedance of 50 ohm can be 
converted into a measured value at an arbitrary port impedance. 

 When using balance conversion, be sure to set the 
impedances of the two unbalanced ports equal to each other.  

Port impedance conversion function 

 
  

Converting Port Impedance 

1. Press Analysis key, the click Fixture Simulator > Port Z Conversion. 

2. Specify the port reference impedance for the required port. 

 Select Port 1 Z0 Real, Port 2 Z0 Real, Port 3 Z0 Real, or Port 4 Z0 
Real to set the port reference impedance in Real format. 
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 Select Port 1 Z0 Real and Port 1 Z0 Imag, Port 2 Z0 Real and Port2 
Z0 Imag, Port 3 Z0 Real and Port 3 Z0 Imag, or Port 4 Z0 Real and 
Port 4 Z0 Imag to set the port reference impedance in Complex 
format. 

3. Click Port Z Conversion to change the port impedance conversion 
function to the ON state. 

4. Click Return. 

5. If Fixture Simulator is OFF, click the key again to turn it ON. 
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Determining Characteristics After Adding a Matching Circuit 

 Overview 

 Using Matching Circuit Function 

Other topics about Fixture Simulator 

Overview 

Using the matching circuit embedding function, you can easily obtain the 
resulting characteristics after adding a matching circuit for each test port. 

Matching circuit function 

 
  

Define the matching circuit to be added by one of the following methods: 

 Select one of the nine predetermined circuit models and specify the 
values for the elements in the circuit model. 

 Use a user file (in two-port Touchstone data format) that defines the 
matching circuit to be added. 

The circuit models used for defining matching circuits are shown below. 

Circuit models for defining matching circuits 
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 In the 2-port matching circuit embedding or the 2-
port network de-embedding feature, if the normalized 
impedance value specified in the user file (2-port Touchstone 
data file) is different from the port reference impedance setting 
value of the analyzer, it is automatically converted to adapt to 
the analyzer setting. 
 
When a 2-port Touchstone data file is read in, data for up to 
3202 frequency points are read in using interpolation according 
to the measurement frequency point setting of the analyzer. If 
the number of frequency points in the file is greater than 3202, 
excess data are ignored. 
 
For a network defined in the user file, it is assumed that port 1 
is connected to the test port and port 2 is connected to the DUT. 

Using Matching Circuit Function 

1. Press Analysis key. 

2. Click Fixture Simulator >  Port Matching > Select Port. 

3. Click 1, 2, 3, or 4 to select the port to which a matching circuit is to 
be added. 

4. Click Select Circuit. 

5. Select a matching circuit model. 
  

Softkey Function 

None No matching circuit is added. 

Series L - 
Shunt C 

Selects a circuit model consisting of a series inductor and a 
shunt capacitor 

Shunt C - 
Series L 

Selects a circuit model consisting of a shunt capacitor and a 
series inductor 

Shunt L - 
Series C 

Selects a circuit model consisting of a shunt inductor and a 
series capacitor 

Series C - 
Shunt L 

Selects a circuit model consisting of a series capacitor and a 
shunt inductor 

Shunt L - 
Shunt C 

Selects a circuit model consisting of a shunt inductor and a 
shunt capacitor 

Series C - 
Shunt C 

Selects a circuit model consisting of a series capacitor and a 
shunt capacitor 
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Shunt C - 
Series C 

Selects a circuit model consisting of a shunt capacitor and a 
series capacitor 

Series L - 
Shunt L 

Selects a circuit model consisting of a series inductor and a 
shunt inductor 

Shunt L - 
Series L 

Selects a circuit model consisting of a shunt inductor and a 
series inductor 

User Selects the circuit model defined in the user file imported. 

To add a matching circuit defined in a user file, execute the 
following operations before selecting this softkey: 

1. Press User File. 

2. In the dialog box that appears, select the two-port 
Touchstone data file (.s2p format) for the matching 
circuit to be added. 

Once a user file is specified, the selection of Select Circuit 
automatically changes to User. 

6. For the circuit models, see Circuit models for defining matching 
circuits. 

7. Specify the values of the elements in the selected circuit model. 

Softkey Function 

C (C1) Specifies capacitance [F] 

G (G1) Specifies conductance [S] 

L (L1) Specifies inductance [H] 

R (R1) Specifies resistance [ohm] 

C2 Specifies capacitance [F] 

G2 Specifies conductance [S] 

L2 Specifies inductance [H] 

R2 Specifies resistance [ohm] 

8.  When either of the two components of Series-
C, "C" and "G", is set to 0, the component is defined as 
"Open"; when both components are set to 0, they are 
defined as "Short." 
When either of the two components of Shunt-L, "L" and 
"R", is set to 0, the component is defined as "Short"; 
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when both components are set to 0, they are defined as 
"Open." 

9. Repeat the procedure above to set up the matching circuit for each 
port used. 

10. Click Port Matching to turn the matching circuit function ON. 

11. Click Return. 

12. If Fixture Simulator is OFF, press the key again to turn it ON. 
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Obtaining Characteristics After Embedding/De-embedding 4/6/8-
port Network 

 Overview 

 Procedure 

Other topics about Fixture Simulator 

Overview 

The 4/6/8-port network embedding/de-embedding feature allows you to 
add (embed) or remove (de-embed) data of your desired 4/6/8-port 
network defined in a 4/6/8-port Touchstone data file to or from 
measurement values through software-based processing. The 
embedding/de-embedding supports three types of connection as shown 
below. 

Connection that enables embedding/de-embedding network 
(4/6/8-port touchstone data) 
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Touchstone Data File Definition 

When defined in the 4-port Touchstone data file, a 4-port network assumes 
that ports 1 and 2 are connected to the analyzer and that ports 3 and 4 are 
connected to the DUT. 

When defined in the 6-port Touchstone data file, a 6-port network assumes 
that ports 1, 2 and 3 are connected to the analyzer and that ports 4, 5 and 
6 are connected to the DUT. 

When defined in the 8-port Touchstone data file, a 8-port network assumes 
that ports 1 to 4 are connected to the analyzer and that ports 5 to 8 are 
connected to the DUT. 

Topology Selection 

For measuring a 4-port DUT with a 4-port network embed/de-embed only 
on one side, select topology C instead of A, set embedding/de-embedding 
on the desired side, and specify no processing (None) on the other side. 

For measuring a 3-port DUT with a 4-port network embed/de-embed on 
one side and a 2-port network on the other side, select topology B instead 
of A, embed/de-embed a 4-port network on one side, and embed/de-
embed a 2-port network on the other side using the 2-port matching circuit 
embedding feature or the 2-port network de-embedding feature. Selecting 
topology A will result in unexpected measurement. 

Procedure 

1. Prepare a 4/6/8-port touchstone data file (.s4p/.s6p/.s8p format) 
corresponding to a network you want to embed/de-embed. 

2. Press Analysis key. 

3. Click Fixture Simulator > De-Embedding SnP > Topology > Select 
Topology. 

4. Select a network connection type (topology) from A, B, or C. 

5. Click Ports to select measurement port numbers of the analyzer to 
which you want to connect ports 1 and 2 of the 4-port network. 

 For topology A: Select measurement port numbers of the 
analyzer to which you want to connect nwk1-1 and nwk1-2. 
For example, when you connect nwk1-1 and nwk1-2 to 
measurement ports 1 and 2, respectively, specify Ports ="1-2". 

 For topology B: Select measurement port numbers of the 
analyzer to which you want to connect nwk3-1, nwk3-2, and 
nwk3-3. For example, when you connect nwk3-1, nwk3-2, and 
nwk3-3 to measurement ports 1, 2, and 3, respectively, specify 
Ports="1-2-3". 

 For topology C: Select measurement port numbers of the 
analyzer to which you want to connect nwk4-1, nwk4-2, nwk4-
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3, and nwk4-4. For example, when you connect nwk4-1, nwk4-
2, nwk4-3, and nwk4-4 to measurement ports 1, 2, 3, and 4, 
respectively,  specify Ports="1-2-3-4". 

6. Click User File (nwkn) and select a Touchstone data file you want to 
use for network n. For nwk1 and nwk2, a 4-port touchstone data file 
should be selected. a 6-port and 8-port touchstone data file should 
be selected for nwk3 and nwk4, respectively. 

7. Click Type (nwkn) and select a processing type for network 1. 

8. Click De-Embedding SnP to turn ON the 4/6/8-port network 
embedding/de-embedding feature. 

9. Click Return. 

10. If Fixture Simulator is OFF, click the key to turn it ON. 

At the firmware A.9.61 and above, when the 4/6/8-port network 
embedding/de-embedding feature reads a 4/6/8-port Touchstone data 
file,it automatically convert the file's normalized impedance value to adapt 
to the port reference impedance setting value of the analyzer.  

At the firmware A.9.61 and above, the data in the 4/6/8-port Touchstone 
data file has to be defined with a single normalized impedance value (real) 
written in the option line.  

When a 4/6/8-port Touchstone data file is read in, data for up to 3202 
frequency points are read in by using interpolation according to the 
measurement frequency point setting of the analyzer. If the number of 
frequency points in the file is greater than 3202, excess data are ignored. 
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Evaluating Balanced Devices (Balance-Unbalance Conversion 
Function) 

 Overview 

 Measurement Parameters of Balanced Devices 

 Procedure for Balance-Unbalance Conversion 

 Measurement Parameter Setup 

 Checking Device Type and Port Assignment 

Other topics about Fixture Simulator 

Overview 

The balance-unbalance conversion function simulates a measurement 
under a balanced state based on measurement results obtained in an 
unbalanced state. This function enables you to evaluate devices with 
balanced ports. 

 Be sure to set the impedances of the two unbalanced 
ports equal to each other. For more details on setting up port 
impedance for unbalanced ports, refer to Converting the Port 
Impedance of the Measurement Result. 

Balance-unbalance conversion 
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The types of devices that can be evaluated using the E5071C are shown 
below.  To evaluate a balanced device, an E5071C with at least three test 
ports is required. 

Types of balanced devices that can be evaluated with E5071C 
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In the terminology of the E5071C, ports after the balance conversion are 
called logical ports (or DUT ports). 

You can freely assign the test ports of the E5071C to logical ports (ports a 
to d in the figure above). 

Measurement Parameters of Balanced Devices 

Turn on the balance-unbalance conversion function to measure the 
following parameters. 

 Mixed mode S-parameter 

 Imbalance parameter 

 CMRR (Common Mode Rejection Ratio) 
Mixed mode S-parameter 

By turning on the balance-unbalance conversion function, you can obtain 
the S-parameter of the balanced port separately for two modes, the 
differential mode and the common mode. The following figure shows the 
notation of the S-parameter in balance measurement (mixed mode S-
parameter). 

Notation of mixed mode S-parameter 
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The following two figures show the mixed mode S-parameter when 
measuring each balanced device. 

Mixed mode S-parameter when measuring a single-ended - 
balanced device 
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Mixed mode S-parameter when measuring a balanced - balanced 
device 

 
  

Mixed mode S-parameter when measuring a single-ended - single-
ended - balanced device 
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Mixed mode S-parameter when measuring a  balanced device 

 
Imbalance Parameter 

By turning on the balance-unbalance conversion function, you can select 
the imbalance parameter of the balanced port as the measurement 
parameter. The following three figures  show the imbalance parameter you 
can select when measuring each balanced device. 

Parameter when measuring a single-ended - balanced device 
(Imbalance) 
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Parameter when measuring a balanced - balanced device 
(Imbalance1, Imbalance2) 

 
  

Parameter when measuring a single-ended - single-ended - 
balanced device (Imbalance1, Imbalance2, Imbalance3, 
Imbalance4) 

 
  

 The balance matching circuit (Differential matching 
circuit embedding) is not applied to single-ended S-parameter 
results. For example, the balance matching circuit is not applied 
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to the imbalance parameter as it is derived from single-ended 
S-parameters. 

CMRR (Common Mode Rejection Ratio) 

By turning on the balance-unbalance conversion function, you can select 
CMRR (ratio between the transmission characteristic in the differential 
mode and that in the common mode) of the balanced port as the 
measurement parameter. The table below shows the CMRR parameter you 
can select when measuring each balanced device. 

Device Type CMRR 

Single-ended - balanced 
device 

 Sds21/Scs21 and Ssd12/Ssc12 

Balanced - balanced device  Sdd21/Scc21 

Single-ended - single-ended - 
balanced device 

Sds31/Scs31 and Sds32/Scs32 

Procedure for Balance-Unbalance Conversion 

 When using three test ports, perform a full three-port 
calibration on the test ports to be used. When using four test 
ports, perform a full four-port calibration. 

 Extend the calibration plane, if necessary, by using 
the port extension function or network de-embedding function. 
For more on the port extension and network de-embedding 
functions, see Extending the Calibration Plane Using Network 
De-embedding. 

1. Press Analysis key. 

2. Click Fixture Simulator > Topology > Device. 

3. Select the balanced/unbalanced topology. 
  

Softkey Function 

SE-Bal Establishes port 1 on the DUT as an unbalanced port and port 2 as 
a balanced port 

Bal-Bal Establishes both port 1 and port 2 on the DUT as balanced ports 

SE-SE-
Bal 

Establishes port 1 and port 2 on the DUT as unbalanced ports and 
port 3 as a balanced port 

Bal Establishes port 1 on the DUT as balanced ports 

4. Select each port on the analyzer to which a port on the DUT is 
connected. 
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 When you have selected SE-Bal: 
  

Softkey Function 

Port 1 
(se) 

Selects a port on the analyzer from among 1, 2, 3, and 4 for 
connection to logical 1 (Port a) 

Port 2 
(bal) 

Selects two ports on the analyzer from among 1-2, 1-3, 1-4, 2-1, 2-
3, 2-4, 3-1, 3-2, 3-4, 4-1, 4-2, and 4-3 for connection to logical port 2 
(Port b and Port c) 

 When you have selected Bal-Bal: 
  

Softkey Function 

Port 1 
(bal) 

Selects two ports on the analyzer from among 1-2, 1-3, 1-4, 2-1, 2-
3, 2-4, 3-1, 3-2, 3-4, 4-1, 4-2, and 4-3 for connection to logical port 1 
(Port a and Port b) 

Port 2 
(bal) 

Selects two ports on the analyzer from among 1-2, 1-3, 1-4, 2-1, 2-
3, 2-4, 3-1, 3-2, 3-4, 4-1, 4-2, and 4-3 for connection to logical port 2 
(Port c and Port d) 

 When you have selected SE-SE-Bal: 

Softkey Function 

Port 1 
(se) 

Selects a port on the analyzer from among 1, 2, 3, and 4 for 
connection to logical 1 (Port a) 

Port 2 
(se) 

Selects a port on the analyzer from among 1, 2, 3, and 4 for 
connection to logical 2 (Port b) 

Port 3 
(bal) 

Selects two ports on the analyzer from among 1-2, 1-3, 1-4, 2-1, 2-3, 
2-4, 3-1, 3-2, 3-4, 4-1, 4-2, and 4-3 for connection to logical port 3 (Port 
c and Port d) 

 When you have selected Bal:  

Softkey Function 

Port 1 
(bal) 

Selects two ports on the analyzer from among 1-2, 1-3, 1-4, 2-1, 2-3, 
2-4, 3-1, 3-2, 3-4, 4-1, 4-2, and 4-3 for connection to logical port 1 ( 
Port a) 

5. Click Return. 

6. Click BalUn to turn on the balanced/unbalanced state conversion 
function. 

7. Click Fixture Simulator to turn on the fixture simulator function. 
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Measurement Parameter Setup 

Performing balance-unbalance conversion enables you to make 
measurements with mixed mode S-parameters, imbalance parameters and 
CMRR. Parameters that can be used differ depending on the balance-
unbalance topology specified in Balance-Unbalance Conversion. 

1. Press Meas key (or Analysis > Fixture Simulator > Measurement). 

2. Select the measurement parameter. 

Checking Device Type and Port Assignment 

You can check the device type and the port assignment for the balance-
unbalance conversion by displaying the balance measurement topology 
property as shown below. 

 
Procedure to Turn On/Off Balance Measurement Topology Property Display 

Follow these steps to turn on/off the balance measurement topology 
property display. 

1. Press Analysis key. 

2. Click Fixture Simulator > Topology 

3. Click Property. Each press toggles between on/off. 
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Converting Reference Impedance of Balanced Port 

 Overview 

 Converting Port Reference Impedance in Differential Mode 

 Converting Port Reference Impedance in Common Mode 

Other topics about Fixture Simulator 

Overview 

By using the port impedance conversion function, you can specify the 
impedance of each test port. As a result of this conversion, the impedance 
of the balanced port in differential mode is set to a value twice as large as 
the impedance of the two unbalanced ports before conversion, and in 
common mode to a value one-half as large. 

 Be sure to set the impedances of the two unbalanced ports 
equal to each other. For more details on setting up port impedance 
for unbalanced ports, refer to Converting the Port Impedance of the 
Measurement Result. 

Port impedance after a balance-unbalance conversion 

 
As described above, the impedance of the balanced port is automatically 
specified as the result of specifying the impedance of the two unbalanced 
ports prior to balance-unbalance conversion. However, the port impedance 
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can be changed to an arbitrary value by using the differential port 
impedance conversion function and the common port impedance 
conversion function. 

Converting Port Reference Impedance in Differential Mode 

If you turn on the differential port impedance conversion function, the port 
reference impedance in the differential mode is converted to an arbitrary 
value specified with this function instead of the value in the above figure. 

Procedure to Turn On/Off Differential Port Reference Impedance Conversion Function 

1. Press Analysis key, then click Fixture Simulator > Diff Z Conversion. 

2. Click Diff Z Conversion to set the differential impedance conversion 
function to ON. 

You can only turn on or off Differential Port Impedance Conversion for all 
of the balanced ports together, not for each port individually. If you want 
to turn off only a specific port, set the reference impedance of the port to 
the value in the above figure. 

Procedure to Set Differential Port Reference Impedance 

1. Press Analysis key, then click Fixture Simulator > Diff Z Conversion. 

2. Specify the port reference impedance in differential mode. 

3. Select the balanced port from Port 1 (bal) Real, Port 2 (bal) Real, or 
Port 3 (bal) Real to set the differential port reference impedance in 
"Real" format. 

4. Select Port 1 (bal) Real and Port 1 (bal) Imag, Port 2 (bal) Real and Port2 
(bal) Imag, or Port 3 (bal) Real and Port 3 (bal) Imag to set the 
differential port reference impedance in "Complex" format. 

5. Ports 1, 2, and 3 refer to the logical ports 1, 2, and 3. 

Converting Port Reference Impedance in Common Mode 

If you turn on the common port impedance conversion function, the port 
reference impedance in the common mode is converted to an arbitrary 
value specified with this function instead of the value the above figure. 

Procedure to Turn On/Off Common Port Reference Impedance Conversion 

1. Press Analysis key, then click Fixture Simulator > Cmn Z Conversion. 

2. Click Cmn Z Conversion to set the common port impedance 
conversion function to ON. 

3. You can only turn on or off Common Port Impedance Conversion for 
all of the ports together, not for each port individually. If you want to 
turn off only a specific port, set the impedance of the port to the 
value in the above figurerocedure to set common port reference 
impedance 

1. Press Analysis key, then click Fixture Simulator > Cmn Z Conversion. 
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2. Specify the port reference impedance in common mode. 

3. Select the balanced port from Port 1 (bal) Real, Port 2 (bal) Real, or 
Port 3 (bal) Real to set the common port reference impedance in 
"Real" format. 

4. Select Port 1 (bal) Real and Port 1 (bal) Imag, Port 2 (bal) Real and Port2 
(bal) Imag, or Port 3 (bal) Real and Port 3 (bal) Imag to set the common 
port reference impedance in "Complex" format. 

 Ports 1, 2, and 3 refer to the logical ports 1, 2, and 
3. 
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Determining the Characteristics that Result from Adding a Matching 
Circuit to a Differential Port 

 Overview 

 Procedure 

Other topics about Fixture Simulator 

Overview 

You can obtain the characteristics resulting from the pseudo addition of a 
balance matching circuit to a balanced port created by balance-unbalance 
conversion. By using the matching circuit function, you can obtain the 
characteristics resulting from the addition of an arbitrary matching circuit 
for each test port. 

Balance matching circuit function 

 
 The balance matching circuit (Differential matching 

circuit embedding) is not applied to single-ended S-parameter 
results. For example, the balance matching circuit is not applied 
to the imbalance parameter as it is derived from single-ended 
S-parameters. 

Procedure 

Define the matching circuit to be added by one of the following methods: 
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 Use a predetermined circuit model and specify the values for the 
elements in the circuit model. 

 Use a user file (in two-port Touchstone format) to define the 
matching circuit to be added. 

The following figure shows the circuit models used in defining a balance 
matching circuit. 

Circuit models used to define balance matching circuit 

 
 For a network defined in a user file, it is assumed 

that port 1 is connected to the test port and port 2 is connected 
to the DUT. 

The setup steps are shown below. 

1. Press Analysis key, then click Fixture Simulator > Diff. Matching. 

2. Click Select Port. 

3. Click 1, 2, or 3 to select the port on the DUT to which a differential 
matching circuit will be added. 

4. To add a matching circuit defined in a user file, perform the following 
operations: 

a. Press User File. 

b. Using the dialog box that appears, select the 2-port 
Touchstone data file (.s2p format) for the matching circuit to 
be added. 

c. Once you have specified the user file, the selection of Select 
Circuit automatically changes to User. In this case, you do not 
have to execute Step 5 and Step 6. 

5. Click Select Circuit. 

6. Select a differential matching circuit model. 
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Softkey Function 

None The matching circuit is not added. 

Shunt L - Shunt 
C 

Selects a circuit model consisting of a shunt inductor and a 
shunt capacitor 

User Selects the circuit model defined in the user file imported in 
Step4. 

7. Specify the values for the elements in the circuit model selected. 
  

Softkey Function 

C Specifies the capacitance [F] 

G Specifies the conductance [S] 

L Specifies the inductance [H] 

R Specifies the resistance [Ω] 

8.  When either of the two components of Shunt-
L, "L" and "R", is set to 0, the component is defined as 
"Short"; when both components are set to 0, they are 
defined as "Open." 

9. Repeat the procedure to set up the differential matching circuit to be 
added to the selected ports on the DUT. 

10. Click Diff. Matching to turn the differential matching circuit ON. 

11. Click Return. 

12. If Fixture Simulator is OFF, press the key again to turn it ON. 
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Example of Using Fixture Simulator 

 Overview 

 Measurement Circuit Example: DUT with Balanced Port 

 Evaluation Using Actual Test Fixture 

 Problems in Measurement with Actual Test Fixture 

 DUT Evaluation using E5071C's Fixture Simulator 

 Advantages of Balanced DUT Evaluation using Fixture Simulator 

Other topics about Fixture Simulator 

Overview 

In this section, the fixture simulation function is explained based on an 
evaluation example for a DUT (balanced SAW filter) with a balanced port. 

Measurement Circuit Example: DUT with Balanced Port 

The following figure shows an example of a measurement circuit used to 
evaluate a balanced SAW filter. DUT port 1 is an unbalanced port 
connected to source impedance Rs and input matching circuit L1. DUT port 
2 is a balanced port connected to an output matching circuit (C1, C2, and 
L2) and load resistance RL. 

Measurement circuit of balance SAW filter 

 
Evaluation Using Actual Test Fixture 

Generally, a test fixture as shown in the following figure is fabricated for 
evaluating the characteristics of a DUT in a measurement circuit by using a 
network analyzer. 

In typical use, a network analyzer performs measurements at a 50 ohm 
port reference impedance and in a single-ended (unbalanced) state. 
Therefore, DUT port 1 can be connected directly to the test port of the 
network analyzer. 
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On the other hand, DUT port 2 is a balanced port that cannot be connected 
directly to the test port of the network analyzer. Usually, a balun 
(BALance-UNbalance transformer) is used to convert the DUT's balanced 
port to an unbalanced port and to connect the converted port to the test 
port of the network analyzer. Matching circuits are mounted in the test 
fixture as shown in the following figure. 

DUT evaluation using an actual test fixture 

 
Problems in Measurement with Actual Test Fixture 

Evaluating a balanced device with an actual test fixture involves the 
following problems: 

 Calibration cannot be performed at the DUT's terminals. (A DUT's 
terminals are in the test fixture and calibration standards cannot be 
connected to them. In addition, it is very difficult to obtain calibration 
standards that can be used to calibrate a balanced port.) As a result, 
calibration is performed at appropriate connectors connected to the 
test fixture, and the network between the calibration reference plane 
and the DUT's terminals induces measurement errors. 
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 Different test fixtures must be fabricated for evaluating different 
types of DUTs because they require different characteristic 
impedances and matching circuits. 

 An actual balun does not have ideal characteristics, so measurement 
error cannot be avoided. Furthermore, a common mode signal 
evaluation cannot be performed when an actual balun is used. 

DUT Evaluation using E5071C's Fixture Simulator 

The E5071C's fixture simulator function simulates a test fixture by using 
internal software instead of using an actual test fixture for evaluating 
DUTs. 

The following figure shows an example connection for evaluating a DUT 
with the E5071C's fixture simulator function. The unbalanced port of the 
DUT should be directly connected to a test port of the E5071C, and the 
balanced port of the DUT should be connected to two other test ports of 
the E5071C. The actual measurement by the E5071C is performed at 
single-ended ports with a 50 ohm port reference impedance. 

DUT connection when fixture simulator is used 
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The following figure shows the measurement circuit simulated by the 
fixture simulator based on actual measurement with the test fixture shown 
in figure above. 

Measurement circuit simulated by fixture simulator 
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First, the effect of an undesired network can be eliminated by port 
extension and/or network de-embedding. In the above figure (DUT 
connection when fixture simulator is used), since calibration standards 
cannot be connected to the DUT terminals to perform calibration, 
calibration should be performed at the connectors to the test fixture. Using 
port extension and/or network de-embedding enables you to remove an 
undesired network by using data processing and moving the calibration 
reference plane to the DUT's side equivalently. This function is performed 
for a single-ended port even if balance-unbalance conversion is applied to 
the port. 

Port reference impedance conversion converts measured S-parameters to 
those at arbitrary port reference impedance. In the above figure 
(Measurement circuit simulated by fixture simulator), since the single-
ended port of the DUT is connected to the E5071C's test port (50 ohm , 
single-ended), port reference impedance conversion is not required. This 
function is performed for a single-ended port even if balance-unbalance 
conversion is applied to the port. 

Matching circuit embedding converts measured S-parameters to those 
when a matching circuit is added to the DUT's terminal. This function is 
performed for a single-ended port even if balance-unbalance conversion is 
applied to the port. 

Balance-unbalance conversion converts S-parameters measured at an 
unbalanced state to mixed-mode S-parameters measured at a balanced 
state. The balanced port signal can be evaluated by using differential mode 
and common mode signals. 
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Differential matching circuit embedding converts measured S-parameters 
to those when a matching circuit is added to the DUT's differential mode 
port.(L2 in there figure Measurement circuit simulated by fixture simulator) 

Differential port reference impedance conversion converts a differential 
port reference impedance to an arbitrary impedance. Port reference 
impedance Z [ohm] at the two single-ended ports before balance 
conversion is automatically converted to 2Z [ohm] for differential mode 
port and Z/2 [ohm] for common mode port after balance conversion. 
Accordingly, if port reference impedance conversion is not performed for 
the two single-ended ports before balance conversion, differential mode 
port reference impedance Zd becomes 50 ohm * 2 = 100 ohm , and 
common mode port reference impedance Zc becomes 50 ohm / 2 = 25 
ohm . Since the differential port is terminated with 200 ohm in the 
figure,Measurement circuit of balance SAW filter, differential port reference 
impedance Zd should be set to 200 ohm. 

Advantages of Balanced DUT Evaluation using Fixture Simulator 

Balanced device evaluation using the fixture simulator offers the following 
advantages: 

 Calibration reference plane can be easily moved to the DUT's 
terminal after calibration is performed at the connectors where 
calibration standards can be connected. Undesired network can be 
removed to eliminate measurement errors (port extension, network 
de-embedding). 

 Characteristics of a DUT, including desired matching circuits, can be 
obtained easily (matching circuit embedding, differential matching 
circuit embedding). Port reference impedance can be set freely (port 
reference impedance conversion, differential port reference 
impedance conversion). 

 Differential mode and common mode signal evaluation (mixed-mode 
S-parameter evaluation) can be performed easily (balance-unbalance 
conversion). 

 


